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C H A P T E R  O N E

Getting Started

Welcome to Chart software for Macintosh computers. Chart operates 

as part of the e-corder system providing multichannel signal recording, 

display and analysis capability.

This chapter contains information on hardware requirements, and the 

use of this guide in learning to use the application. There is also a basic 

introduction to data acquisition.
1
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Table 1–1  
Shorthand usages 
referring to menu 
commands and shortcuts.
Learning to Use Chart
Where to Start

Before recording data read the booklet that came with your e-corder 
system and the e-corder Manual on the Installer CD. Be sure to connect 
your e-corder to your computer properly.

How to Use this Guide

It is best to gradually work through this manual in front of your 
computer. The information in the following chapters is set out in the 
order you will probably require it. 

Conventions

Menu commands and shortcuts are usually described using the 
conventions in Table 1–1. Note that shortcuts can appear in two forms: 
hyphenated in text, and with a + sign in tables, to make each clearer in 
context.

The screen shots used in this guide are from Mac OS 10.1. They were 
made using the Mac OS X default appearance settings. There may be 
changes in appearance when using Chart with later systems and 
settings. 

Example phrase Meaning
Chart Software

File > New The New command of the File menu

Chart > Preferences > Extensions… The Extensions… command of the Preferences 
submenu of the Chart menu

Channel Function pop-up > Input 
Amplifier…

The Input Amplifier… command of the Channel 
Function pop-up menu

Command-S, or  
Command + S

Hold down the Command (apple, clover leaf) 
key and type ‘s’

Option-Shift-click, or  
Option + Shift + click

Hold down the Option and Shift keys and click 
the mouse button
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Where to from Here?

This book is a reference guide for the main features of the Chart 
software. Some specialist features are provided using Chart Extensions 
(software plug-ins) available from our web site, www.eDAQ.com. 
Documentation for the Chart Extensions is also provided on the web 
site.

Our documentation is continually being improved and updated, and 
latest editions are available from www.eDAQ.com.

Computer Requirements

• PowerPC or better

• 128 MB RAM

• 40 MB free hard disk space

• 800 x 600, 256 color display or better

• Mac OS X 10.1

• A CD-ROM drive

• USB 2.0 or 1.1

The e-corder® System

The e-corder system is an integrated system of hardware and software 
designed to record, display, and analyze experimental data. The 
system consists of an e-corder recording unit and software programs 
d 3

(such as Chart and Scope) that run on the computer connected to the 
e-corder. Your e-corder unit has considerable computing power of its 
own and performs many tasks that are necessary during data 
recording. Once the e-corder transfers the data to the computer, the 
data are available for display, manipulation, printing, storage and 
retrieval.

First Use

Ensure that the e-corder is connected properly to your computer (this is 
covered in the manual that came with your e-corder) and turned on. 
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Figure 1–1  
The Chart License setup 
dialog box.

Figure 1–2  
The dialog box that 
appears if the e-corder is 
not connected correctly.
Click the Chart icon in the Dock or double-click the Chart icon in the 
Finder. 

The first time you run Chart, you will be presented with the dialog box 
shown in Figure 1–1. Enter your name (minimum three characters), 
organization (minimum three characters) and the license code that you 
received with your copy of Chart. Click OK to enter the license, or Quit 
to leave Chart. 

Note that if the computer has an owner’s name in the system already 
(for file sharing), the name will be put into the Name box and selected 
automatically. Just start typing if you want to overwrite it.

There may be a short delay while the program sets up the e-corder. If 
the e-corder is not connected, then after naming your copy of the 
application, the dialog box in Figure 1–2 will appear. If this dialog box 
appears when the e-corder is connected and turned on, see the manual 
that came with your e-corder for help. Some of the information from that 
guide on hardware startup problems is also repeated in Appendix B. 
Chart Software

Click here to 
access the 
e-corder Startup 
dialog box
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Mechanical 
signal

Input

Tra

Figure 1–3  
A graphical summary of 
data acquisition using an 
e-corder system.
Quitting Chart 

If you want to quit Chart after naming your copy of the application, 
choose Chart > Quit. If you want to proceed with working through this 
guide, just carry on. 

Basics of Data Acquisition
The purpose of the e-corder system is to acquire, store, and analyze 
data. Figure 1–3 summarizes the acquisition. Usually, the raw input 
signal is in the form of an analog voltage whose amplitude varies 
continuously over time. This voltage is monitored by the hardware, 
which can modify it by amplification and filtering, processes called 
‘signal conditioning’. Signal conditioning may also include zeroing, for 
example the removal of an unwanted steady offset voltage from a 

transducer’s output. After signal conditioning, the analog voltage is 
sampled at regular intervals. The signal is then converted from analog 
d 5

to digital form before transmission to the attached computer (computers 
need digital data). The computer software usually displays the data 
directly; it plots the sampled and digitized data points and reconstructs 
the original waveform by drawing lines between the points. Digital 
data can be stored on disk for later retrieval. Software can also easily 
manipulate and analyze the data in a wide variety of ways. 

Most of the parameters that affect acquisition can be set by the user 
through the software. To make a good recording, the parameters must 
be appropriate for the signals being recorded. In some disciplines you 

Analog electrical 
signal

Digital signal

e-corder
Computer

Amplification Filtering Sampling Display

…101101…

nsducer
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Figure 1–4  
Undersampling: 
oscillating pressure 
signal recorded at 20 /s 
(too slow) and 200 /s 
(correct sampling speed)
may be able to find tables of suggested sampling rates, ranges, and 
filter settings, but these should not be applied blindly. You still need to 
know the science (what you are recording, why you are recording it, 
and what relation it bears to real phenomena) and the technique (how 
best to record, and what limitations or compromises are inherent in the 
process). 

Sampling Rate

Sampling replaces the original continuous analog signal by a series of 
discrete values (samples) taken at regular time intervals. The 
appropriate sampling rate depends on the signal to be measured. If the 
sampling rate is too low, information is irreversibly lost and the original 
signal will not be represented correctly. If it is too high, there is no loss 
of information, but the excess data increases processing time and 
results in unnecessarily large disk files. 

20 /s

200 /s
Chart Software

Recordings of periodic waveforms that have been sampled too slowly 
may be misleading as well as inaccurate because of aliasing. An 
analogy to aliasing can be seen in old films: spoked wagon wheels 
may appear to stop or even go backwards when their rate of rotation 
matches the film frame speed — obviously not an accurate record. 

To prevent aliasing, the sampling rate must be at least twice the rate of 
the highest expected frequency of the incoming waveform. This 
sampling rate is known as the Nyquist frequency, the minimum rate at 
which digital sampling can accurately record an analog signal. For 
example, if a signal has maximum frequency components of 100 Hz, 
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Figure 1–5  
Aliasing: sampling a 
3.5 Hz signal at 4 /s 
gives a misleading 
waveform, an apparent 
signal of 0.5 Hz.
the sampling rate needs to be at least 200 Hz to record it accurately. 
To provide a safety factor to guard against information loss, it is usual 
to sample at five to ten times the highest expected frequency rather than 
the minimum two times.

In most cases, the highest expected frequency will be known. It may 
well be limited by the transducer used: a bridge transducer to measure 
mechanical force will not produce high frequencies, for instance. If you 
are unsure of the frequency range (bandwidth) of your signal, a useful 
rule of thumb is to choose a sampling rate high enough to allow at least 
5 to 20 samples for any transient peaks or recurring waves in the 
signal.

The highest frequencies in a signal can be formally determined by 
sampling the signal at the maximum rate, and looking at the spectrum 
of the signal (using the Spectrum window). High-frequency components 
in the spectrum with less than 2% or so of maximum amplitude usually 
contribute little to recording accuracy. 

Actual signal (3.5 Hz), at 40/s Aliased signal (0.5 Hz), at 4/s

Sample 
points at 
4/s
d 7

Filtering

Any analog waveform can be described mathematically as the sum of a 
number of pure sine waves at various frequencies and amplitudes. Low 
frequencies characterize the slowly changing parts of a waveform; high 
frequencies, the quickly changing parts. A filter removes selected 
frequencies from a signal: for instance, a low-pass filter lets low 
frequencies pass and stops high frequencies. Low-pass filters are 
commonly used to help reduce noise and give a smoother signal. A 
high-pass filter removes any steady component of a signal; it also 
removes slow fluctuations.
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Figure 1–6  
The effects of filtering on 
a mixed-frequency 
signal: a high-pass filter 
removes low frequencies; 
a low-pass filter removes 
high frequencies.

Figure 1–7  
A signal with various 
low-pass filter settings: 
some filtering cleans up 
noise, but too much 
distorts the high-
frequency spikes.
Filters are imperfect. A 200 Hz low-pass analog filter, say, might leave 
frequencies up to 150 Hz untouched, reduce a 200 Hz signal to 0.7 of 
its original amplitude (this is its cut-off frequency), and reduce higher 
frequencies more and more. If you were expecting useful frequencies of 
up to 100 Hz, you could sample at 400 samples per second and filter 
out any higher frequencies using a 200 Hz filter. If higher frequencies 
are left unfiltered, then they could possibly be aliased, resulting in the 
appearance of spurious lower frequencies. 

Filtering can change the signal to some extent: its use must be balanced 
against the distortions it can remove, such as noise, baseline drift, and 
aliasing. If the filter settings overlap the bandwidth of a signal, then the 
signal will have components removed. If you were interested in a 
waveform with components down to 5 Hz and used a 20 Hz high-pass 
filter (filtering out 0 to 20 Hz signals), then vital information would be 
lost from the signal. 

Original signal (high 
and low frequencies)

Filtered signals

High-pass 
filter

Low-pass filter
Chart Software

Unfiltered

Noise reduced

Over-filtered
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Filtering can also be applied to the recorded digital data after 
acquisition. Chart has a smoothing channel calculation available to 
help remove noise, clutter, and unwanted high frequencies from signals. 
This acts as a simple low-pass filter by averaging adjacent data points, 
but shouldn’t be used as a substitute for the correct low-pass filter 
during recording. It is most useful in helping clean up signals recorded 
at high sampling rates.

Digitization

When analog data such as voltage amplitude is converted to digital 
form for use by a computer, it must conform to a fixed number of values 
(for instance, a digital thermometer might only measure temperature to 
the nearest degree). Any analog values between these values are 
rounded up or down. The approximation is usually very good, since the 
number of values is very large. The analog-to-digital converters (ADCs) 
that perform the digitization usually generate a number of values equal 
to a power of two: an ADC with 12-bit resolution can resolve a signal 
into 212 or 4096 possible amplitude values, which is adequate for most 
biological signals; an ADC with 16-bit resolution can resolve a signal 
into 216 or 65 536 possible amplitude values. 

e-corder units use 16-bit ADCs. Chart fits 64 000 of the 65 536 
possible values to the range, allowing some leeway above and below 
for a small amount of overrange. Thus the 10 V range would be 
divided into 64 000 fixed values from –10 V to +10 V; the minimum 
change in voltage that could be discerned at that range would be 
0.3125 mV. At 10 mV range, the minimum discernible voltage change 
would be 0.3125 µV. ADC resolution is part of the hardware, and 
d 9

cannot be set by the user. 

Range

Range is inversely proportional to gain, the amount of amplification, 
and is a more useful concept than gain since it relates directly to the 
signal being measured. The range can be set independently for each 
input on an e-corder recording unit.

If the signal amplitude exceeds the range, there will be severe loss of 
information. (This is the same as ‘clipping’ in a stereo system where 
music is severely distorted when the amplitude exceeds the capabilities 
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Figure 1–8  
Noise in a signal (left) 
can mar the original 
signal (right), unless 
filtered out.
of the amplifier.) Any signal exceeding the range is ‘out of range’, a 
condition indicated where no amplitude can be given. If there is any 
possibility of this condition occurring, you should set the range to a 
larger value.

For the best resolution, the maximum amplitude of the signal you are 
interested in should be reasonably close to the chosen range without 
exceeding it. That way, the minimum change in voltage discernible in 
digitization remains small in relation to the signal being measured (the 
signal is digitized after it is amplified). If a signal is very small in 
relation to the range, then its resolution will be degraded. In extreme 
cases, the recorded waveform may appear stepped rather than smooth. 
Even though you could see a ±380 mV signal easily enough at the 
default 10 V range, you would use the 500 mV range to measure it at 
maximum resolution. It would be safer in practice to use a 1 V or 2 V 
range, though, since unexpectedly large peaks could exceed the 500 
mV range if the signal was not well-behaved.

Changing the display of the waveform on screen (by enlarging it in the 
Zoom window or by stretching or shrinking its Amplitude axis, for 
instance) does not affect its resolution, just its appearance. 

Noise

Noise is defined as ‘unwanted signal’. It is likely to be a problem at 
lower range settings, when you are trying to measure very small 
signals. Random noise, such as thermal noise, is inherent in all 
electronic circuits, including those of the e-corder recording unit, and 
generally must be filtered to minimize it. The trick is to choose a low-
Chart Software

pass filter setting that removes most of the background noise without 
unduly changing the signal of interest. 

For biological signals, differential inputs are preferred, and can reduce 
common-mode noise due to ground loops. (Ground loops occur where 
multiple connected pieces of recording equipment are connected to 
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mains power grounds.) e-corder single-sided inputs are ‘quasi-
differential’, and automatically neutralize up to a fraction of a volt of 
ground loop noise, the most that normally appears.

Other important causes of noise are stray electromagnetic and 
electrostatic fields, and include interference (often at the mains 
frequency of 50 Hz or 60 Hz) from unshielded power lines, switching 
equipment, fluorescent tubes, transformers, computers, network cables, 
VDUs, and so on. The interference can interact significantly with a 
recorded signal. Reasonable care in the arrangement and shielding of 
equipment and cables will reduce such interference. Particularly 
delicate measurements, however, may require special apparatus and a 
controlled environment. 

Display and Expectations

The two most important settings for data recording are the input range 
and recording speed. Provided these are set correctly, then your signals 
will be recorded which high precision. However, the actual 
appearance of the data on the computer monitor can be affected by the 
vertical magnification and time base compression used in the Chart 
display settings, and screen resolution of your monitor.

The screen display on a monitor is generally about 72 dots per inch 
(dpi), so the apparent resolution may be poor if the display is kept 
small. However, the resolution of the underlying recorded data is 
independent of the resolution of the display: even if the channel is very 
thin or not visible on screen, sampled data are recorded at full fidelity, 
as can be seen by expanding the channel display or examining the 
d 11

signal in the Zoom window.

High-resolution printing will also show data more accurately. 

It is important to check display settings and axis labels carefully when 
examining a signal. 
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Figure 1–9  
An signal shows with 
various display settings.
Chart Software
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C H A P T E R  T W O

Introduction to Chart

Chart is one of the application programs that together with your 

e-corder make up the e-corder system, a powerful data acquisition 

system driven from an intuitive and robust interface. 

This chapter provides a general overview of Chart, looks at the Chart 

window in detail, and deals with the basics of recording data in Chart.
13
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An Overview of Chart
Chart, together with the e-corder hardware and a Macintosh computer, 
gives you the capabilities of a multi-channel chart recorder and more. 
Depending on your hardware, you can record on as many as sixteen 
channels at various rates. Chart also provides a range of powerful and 
easy-to-use features that transcend the limitations of a mechanical pen-
and-ink recorder. 

Controls and Display

Controls are easy and intuitive. The Chart window can be resized like 
other Macintosh windows. The data display area can be compressed 
or expanded horizontally, or split into two panes, and the vertical size 
of each channel can be changed to suit, simply by dragging the 
dividing bars. Channels can be turned off or hidden if they are not 
required, or overlaid to compare waveforms directly, and their 
Amplitude axes can be dragged, stretched, scaled, or set through a 
dialog box for optimum data display. 

Range and filtering options, and even sampling rate, can be set 
independently for each channel. You can type in appropriate channel 
titles and define units of measurement for each channel. Display colors, 
patterns, and grids can be altered. A Tool bar allows common 
operations and user-defined macros to be performed with a single click 
of the mouse. 

Recording
Chart Software

You can not only view data as they are sampled, but also review past 
data while sampling, in a split or single window. Sampling rate and 
range can be changed while recording at lower sampling rates. You 
can start and stop sampling at any time and build up a Chart file with 
many individual sections of data. Recording is usually to disk, and data 
recorded this way can survive a power failure or system crash — which 
is especially useful if you are making lengthy recordings. (You have the 
option of recording to RAM if your disk drive is slow.) Comments to 
mark points or areas of interest can be made during or after recording, 
on all or on specific channels. A Notebook accessory is available for 
making general notes about a recorded data file. 
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Saving, Printing, and Editing

Chart recordings can be printed, edited, and saved to disk for later 
review. You can save the settings of any Chart file to enable an 
experiment to be repeated quickly and easily, without having to go 
through the process of setting it up again. You can print a selection or 
save it as a file — this allows for easy editing by extracting only that 
part of the recording you need. You can append files to the end of an 
open file, to produce recording summaries conveniently in a single file. 
Data can be transferred as text to other Macintosh applications, such as 
spreadsheets or statistics programs. 

Analysis

When you have finished recording, you can scroll through your data 
and make measurements directly from the recording — since everything 
is digital, you are given a direct read-out, with no chance of 
measurement errors. You can measure relative to a reference point set 
using the Marker, or set a baseline to remove an unwanted offset. You 
can search any channels for comments, peaks and troughs in the 
waveform, block boundaries, and so on, and select data according to 
criteria you specify. The Data Pad calculates and stores statistics about 
recorded data, and can be printed out or have its data transferred to 
other applications. The X–Y window gives you a plot of data from one 
channel against another. Chart has an Overview miniwindow for 
finding areas of interest in large recordings, and a Zoom window for 
examining a section of the recording in more detail in which you can 
overlay channels (independently of any overlaying in the Chart 
window). Exclusions let you mark points and areas to be excluded from 
o Chart 15

data searches and so on. Comments and exclusions in a file are listed 
in the Comments & Exclusions window, from which you can go directly 
to the part of the record where they were added. 

Advanced Features

Triggering functions let you control when Chart starts and stops 
recording, using internal or external measurements. The Stimulator 
allows you to set up an external stimulus for an experiment, and the 
Stimulator Panel control allows this to be turned on or off or adjusted as 
required during recording. A range of computed input functions can be 
applied in real time to measured data: event counting, signal 
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frequency, and so on, cyclic and envelope parameters, and differential 
and various integral functions are all available. Computed data can be 
displayed in place of the raw data or in addition, on another channel. 
Data can be smoothed by channel calculations to remove unwanted 
high frequencies in the waveform.

Customizing and Automating

Chart can be extensively customized for your purposes. Controls, and 
menus and their commands (and keyboard shortcuts) can be locked, 
hidden, or altered, and Chart as a whole simplified, say, for student 
use. Chart files and related files such as documentation and multimedia 
files can be added to the ‘Experiments Gallery’ for easy access. Macros 
can be created to speed up and to automate complex tasks, stored in 
any menu in a file, and added to the Tool Bar as buttons. Chart 
extensions are available to add specialist analysis capability to Chart, 
and to provide data export options to other applications. For example, 
physiological signal peaks can be analyzed using Peak Parameters, 
and Export QuickTime allows you to play your recorded data in a 
movie on a web site or in a presentation. 

The Timed Events dialog box allows you to create a list of actions you 
want performed at particular times: Chart will do the rest. By setting up 
the digital output lines appropriately (only available on specially 
configured e-corder units), you can control their states while recording, 
to turn external devices on and off, control pumps, relays, indicator 
lights, and so on. By setting up a list of comments that correspond to 
states of the e-corder digital inputs, the external trigger or stimulator, or 
various Function keys, you can have Chart automatically insert 
appropriate comments while recording when the digital inputs change, 
Chart Software

a Function key is pressed, and so on. 

Opening a Chart File
It is a good idea to have a Chart file open if you are working through 
this guide, so that you can try the commands, controls, and settings as 
they are discussed in the text. First, make sure that the e-corder is 
properly connected to your computer, and is turned on. You may wish 
to learn Chart without the e-corder — if you have taken home a copy 
on your laptop, for instance. In this case, on opening a file, a dialog 
box will offer the Analysis option, which lets you use Chart except 
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Figure 2–2  
The Open dialog box 
(see the Macintosh 
system help for the many 
shortcuts available).

Note
Hold down the 
Command key as you 
start up Chart to bypass 
the current start-up 
settings and use the 
default settings. Release 
the key when the alert 
box appears, and click 
the Yes button.

Figure 2–1  
Chart desktop icons: 
double-click one to open 
Chart.
where it requires the e-corder hardware, such as for recording. 
Unusable controls appear dimmed. 

To open a Chart file, click one of the Chart icons in the Finder to select 
it, and choose File > Open…, or simply double-click the icon. There 
may be a short delay while Chart sets up the e-corder. The top icon in 
Figure 2–1 shows the Chart application, which if double-clicked will 
open a new untitled file with the current start-up settings. The middle 
icon shows a file of recorded data, which opens up a saved Chart data 
file. The bottom icon shows a a settings file, which will open an untitled 
file set up in a predefined way.

In each case, Chart opens and the Chart window will appear. By 
default, the window of a new untitled file opened when Chart starts up 
will fill the screen, but its size can be adjusted. If you start Chart without 
a file and the Experiments Gallery has been set up, the Experiments 
Gallery dialog box will appear at this point: close the dialog box and 
ignore it for now; its use is described in Chapter 5. 

Once the Chart application is open, you can open an existing file or 
create a new one. Choose File > New to create a new, untitled Chart 
data file. If you choose File > Open…, the Open dialog box appears 
(Figure 2–2). 

At the top of the dialog box, the Show pop-up menu lets you choose 
which type of files are displayed. All Chart Documents displays data 

Choose a file 
type here
▼ Refer
The Experiments Gallery,  
p. 96
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and settings files, or you can choose to display one or other of these 
types individually. Choosing Chart (Win) Data displays Chart for 
Windows data files. Other choices may be added through Chart 
extensions.

If the Discard Existing Macros checkbox is on, it prevents macros 
accumulating as you open files (this is discussed in a later chapter).

The information in a Chart data file is made up of data and settings. 
Data are the recorded waveforms. Settings are of two sorts: those that 
affect recording, such as the sampling rate, channel ranges, triggering, 
and stimulation functions; and those that affect the way the data looks, 
such as the window size, channel areas, and display settings (along 
with menu arrangements and macros). A data file opens with the 
settings it had when it was saved. Chart lets you have only one data 
file open at a time, so if you open another, your old file must be closed. 
If it has any unsaved changes, an alert box informs you and lets you 
save or discard them, or cancel. If you create a new file, the new file 
continues to use the settings from the file just closed.

Opening a settings file, if no Chart file is open, creates a new untitled 
data file with the defined settings. If an existing Chart data file is open, 
then an alert box gives you the choice of creating a new untitled data 
file with those settings, or applying the settings to the current Chart file. 
Applying settings to a file affects the display of existing data and the 
recording settings for subsequent sampling. It does not affect the 
recording settings of, or alter, existing data: sampling rates, ranges, 
applied units, and so on are all left unchanged.

Opening a Chart for Windows File
Chart Software

Chart for Macintosh can import files written by Chart for Windows. To 
show Windows formatted Chart data files, choose Chart (Win) Data in 
the Show pop-up menu. If one is chosen and the Open button clicked, a 
new untitled file will be opened containing the Windows data. The 
data and channel titles are imported. The settings for range, computed 
input, and units conversion are not imported and will need to be 
redefined if they are required for new data. Channel calculations are 
ignored (only recorded data is imported). Most display settings, such as 
data trace colors, channel heights, and so on, are ignored. The Data 
Pad and Macros are also ignored.
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▼ Refer
The Experiments Gallery,  
p. 96
Closing a File or Quitting Chart
To close a Chart file, choose File > Close. To quit Chart, choose Chart 
> Quit. In either case, if you have made any changes, an alert box will 
appear, asking you if you wish to save your work. Click the Save 
button if you want to keep the changes you have made; click the Don’t 
Save button to discard them. Note that when you close a Chart file, the 
Experiments Gallery dialog box (see Chapter 5) will appear (provided 
that it has been set up).

The Chart Window
All essential controls for recording data are provided within the Chart 
window, illustrated in Figure 2–3. These controls are discussed briefly 
below, and, in most cases, in more detail elsewhere. There are three 
main areas in the window, from left to right: the Amplitude axis area, 
which contains the scale for each channel; the data display area, 
which contains recorded data; and the channel control area. 

The Menu bar at the top of the screen contains the Chart menus (see 
Appendix A), allowing you to set up and modify the way Chart looks 
and behaves. Window > Chart Window returns to the Chart window 
from another, or creates a new, untitled Chart data file. The Tool bar 
appears by default between the Menu and Title bar of the Chart 
window, and provides shortcuts for common tasks, including returning 
to the Chart window or opening a new file. 

Navigating
o Chart 19

The Scroll bar lets you move through the file’s data in the Chart 
window. The box in the Scroll bar shows where the display area is in 
relation to the file as a whole. Click the left or right arrows, or drag the 
box, to move smoothly left or right. Click in the gray region to either 
side of the box in the scroll bar to jump a screen left or right. You can 
also move left or right by pressing, respectively, the left and right arrow 
keys on the keyboard. Hold down the Option key while pressing the left 
or right arrow key to jump a block left or right (the block boundary will 
be moved to the left edge of the Chart window). Hold down the 
Command key while pressing the left or right arrow key to go to the 
beginning or the end of the file. 



20

The Rate pop-up menu lets you 
choose how fast Chart samples data

Scale 
pop-up 
menu

< The data display area 

Amplitude 
axis

Re-sise 
channel 
display by 
dragging 
the channel 
separator

Split 
bar

Marker

Data 
display 
bar

Memory 
remaining

Set channel 
range — the 
button is 
dimmed if the 
channel is off

Set the channel 
function

Range/ 

Rate/Time 
display

Set the signal 
trace color

Block button

Scaling 
buttons

Time & Date buttonFigure 2–3  
The Chart window.
Scroll 
bar

Compress or re-
expand the record 
horizontally

Start /stop 
sampling

Pause/resume recording 
while still sampling

< Time axis >

Amplitude 
display

Click here for a 
channel status 
pop-up list

Pause/resume 
scrolling while 
sampling
Chart Software

You can manually scroll data by holding down the Option key while 
the pointer is over the data display area: this turns the pointer into a 
hand that can drag the data back and forth. If you ‘push’ the data, by 
moving the hand and releasing the mouse button while it is moving, the 
file keeps scrolling through automatically at the speed at which you 
moved it. It will stop at the beginning or end of the file, or when you 
click anywhere in the Chart window. 

You can go directly to a block of data by clicking its numbered Block 
button. Clicking and holding the mouse down over the button pops up 
a menu letting you choose to go to the block or to select it. 
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▼ Refer
Units Conversion,  p. 46
View Buttons

The View buttons allow you to compress or re-expand the horizontal 
scaling of a file in the Chart window (the steps are 1, 2, 5, 10… up to 
2000 to 1). To see more of the file on screen at once, click the left (far 
mountains) button to compress it. To expand the file out again, click the 
right (near mountains) button. The pop-up menu between the two shows 
the current compression and lets you choose the extent of horizontal 
compression directly. If you print a horizontally compressed file or 
selection, then it will print at the compression at which you see it on 
screen.

The Chart Axes

The horizontal Time axis, above the Scroll bar along the bottom of the 
Chart window, records the time from the start of sampling or the 
absolute time in various formats, depending on the time display mode 
(which can be set using the Display Settings dialog box).

For each channel, the vertical Amplitude axis on the left of the window 
indicates the amplitude of the recorded waveform. Note that the axis 
area remains blank until some data are actually recorded. The scale for 
each channel is initially set by the range control on the right side of the 
window, but can be stretched or dragged using the pointer. Display 
options can be chosen from the Scale pop-up menu, including which 
channel of an overlaid set is active. The data trace color, title, and units 
of the active channel are shown in the axis. Units are volts by default, 
but may be changed to any other units (for example mmHg, Ω, or kPa), 
by using units conversion.
o Chart 21

Scaling Buttons

The Scaling buttons are at the bottom left of each channel’s Amplitude 
axis. Click the up button to enlarge or down button to reduce the 
vertical scale, halving or doubling what is shown each time. 

Channel Controls

The channel controls are located rightmost in the Chart window, at the 
right of the data display area. 
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The Rate pop-up menu at the top right of the Chart window controls the 
sampling rate, which is usually the same for all channels (but can be set 
independently for each channel).

There are three individual channel controls for each channel. Click the 
button to the left to choose the range from the Range pop-up menu. 
Click the channel title or the button at its right to choose options from 
the Channel Function pop-up menu. Click the colored box to choose the 
channel’s data trace color from the Color pop-up menu. The channel’s 
Range pop-up menu button is dimmed and unusable when the channel 
is off. 

Sampling Parameter Display

The Rate/Time display shows the current set rate of sampling (the 
sampling rate in samples per second and the scrolling speed in seconds 
per division) if the pointer is over the channel control or Amplitude axis 
areas, or the time at the pointer position over the data display or Time 
axis areas. If channels are set up to record at different rates, then the 
Rate/Time display shows the maximum. The Range/Amplitude display 
shows the current range of each channel if the pointer is over the 
channel control or Amplitude axis areas, or the amplitude of the 
waveform at the pointer position over the data display or Time axis 
areas. 

The Channel Status indicator is a diamond at the right of the channel 
control area for each channel. It is solid if the channel is on, open if the 
channel is off, and contains an = sign if a channel calculation is 
applied. Clicking the indicator pops up a list showing the sampling 
rate, range, what is to be recorded (raw data or a computed function, 
Chart Software

and from which input), the eDAQ Amp or Pod settings and filter 
settings, and any active channel calculation. 

Data Display Area

Recorded data are shown in the area of the Chart window bounded by 
the channel control area on the right and the channel Amplitude axes 
on the left. The data for each channel are to the left of the channel title 
and bounded above and below by horizontal bars. These bars, or 
channel separators, can be dragged up or down to vary the size of the 
channel display areas (double-click them to restore their original 
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Split bar
positions). The separators can also be removed, to overlay adjacent 
channels. 

Split Bar

The vertical Split bar, at the left of the data display area, can be 
dragged to the right to split the data display area into two parts, each 
with its own scroll bar and View buttons (if there is room), so that you 
can compare different sections of recorded data, or compare data 
already recorded with new data as they are sampled. 

Memory Indicator

A box at the bottom left of the Chart window gives a numeric indication 
of current memory available for recording (disk or RAM), in gigabytes, 
megabytes, or kilobytes. If the remaining memory becomes very low, 
the box is highlighted. 

The Marker

The Marker can be found in a box at the bottom left of the Chart 
window, above the memory indicator box. It can be dragged from its 
lair onto the data display area to set a particular data point on a 
waveform as a zero reference point, so that measurements can be 
made relative to that point. Double-click it or click its box to send it 
home. During sampling, the Marker temporarily disappears, and its 
box shows roughly how much of the computer’s processing power is 
used during the operation. 
o Chart 23

Start Button

To start sampling, click the Start button at the bottom right of the Chart 
window. The Start button is also available to the right of the Tool bar. 
The button then changes to Stop: click it to stop sampling. The button 
may show a dimmed Wait… while starting or stopping if the e-corder 
or computer is particularly busy. 

Record/Monitor Button

The Record/Monitor button at the bottom right of the Chart window, to 
the left of the Start button, controls whether data are recorded as they 
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Figure 2–4  
The Tool bar.
are sampled (the default) or merely displayed, and discarded when 
sampling stops. When monitoring (to get an idea of incoming signal 
characteristics, perhaps), a cross is shown. Click the button to switch 
between recording and monitoring. 

Scroll/Review Button

The Scroll/Review button at the bottom right of the Chart window, to 
the left of the View buttons, controls whether data are scrolled while 
recording (the normal behaviour), or whether you can instead use the 
scroll bar to review the recorded data even during recording. Depress 
the button for the review option. 

Time & Date

Click the Time & Date button, the clock at the top right of the Chart 
window, to open a dialog box letting you set the time scale format, and 
whether to display the date and time data at the cursor position were 
recorded. 

Pointer

The pointer will change form as you move it about the Chart window, 
giving you an indication of its function in certain areas — it becomes 
an I-beam over a text entry area, for instance. It becomes dimmed 
when it cannot do something under particular conditions. 

The Tool Bar
Chart Software

The Tool bar provides shortcuts for common tasks in Chart in the form of 
buttons. The default buttons are shown in Figure 2–4: you can change it 
to suit your preferences, and add new buttons for any available 
macros. You can assign Function keys to the buttons for use with an 
extended keyboard. The Tool bar can be hidden if you don’t want to 
use it, or moved by Shift-dragging it. 



Chapter 2 — Introduction t

Figure 2–5  
Control changes during 
recording.
The text box at the right of the Tool bar tells you the function of the 
button that the pointer is over. It will also indicate the state of Chart in 
some cases: loading data or settings, saving, sampling, recording a 
macro, and so on. 

Recording
To start recording, click the Start button at the bottom right of the Chart 
window or to the right of the Tool bar. The button then changes to Stop: 
click it when you want to stop recording. The button may show a 
dimmed Wait… while starting or stopping if the e-corder or computer is 
very busy. Chart uses the visual metaphor of a mechanical chart 
recorder: recorded data scroll across the data display area from the 
right of the window as if the display area were a roll of paper in such a 
device, with new data being drawn at the right and old data moving 
left. 

When recording, the controls at the bottom of the Chart window 
change, as shown in Figure 2–5. The Time axis area goes gray, and 
the Recording Status indicator appears; and the scroll bar is replaced 
by the comments bar. The Marker is replaced by an indicator showing 
roughly how much of the computer’s processing power is used during 
sampling. The controls are discussed in detail later on.

Recording Status indicatorCPU load indicator
o Chart 25

Display While Recording

While recording, the amplitude of the signal being recorded is shown 
in the Range/Amplitude display at the right of each channel, unless 
sampling at higher rates. If units conversion is being used, the value is 
displayed in the set units rather than as a voltage. The time is also 

Channel the comment 
applies to (* for all)

You can add your 
comment text here

Comment 
number box
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▼ Refer
Display,  p. 78

Figure 2–6  
Displays of the time and 
amplitude while 
recording.
shown in the Rate/Time display at the top of the channel control area, 
in a form depending on the time display mode (usually from the start of 
the block). These displays are updated every second or so. 

Chart records to disk by default, or memory (RAM) if data buffering is 
turned off, and sampling stops automatically when disk space or 
memory runs out. The space left in which to record is monitored. A 
small box at the bottom left of the Chart window gives a numeric 
indication of current remaining space, in gigabytes, megabytes, or 
kilobytes. If the remaining memory becomes very low, the box is 
highlighted. 

Blocks and Settings

A solid vertical line is drawn between two sections (user-defined 
‘blocks’) of recorded data to indicate discontinuity, for instance if you 
stop recording and then start again. If you change the range of one or 
more channels, a new scale is drawn between the two blocks for each 
changed channel to show the new range. Blocks always apply across 
all channels, even if only one has been changed. Block numbers are 
shown at the start of blocks as white-on-black tags in the Time axis. 
Block numbers, lines, and scales can be hidden if this is desired. 

At slower rates, you can change the sampling rate and channel range 
settings without having to stop and restart recording. Chart will simply 
start a new block at the point where the settings were changed, 
drawing a solid vertical line or a new scale as appropriate. The display 
will momentarily stop scrolling while you are making settings changes, 
then update once the operation is complete. 
Chart Software

A numbered Block button appears for each block as it is recorded. The 
width of the button is proportional to the number of samples in the 
block. You can go directly to a block by clicking its Block button; 
pressing the button pops up a menu letting you choose to go to the 
block or to select it. In any case, the start of the block is shown (the 
block boundary is moved to the left edge of the Chart window) if it is 
not already visible, and a brief animation shows the block’s position. 
Under the title bar there is a thin black strip, the Data display bar, used 
to indicate where the data display area is in relation to the blocks. The 
bar is positioned over the buttons for the block or blocks visible in the 
data display area, and its length is in proportion to the extent of the 
block or blocks shown. 



Chapter 2 — Introduction t

Scrolling buttons

Figure 2–7  
User-defined blocks of 
data: left break, after 
stopping and starting; 
right, after changing a 
channel’s range.
If there are too many Block buttons to show along the top of the 
window, then left and right arrow buttons appear at either side: click 
them to scroll one Block button left or right — this doesn’t change 
anything except the range of Block buttons that you can see.

Quick Block Information

Often, you want to get information about a recorded block. This can be 
obtained from the Data Pad easily enough, but for a quick check, just 
click and hold down the mouse in the data display area for a channel. 
This highlights the visible area of the block with a heavy border, and 
pops up a list (Figure 2–8) showing the sampling rate, range, any 

Block numberBlock boundary

Data display bar Block buttons
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active units conversion or channel calculation, the block number, and 
the date and time at which the block recording started. (This is similar 
to the information available from the Channel Status pop-up list, but 
applies to existing data rather than the data to be recorded.) 

Recording or Monitoring

The Record/Monitor button at the bottom right of the Chart window, to 
the left of the Start button, controls whether sampled data are recorded 
(the default) or merely displayed on the screen, perhaps to get an idea 
of incoming signal characteristics. When monitoring, sampled data can 
be seen coming in, but the data are not actually recorded, and 
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Figure 2–10  
Recording Status 
indicator display.
disappear once sampling stops. Clicking the button switches between 
recording and monitoring. The data display area is grayed while 
monitoring, so it is easy to distinguish monitoring from recording. The 
grayed area disappears (along with any sampled data in that area) 
once monitoring stops. The button is inactive (and dimmed) when 
triggering is in operation. You cannot add comments while monitoring, 
since there is no real record, so the box in the comments bar is 
dimmed, and typing has no effect.

You can stop or start recording data while sampling normally by 
clicking the Record/Monitor button. This is useful to see if incoming 
signals are behaving themselves before you actually record them. If 
fixed-duration recording is set up and Chart is monitoring rather than 
recording, then when you click the Record/Monitor button, Chart 
records for the set time and then goes back to monitoring. 

Recording Status Indicator

While sampling, a shadow box appears just to the left of the Start 
Figure 2–8  
Block Information pop-up 
list.
Figure 2–9  
Record/Monitor button: 
left, data displayed and 
recorded; right, data 
displayed but not 
recorded.
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button, giving information on the recording status of Chart (see Figure 
2–10): whether data are actually being recorded, or whether Chart is 
waiting for a trigger or for the post-trigger delay time to elapse. This 
gives you a quick visual indication of recording status.

‘Recording’ means that data are being recorded to memory (either to 
disk, the default, or to memory). The waveform icon at the right end of 
the box ripples when Chart is recording. If data are not being recorded 
and are only being displayed on the screen, ‘Not Recording’ shows. 
The waveform icon flashes to give a visual cue. If triggering is set up, 
‘Waiting for trigger’ shows while the e-corder is waiting for a trigger 
event to occur before it starts sampling. If there is a trigger delay, ‘Post-
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Figure 2–11  
General and channel-
specific comments, and 
the pop-up comment box.
trigger delay’ shows after triggering, while the e-corder is waiting for 
the delay to elapse. If the internal timer is set up, ‘Int. Timer’ shows 
while the timer is counting down prior to recording a block of data. A 
few other messages appear in some circumstances, for instance, if an 
operation takes a while to suspend. 

Adding Comments While Recording

During recording, comments can be entered as required, and are 
automatically numbered as they appear. Type what you want to say: it 
appears in the text entry area at the bottom of the Chart window (see 
Figure 2–5). Pressing the Enter or Return key adds the comment to the 
file at the time the key is pressed. By default, the comment applies for 
all channels, and the numbered comment box is preceded by an 
asterisk. To comment on a specific channel, select the asterisk by 
clicking it or pressing the Tab key, and type the number of the channel, 
or click the channel in the data display area: the channel number 
appears (for Channels 1 to 8; you can’t make a specific comment for 9 
to 16 while recording). To apply a comment to all channels, select the 
comment channel number and type a character other than 1 to 8, or 
click the gray area at the bottom of the Chart window (the Time axis 
when not sampling). 

Comments are stored and saved along with recorded data. Comments 
are marked by numbered boxes in the appropriate channel on the 
record, or along the Time axis, and a dotted vertical line. Comment text 
may be visible in the window, or you can read the text in full by 
placing the pointer over the comment box and pressing the mouse 
button. Comments can also be added after recording, by choosing 
o Chart 29

Commands > Add Comment…, and can be read, edited, deleted, 
found, and printed from the Comments & Exclusions window. Comment 
boxes, lines, and text can be hidden if this is desired.



30

Split bar

Figure 2–12  
Time axis control 
changes when reviewing 
while recording.
Background Recording

You can do other things while recording in Chart. You can review 
recorded data, compare old data with new by using the split-screen 
feature, or even leave Chart recording in the background while you run 
other applications. This is useful for longer recordings, since the 
computer is not tied up doing one thing. You do need to be using Chart 
at slower or moderate sampling rates, though, in most cases. 

Recording While Reviewing Data

Normally, when recording in Chart, the recorded data scroll across the 
data display area from the right of the window, with new data being 
drawn at the right and the old data moving left. In these circumstances, 
the scroll bar is dimmed and inactive, and the Scroll/Review button is 
set to Scroll. When the button is clicked, it highlights and depresses, 
and reviewing becomes active. The controls at the bottom of the Chart 
window also change: the Time axis and scroll bar appear, but the 
Recording Status indicator is still evident, showing that you are still 
recording. 

When reviewing while recording, you can use the scroll bar to scroll 
through previously recorded data: the scrolling controls and keyboard 
shortcuts all work normally. You cannot add comments using the 
Comments bar while reviewing, but you can use Commands > Add 

Scroll/Review button set to You can scroll through data already 
Chart Software

Comment… instead. Data are still being recorded, but the new data 
are only visible if you scroll to the right-hand end of the record. At 
faster recording rates, Chart may disable the review feature, since it 
requires more computing power than normal.

Recording With a Split Data Display

You can split the data display area before or during recording, by 
dragging the vertical Split bar to the right. Splitting the data display 
area allows the incoming data to be viewed alongside previously 
recorded data, so that you can compare the two. Chart records 
normally in the right-hand pane, so you can use the Comments bar to 
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▼ Refer
Setting Sampling Rates,  
p. 36
comment on newly acquired data there, and so on, and can scroll 
through the left-hand pane to check waveforms of interest. You can also 
use the split-display feature while reviewing is active, to give two 
independent scrolling views of the data while Chart is still recording. 

Running Other Applications While Recording 

You can run other applications while Chart is recording in the 
background. You will need enough memory (RAM) in your computer to 
be able to run multiple applications, of course. How slowly your other 
applications run while background recording is going on depends on 
the sampling rate (in general, a slower rate would be needed), as well 
as the type of computer you have. It helps if you have a fast computer: 
the faster your computer, the faster it can handle data from the 
e-corder, and therefore, the more time it can give to another 
application. 

Performance
To get the maximum performance from your e-corder, you should have 
a fast computer. At the root of most problems are low processing 
power, memory, and hard disk speed. Slower computers not only limit 
sampling rates, but also limit the rates at which you can make changes 
while recording. If too much data are coming in for the computer to 
cope with comfortably, then changing ranges, bringing up dialog 
boxes, and so on may stop recording.

To estimate how much of your computer’s processing power is used, 
look at the CPU load indicator that appears in the Marker box during 
o Chart 31

sampling. Although this indicator is at best approximate, anything 
greater than 50% indicates the system is under strain.

Chart estimates computer performance when it starts up and when it 
first starts sampling data. If the estimate is too high and the computer 
can no longer cope with the amount of data being collected, Chart 
stops recording and notifies you of the problem. This may occur if the 
amount of incoming data increases markedly, or after a while when 
recording very large files to disk, since the speed of writing to disk 
decreases as the disk becomes fragmented. Fragmentation means that 
data are written in small blocks all over the disk rather than as one 
contiguous file. This happens when a disk is nearly full, for instance, so 
that data must be written to leftover spaces. (As a rule of thumb, hard 
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▼ Refer
Data Buffering,  p. 198
disks should always have at least 10% free space, and should be 
checked regularly for file fragmentation with disk-checking software.) 

It is advisable to test the system before critical recordings using the 
sampling rates at which you intend to record, especially for extended 
fast sampling. Recording to disk (page 34) is recommended as it will 
give good performance on most computers, and in the event of a 
power failure or system crash, you will not lose your data. Recording to 
RAM (page 33) may give better performance on slower computers, but 
only if the amount of data being collected is less than the amount of 
RAM: otherwise virtual memory will be used, requiring a fast hard disk 
and processor. 

Background activities decrease the ability of the computer to cope with 
the data it gets from the e-corder. To avoid data loss at high sampling 
rates, it is best if Chart is the only application running. You may also 
want to turn off sharing services (in the Mac OS X System Preferences) 
such as file sharing, and unmount file servers.

Chart usually performs better with more memory. You can reduce the 
memory required for the Chart window buffer and speed up display by 
shrinking the Chart window and reducing the color depth of the 
display. Chart extensions (software plug-ins that add features to Chart) 
use up allocated memory and may slow down Chart: you should only 
use those that you need. Using computed inputs, or digital filters on 
many channels also limits sampling rates. 

Interruptions
Chart Software

Some activities may interfere with the transfer of information from the 
e-corder to the computer, possibly resulting in a loss of data. When 
recording critical data, avoid copying to and from floppy disks, or 
using applications that access the hard disk frequently (using virtual 
memory with many programs open has the same effect). Unusual 
network activity and screen savers may also cause performance 
problems, especially at higher sampling rates. 

Recording Length

How long you can record for depends primarily on the free space you 
have in which to record. Chart can record to disk (the default, usually 
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Figure 2–13  
The lower portion of the 
About Chart dialog box.
allowing for longer recording) or RAM (may be useful if your disk drive 
is slow) as set up in the preferences for data buffering. 

Recording limits also depend on the sampling rate, the number of 
channels sampled, and the extent to which Chart compresses the data. 
Each sample takes at most four bytes of storage (with no compression), 
so recording on one channel at 100 000 samples per second for 
example would use 1 × 100 000 × 4 = 400 000 bytes (400 K) of 
memory per second, or 24 megabytes per minute.

Compression takes place during recording. The compression efficiency 
depends on how the signal varies: signals that change very slowly, 
such as a straight line or gradual curve, can be compressed a great 
deal, while complex and rapidly changing signals may not compress 
much at all. The extent of compression, as well as the amount of free 
space and number of data points, can be seen by recording some data 
of the type in which you are interested, then selecting Chart > About 
Chart… to view the results.

Recording to RAM

Recording to RAM (physical memory) may be faster than recording to 
disk when using a slower computer. However, the benefits will be 
o Chart 33

limited by the amount of RAM you have; if you need more space for the 
file you are recording than there is RAM, Chart will start using virtual 
memory, which accesses the hard disk anyway. You should also note 
that when you are recording to RAM, your data will be lost in the event 
of a power failure or system crash.

Chart uses some memory for an off-screen buffer to speed up data 
display. If the Chart window is large, more memory is used, especially 
at increased color depths. If the system is short on memory, you can use 
a little less by shrinking the Chart window to a smaller size and 
reducing the color depth of the display. 
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▼ Refer
Memory Cache,  p. 198
Recording to Disk

If you record to disk, you are only limited by the amount of free space 
on your disk. Computers almost always have more disk space than 
RAM, and data buffered to disk by Chart can survive a system crash or 
power outage, so recording to disk is a better choice unless the 
slowness of your computer forces you to record to RAM. 

Chart has application limits of 16 000 or so blocks of data per channel 
and 256 000 000 samples per channel. The blocks are either defined 
by the user (starting and stopping recording and so on), or internally by 
Chart, which records continuous data in blocks of 16 000 samples at 
all sampling rates. Note that only the user-defined blocks are marked 
visually or used for selection purposes. At four bytes per sample, this 
gives limits of 976 MB per channel. The maximum file size for a Chart 
file would therefore be 15.2 GB with no compression (for 16 channels); 
but Chart limits maximum file size to 2 GB after compression. Chart will 
give an alert and stop sampling when it reaches this limit. 

Files recorded by most users will typically be a lot smaller than the 
above limits. If you do record very large files (of the order of 1 GB), 
note that performance and manageability can be affected; for instance, 
saving could take a few minutes, during which recording would not 
take place. It is probably more convenient to save a large, long-term 
data recording as a series of smaller files, using macros. If your 
computer is taking a lot of time to perform actions on large files, it may 
help to change the size of the memory cache (Chart > Preferences > 
Memory Cache…).
Chart Software
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C H A P T E R  T H R E E

Setting Up Chart

Chart gives easy access to basic settings and also offers a flexible 

array of setups suitable for different types of data. 

This chapter describes basic settings controls such as the sampling rate 

and the channel range, together with features such as input 

amplification, units conversion, triggering and stimulation. 
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Figure 3–1  
The Rate pop-up menu 
and the slow submenu.

Figure 3–2  
The graticule: with the 
display at 1:1, it is one 
division wide.

▼ Refer
Channel Settings,  p. 51

Division
Setting Sampling Rates
You can choose the sampling rate using the Rate pop-up menu at the 
top right of the Chart window. If the pointer is not over the data display 
area or Time axis, the sampling rate (the number of samples taken per 
unit time) and the scrolling speed (the time taken for each graticule 
division to scroll past) are shown in the Rate/Time display beside the 
pop-up menu. The sampling rate is usually the same for all channels, 
but can be set independently for each. 

Rate/Time display

Select a sampling 
rate directly by 
choosing it
Chart Software

Display While Sampling

Normally signals are shown as scrolling across the data display area 
from the right to left. The data display area is marked into divisions by 
a graticule, or grid. 

Divisions are always 20 pixels wide at any horizontal scale, and are 
marked by the dot graticule in the data display area (they line up with 
unit divisions on the Time axis). The time taken for each graticule 
division to scroll past depends on both the sampling rate and the 
horizontal scale set using the View buttons. The compression indicated 
in the View buttons indicates the samples per pixel: at 1:1, each pixel 
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▼ Refer
Performance,  p. 31
represents one sample, and there are 20 samples per division; at 20:1, 
each pixel represents 20 samples, and there are 400 samples per 
division. 

Maximum Sampling Rates

The Rate pop-up menu lets you directly choose continuous sampling 
rates of from one sample per second up to 200 000 samples per 
second on one channel, 80 000 on two, 40 000 on three or four. 

Maximum sampling rates may also be limited by the speed of the 
computer. When Chart starts up, it gauges the performance of the 
computer system at a range of tasks, and works out its probable limits 
when sampling data. Chart gives an alert if these limits are exceeded.

Slow and Fast Sampling Rates

Chart offers a Slow Sampling submenu, which has the following rates 
(Figure 3–1): one sample every 2 s, 5 s, 10 s, 15 s, 30 s, 1 min, 
2 min, 5 min, 10 min. Note that at these slower sampling rates, the 
e-corder actually samples more quickly and returns an average value. 

Fast Sampling

At faster rates Chart doesn’t scroll from right to left when drawing data 
on the screen, instead, the signal is drawn on screen from left to right, 
and when the right edge is reached, drawing starts again at the left (a 
vertical line precedes the newly drawn data crossing the screen). The 
effect looks like a series of sweeps are being made even though the 
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recording is actually continuous. In addition, the graticule is not drawn 
while sampling, and the data are automatically scaled (compressed) 
horizontally, the amount depending on sampling rate. The exact speed 
at which this happens is dependent on the speed of the computer, and 
is necessary as very fast scrolling signals could not be adequately 
displayed as a continuous movement.
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Figure 3–3  
Channel pop-up menus: 
Range, Channel 
Function, and Color.
Channel Controls
Each channel in the channel control area has three pop-up menus, 
Range, Channel Function, and Color. Clicking the Range pop-up menu 
lets you select the channel’s input range. The default setting is 10 volts 
(this means from –10 V to +10 V). For the best resolution, the amplitude 
of the signal you are interested in should be reasonably close to the 
chosen range without the risk of exceeding it. If the signal is too large 
or small at a range, select a more appropriate value. Clicking the 
channel title or the button at its right opens the Channel Function pop-up 
menu, which gives access to the other channel controls, described 
below. 

Click here 
to open 
the Range 
pop-up 
menu

Click here to 
open the 
Channel 
Function pop-
up menu

➠

➠
Color pop-
up menu
▼ Refer
Waveform Color,  p. 72
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Turning Channels Off and On 

The number of channels on when Chart starts up will be the same as the 
number of inputs on the connected e-corder. These channels will be set 
to record the raw data from the corresponding inputs. The rest of the 
channels, if any, will be off. Chart can display 16 channels. The 
number of channels that can be turned on, though, depends on the 
attached e-corder. When first turned on, any spare channels will be set 
to record from e-corder Input 1. They can be used for any computed 
function as required, though, using raw data from any input. Channels 
can display calculations even when turned off. 
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▼ Refer
Channel Settings,  p. 51

Figure 3–4  
Data display during 
recording (top) and after 
recording (bottom) with a 
channel off.
Choosing Channel Function pop-up > Turn Channel Off turns the 
channel whose pop-up menu was used off. The menu command then 
becomes ‘Turn Channel On’, and if chosen, turns the channel on again. 
Choosing the Input Amplifier… or Computed Input… menu commands 
will also turn the channel on before they open a dialog box, since the 
channel must be on for these dialog boxes to be used. Channels can be 
turned off or on while you are recording — this creates a new block in 
the record. You can also turn channels on and off using the On column 
in the Channel Settings dialog box. 

There is a shortcut for dealing with multiple channels. If you hold down 
the Command key while opening the pop-up menu for a particular 
channel, the menu command will be plural: choosing it will turn that 
channel and all those below it off, or those with visible data on. When 
a channel is turned off, its Channel Status indicator is an open diamond 
rather than a solid one, its Range pop-up menu button becomes 
dimmed and inactive, and its Range/Amplitude display is replaced by 
‘Channel Off’ instead of a range when not recording. 

While recording normally, the amplitude of the signal being recorded is 
usually shown in the Range/Amplitude display at the right of each 
channel, but if a channel is off, this display stays blank. The data 
display areas of channels that are turned off appear gray while 
recording, and afterwards, the areas in the record where a channel 
was turned off appear blank (there is neither graticule nor data).  

The Range pop-up menu is 
dimmed
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The block line in Channel 1 
shows starting and 

The blank area in Channel 
2 shows nothing was 

The channel turned off is 
gray while recording

The Channel Status 
indicator is open
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▼ Refer
Computed Input,  p. 153

▼ Refer
Units Conversion,  p. 46

▼ Refer
The Input Amplifier,  
p. 41

▼ Refer
Channel Calculations,  
p. 167
Other Functions

The other functions in the Channel Function pop-up menu are described 
briefly below, and more fully elsewhere. Channels unable to be turned 
on have no Input Amplifier or Computed Input access.

Input Amplifier… opens the Input Amplifier dialog box, which lets you 
change input settings, apply signal filtering, and so on, and see the 
effects before recording.

Computed Input… opens the Computed Input dialog box, which lets 
you process signals as they are recorded, converting the sampled raw 
data from any input into computed data. The menu command is ticked 
if the channel has computed input applied.

Units Conversion… opens the Units Conversion dialog box, which lets 
you scale or convert the standard voltage reading for a channel into 
useful units, such as mmHg, kPa, and so on, and lets you use waveform 
measurement to calibrate the channel.

No Calculation is ticked if it is chosen, and means the displayed data in 
the channel is the recorded data (either raw data or computed data) 
with no extra calculation (such as Smoothing, Arithmetic, Cycle 
Variables, Differential or Integral) applied. It is the default setting.

Smoothing… opens the Smoothing dialog box, which lets you apply a 
calculation to smooth the recorded waveform in a channel.

Arithmetic… opens the Arithmetic dialog box, which allows you to 
arithmetically combine data in different channels.
Chart Software

Cycle Variables… opens the Cycle Variables dialog box, which allows 
you to analyze periodic waveforms.

Differential… opens the Differential dialog box, which allows you to 
calculate the first time derivative of data in a channel.

Integral… opens the Integral dialog box, which allows you to calculate 
time integrals with various resetting methods.
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Chart extensions can add further channel calculations to the lower half 
of the Channel Function pop-up menu. In all cases, the menu command 
for the calculation that applies will be ticked. 

The Channel Status Indicator

The Channel Status indicator is a diamond at the right of the channel 
control area for each channel. It is solid if the channel is on, open if the 
channel is off, and contains an = sign if a channel calculation is 
applied. Clicking the indicator pops up a list showing the sampling 
rate, range, what is to be recorded (raw data or a computed function, 
and from which input), Input Amplifier settings, such as eDAQ Amp or 
Pod settings, filter settings, and any active units conversion or channel 
calculation. This will apply to newly recorded data. 

The Input Amplifier
The Input Amplifier dialog box allows software control of the input 
amplifiers and filters in the e-corder itself. Each input is set up 
independently. The signal present at an input is displayed so that you 
can see the effects of changes straight away. The Pod Scan button only 
appears if the e-corder has pod connections. The Input Amplifier dialog 
box appears when you choose Channel Function pop-up > Input 
Amplifier… (or click the Input Settings column in the Channel Settings 
dialog box). By default, Chart channels record data from the 
corresponding e-corder inputs. To set up the inputs quickly, click the 
arrows at the top left, or click the right or left arrow keys on the 
keyboard, to move to the dialog boxes for adjacent channels. This skips 
channels that are turned off. 
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Signal Display

The input signal is displayed so you can see the effect of changing the 
settings — no data are in fact recorded when setting up the input 
amplifier. To avoid aliasing, the input signal is sampled at 10 kHz. 
Each pixel width in the display thus represents a number of samples, 
and so is drawn as a vertical line from the minimum to maximum 
recorded values. Slowly changing waveforms are shown reasonably 
accurately, but quickly changing signals display as a solid area 
showing only the envelope (overall shape) of the signal. The average 
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Figure 3–5  
The Input Amplifier 
dialog box.

▼ Refer
The Amplitude Axis,  
p. 73
signal amplitude is indicated by a horizontal dotted line, and its 
numeric value is shown above the display area. 

You can stop the signal scrolling by clicking the Pause button at the top 
right of the data display area (it looks like the pause button on a tape 
or CD player). It then changes to the Scroll button (like the play button 
on a tape or CD player): click it to start scrolling again. 

Pause/Scroll button

Range 
pop-up 

Filtering 
options

Signal 
range

Signal Amplitude

Signal 
input 
controls

Amplitude axis
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You can shift and stretch the vertical Amplitude axis to make the best 
use of the available display area. It is much the same as the Amplitude 
axis in the main window, and the controls, such as the Scale pop-up 
menu, function identically. There are also scaling buttons (up and down 
arrows) which double or halve the scale respectively. When the 
Amplitude axis is set to a scale that differs from the range, the signal 
shifts, expands or compresses (depending on how the amplitude axis is 
scaled) as it moves from right to left across the signal display area. This 
is to indicate the difference between scale and range. Changes made 
to the Amplitude axis here are reflected in the Chart window.
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You can change the horizontal compression of the displayed signal by 
using the View buttons, which are similar to those in the Chart window. 
Click the left (far mountains) button to see more data in the display at 
once, and click the right (near mountains) button to see less.

Filtering

The AC Coupled checkbox provides each input with a high-pass 
filtering option. Low-pass signal filtering options are provided by a Filter 
pop-up menu. There is also a mains filter option available. (Your 
e-corder Manual gives technical details on filters.)

AC Coupled. Unless the AC Coupled checkbox is selected, the input 
amplifier will be DC coupled, and pass both DC and AC signals. 
When AC coupling is used, a high-pass filter before the first 
amplification stage removes any DC and low-frequency components 
from the input. The cut-off frequency is 0.1–0.5 Hz, depending on the 
e-corder. The AC coupled option is useful to remove a slowly changing 
signal component (when recording a fast signal superimposed on a 
slowly drifting baseline, for instance). 

Low-Pass Filtering. The Low Pass pop-up menu gives a choice of low-
pass filters from 2 kHz down to 1 Hz to remove high-frequency 
components from an input signal. These filters are commonly used to rid 
a signal of excessive noise. To turn the filters off, and use the maximum 
bandwidth of your e-corder (approximately 20 kHz), select Off from the 
pop-up menu.

These filters are implemented as digital filters within the e-corder and 
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use some of its processor power. If you are using the digital filters on 
several channels along with computed functions, you may not be able 
to use the fastest sampling rates, or you might have to turn off one or 
more channels in order to sample.

Mains Filter. By selecting the Mains Filter checkbox, you can filter out 
mains hum (typically seen as noise, with a frequency of 50 or 60 Hz, 
superimposed on your signal). Note the mains filter uses some of the 
e-corder’s processing power and therefore reduces the maximum rate at 
which you can sample. If your signal is noise-free, leave the mains filter 
off, and if your signal is affected by mains noise, try removing possible 
sources before resorting to using the filter.
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▼ Refer
Channel Controls,  p. 38

Note
The term ‘differential’ 
here should not be 
confused with the 
computed input 
differential, which is the 
time derivative, not a 
difference.
Signal Input Controls

The Range pop-up menu lets you select the input range or sensitivity of 
the input. Changing the range in the Input Amplifier dialog box is 
equivalent to changing it in the Chart window. 

The Positive and Negative checkboxes control the signal input on an 
e-corder with positive and negative (that is, differential) inputs. These 
checkboxes do not appear where the input is only single-sided: in this 
case, the input functions as if the Positive box were checked 
permanently. The two checkboxes allow you to set up three possible 
input modes. 

Positive. When only the Positive checkbox is checked, only the positive 
inputs on the front of the e-corder are used, and a positive signal fed 
into one will be shown as a positive signal on the display (non-
inverting). 

Negative. When only the Negative checkbox is checked, only the 
negative inputs on the front of the e-corder are used, and a positive 
signal fed into one will be shown as a negative signal on the display 
(inverting). 

Differential. When both the Positive and Negative checkboxes are 
checked, both positive and negative inputs are used, and the signal 
shown in the channel display is the difference between the signals at 
the corresponding positive and negative inputs. If both input signals 
were the same, they would cancel each other out. 
Chart Software

The Invert checkbox lets you invert the signal on the screen. It provides 
a simple way to change the polarity of the recorded signal without 
having to rewire a circuit or reconnect to the signal source. For 
example, you might be recording from a force transducer where an 
increase in force downwards gives a negative signal, but you want to 
have a downwards force shown as a positive signal on the screen. 
Selecting the Invert checkbox would change the display to do this. 

Other Features

Display Offset. Clicking the Display Offset… button causes the Voltage 
at Input dialog box to appear. In the dialog box, a voltmeter displays 



Chapter 3 — Setting Up Ch

Figure 3–6  
The Voltage at Input 
dialog box.

▼ Refer
Units Conversion,  p. 46
the signal currently being measured at an e-corder input (the input is 
indicated at the top of the dialog box). If a transducer or some other 
external equipment has offset adjustment capabilities, you can use this 
to help see when the device is zeroed. 

This dialog box is not a control, simply an indicator that acts like a 
voltmeter. It is unavailable when the AC Coupled checkbox is selected, 
since AC coupling removes all DC current, and there would be no offset 
to measure. 

Units. Clicking the Units… button opens the Units Conversion dialog 
box, letting you specify the units for a channel, and, using waveform 
measurements, calibrate the channel. The waveform currently in the 
data display area of the dialog box is transferred to the data display 
area of the Units Conversion dialog box. (Use the Pause button to 
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capture any specific signal that you want to use.) Units conversion will 
only apply to subsequently recorded signals. This is the usual way to set 
up sampling parameters.

Pod Scan. Clicking the Pod Scan button updates the dialog box if it has 
been left open and a pod (a type of signal conditioner) has been 
connected or disconnected. 

Zeroing Inputs

eDAQ Amps and pods (signal conditioners) connected to e-corder 
inputs may replace the Input Amplifier dialog box with a dialog box 
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Value 
button

Difference 
button

Channel title

Units 
(before 
conversion 
is applied)

Calibration Type 
pop-up menu

Click to apply the conversion

Figure 3–7  
The Units Conversion 
dialog box.
specific to the device, with controls for extra filtering, offsetting, and so 
on (but most functions will be similar). Some eDAQ Bridge Amps and 
GP Amps, have automatic zeroing to remove transducer offsets — see 
their manuals for details. Choose Setup > Zero All Inputs to have each 
eDAQ Amp automatically zeroed in turn. 
Units Conversion
Units conversion lets you convert the standard voltage reading for a 
Chart Software

channel into suitable units for display. You can calibrate the channel 
using waveform measurements or known relationships. The conversion 
can be applied before recording, so that all subsequent recordings are 
scaled to the required units, or after recording, either to the entire 
channel (and all subsequent recordings) or to particular blocks of data. 
Each channel is set up independently. 

To open the Units Conversion dialog box (Figure 3–7) directly, choose 
Channel Function pop-up > Units Conversion… for a channel. You can 

Units pop-up 
menu

Voltage 
values

Units decimal 
place control

New units 
values

Amplitude axis Maximum, mean and minimum values in selection

What is 
converted
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▼ Refer
Signal Display,  p. 41

Figure 3–8  
A signal transferred from 
the Input Amplifier dialog 
box to the units 
conversion data display 
area.
also click the Units… button in the Input Amplifier dialog box or click 
the Units column in the Channel Settings dialog box. 

After you choose the Units Conversion… menu command directly, the 
selection in the Chart window is shown in the data display area of the 
dialog box. That area appears blank, or may contain a message, if 
there is no selection or a discontinuous one (over two or more blocks). If 
there is a selection point or area, you can choose to convert the units of 
the selected block or blocks of data; else the Selected Blocks radio 
button is dimmed and can’t be chosen. If the dialog box is opened from 
the Input Amplifier or Channel Settings dialog boxes, you can convert 
only the units of subsequently recorded signals: you can’t convert blocks 
of data or the whole channel, and the dialog box appears with no 
radio buttons. 

Using the Units… button in the Input Amplifier dialog box transfers the 
data shown there to the units conversion data display area (Figure 
3–8). This has a slightly different aspect ratio to the original display 
area, but the signal is also drawn differently. Lines are drawn 
connecting the minimum values and connecting the maximum values, 
and the area between them is shaded. This gives a truer representation 
of the signal envelope than is possible in the Input Amplifier dialog box. 
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Converting Quantities
The dialog box has four text entry boxes: actual voltages go in the left 
boxes, and what those readings are equivalent to goes in the right 
boxes. Each box requires an entry, so that there are two sets of values 
to calculate the scaling between volts and the new unit. (It must be a 
linear relationship to work. Note that if the slope is negative, the 
Amplitude axis will be inverted.) You can type in some or all values in 
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Difference 
button

Value 
button
the boxes directly, or use some readings from the data display area in 
the left boxes and type in known conversion values in the right boxes. 
Click the Apply button to see what the converted data look like. Click 
the OK button to convert the data into the chosen units, or Cancel to 
close the dialog box without making changes.

Entering Values

If you know the relationship between what is measured and the 
displayed voltage, then you can directly type in values in the four boxes 
(you can press Tab to move between the fields, left to right, top to 
bottom). If you are using a temperature transducer and calibration 
shows that a temperature of 10 °C gives a reading of 1 volt, and 30 
°C gives 3 V, say, then you can key in the values (left to right, top to 
bottom: 1 V, 10; 3 V, 30), and choose °C from the Units pop-up menu. 

You can set up units conversion using values from data points, 
averages, and changes in the waveform shown in the data display 
area. The Data Use pop-up menu changes which buttons are available 
for data transfer: either Point 1 and Point 2 or Point 1 and Difference. 
This in turn fixes how displayed data are used: you can either use two 
data points (or averages) or a point and a difference to fix the scaling 
for the conversion. (At least one base value must be absolute.) 

You can shift and stretch the vertical Amplitude axis to make the best 
use of the data display area. It is the same as the Amplitude axis in the 
main window, and the controls function identically. If you click in the 
data display area, a vertical line indicates the active point, and an 
indicator arrow at the right of the data display shows the point of 
intersection with the waveform (Figure 3–9, ➊). If you make a selection 
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in the data display area, the indicator arrow at the right of the data 
display shows the average amplitude of the waveform, and two 
markers above and below it indicate the maximum and minimum data 
points in the selection (Figure 3–9, ➍). 

If there is an active point or a selection in the data display area, then 
clicking the Value button enters the voltage value (at the active point, or 
the average of the selected data) in the left box in its row. Clicking the 
Difference button enters the difference between the maximum and 
minimum of the selection in the left box in its row. Differences are 
indicated by a delta prefix (∆). In each case, the right box of the row is 
selected so that you can type in the known value in the new units. As a 
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Figure 3–9  
Selections in the data 
display area of the Units 
Conversion dialog box.
shortcut, you can double-click in the data display area to transfer the 
data at a point in one step (doing this a second time enters data in the 
unused row). 

To calibrate a force transducer in a channel, say, start recording and 
apply two known forces to the transducer, to get two voltages. Stop 
recording, select the area with the two readings, and choose Channel 
Function pop-up > Units Conversion… for the channel. Choose Data 
Use pop-up > 2 Point Calibration in the dialog box. Select a point or 
area in the waveform corresponding to one force (Figure 3–9, ➋), click 
a Value button to enter its value in a left box, and type the known force 
in the right box beside it. Repeat the process for the other force (Figure 
3–9, ➌), entering data in the unused row.

➌

➍

➊

➋
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If you know the relationship between what is measured and the 
displayed voltage, but don’t have two sets of values, you might use the 
Point and Difference option. For example, some temperature 
transducers produce a certain change in voltage for a given change in 
temperature (such as ∆20 mV giving ∆4 °C). Use an absolute reading 
in the top row (a calibration value, perhaps). Select an area in the data 
display where a known change in temperature has been recorded 
(Figure 3–9, ➍). Use the Difference button to enter the difference in 
values in the selected data in the left box of the bottom row, and type 
the known change in the right box.
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Figure 3–10  
Dialog boxes for defining 
and deleting units.
Choosing Unit Names

The Unit pop-up menu lets you choose, define, or delete units. Units are 
just names, and the conversions are set independently, so you could 
have °C in two channels, say, with different conversions. Unit names 
are stored in the e-corder Settings file in the Preferences folder of the 
System folder, in common with those created in Scope, and are 
available to all Chart and Scope files once created (or unavailable 
once deleted). Some frequently used ones are provided. 

Choose Unit pop-up > Define Unit… to define new units. The Define 
Unit Name dialog box appears, letting you type in up to nine 
characters for a unit, and add a prefix (there is a pop-up menu of 
standard prefixes in the dialog box; the default is none). Superscripts 
and subscripts can be used, as with channel titles. Choose Unit pop-up 
> Delete Unit… to delete units: the Delete Unit Name dialog box 
appears. Select the unit to be deleted from the scrolling field (Shift-click 
or Command-click to select several) and click OK to close the dialog 
box: the unit is then deleted. If you accidentally delete a unit, you must 
redefine it. Double-click a unit to delete it and close the dialog box in 
one step. 

You can set the number of decimal places of the new units (from 0 to a 
maximum of 6), by clicking the arrows at the top right of the Units 
Conversion dialog box. You can turn units conversion off or on without 
losing the values you have entered by clicking the Off or On buttons by 
the title of the dialog box. Clicking the Apply button to see how the 
units conversion will look, or the OK button to convert units and return 
to the Chart window, will turn units conversion on.  
▼ Refer
Superscripts and 
Subscripts,  p. 82
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Select a prefix 
from this pop-up 
menu

Type the unit name in here — 
superscripts and subscripts are 
possible
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Figure 3–11  
The Channel Settings 
dialog box.
Channel Settings
The Channel Settings dialog box lets you set up multiple channels 
conveniently: you can both see and specify recording and display 
settings for each channel in the one place. To open the dialog box, 
choose Setup > Channel Settings… or type Command-Y. Note that 
when there is no e-corder connected, a smaller version with only 
display settings visible will appear. 
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The functions of the dialog box and the dialog boxes it gives access to 
are described briefly below, and more fully elsewhere. (Most of the 
recording settings are discussed in detail in this chapter, and the 
display settings in the next.) Click the OK button to apply the changes 
and return to the Chart window. 

Title

You can enter a title for each channel in its text entry box, replacing the 
default titles such as ‘Channel 1’.
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On

The checkbox lets you turn a channel off (unchecked) or on (checked). It 
is equivalent to selecting the ‘Turn Channel Off’ or ‘Turn Channel On’ 
menu commands from the Channel Function pop-up menu for a 
channel. There is a shortcut for dealing with multiple channels: hold 
down the Command key while clicking the checkbox for a particular 
channel to turn that channel and all those below it off or on. If a 
channel is off, its recording settings are blank and unusable.

Sampling

Sampling rates can be set using the pop-up menus in the Sampling 
column. They let you choose any of the continuous sampling rates 
available directly from the Rate pop-up menu. By default, the rate is the 
same for all channels, and the Same Sampling Rate radio button at the 
bottom of the dialog box is turned on. Changing the rate in any pop-up 
menu in the column changes it for all channels.

If the Different Sampling Rates radio button is turned on, then rates can 
be set independently for each channel. You might want to do this when 
some channels require high time-resolution (say, a vibration signal), but 
others being recorded concurrently do not (say, temperature). Chart 
samples on all channels at the maximum rate chosen for any of the 
channels, but interpolates rather than records some data points in 
channels with lower rates, enabling better data compression. Reducing 
the sampling rate for some channels therefore will not solve problems 
with the rate being too fast (you need to turn channels off for this); it just 
creates smaller data files. 
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When some channels have different sampling rates, the Rate/Time 
display in the Chart window shows the maximum rate. Clicking the Rate 
button will not open the Rate pop-up menu in this case: rather, the 
button highlights, and when the mouse is released, the Channel Settings 
dialog box appears. Clicking the Same Sampling Rate radio button will 
set all channels to the maximum rate. 

The pop-up menus in the Sampling column do not include the Slow 
Sampling submenu from the Rate pop-up menu. If a slower or faster 
sampling rate is set from the Chart window using these submenus, then 
the radio buttons at the bottom of the dialog box will be dimmed and 
unusable, and the pop-up menus in the Sampling column will be blank 
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and also unusable: slow sampling rates must be the same for all 
channels. 

Range

The pop-up menus in the Range column let you select the input range or 
sensitivity of each input. Changing the range is equivalent to changing 
it in the Chart window. For those channels with computed inputs, the 
ranges will be the computed input ranges. 

Input Settings

Click the Input Settings column to open the Input Amplifier dialog box 
for an input, letting you change input settings, apply signal filtering, 
and so on, and see the effects without recording. This is the same as 
choosing the Input Amplifier… command from a Channel Function pop-
up menu. By default, Chart channels record data from the 
corresponding e-corder inputs. The channel entry will change to show if 
an eDAQ Amp such as the pH/mV Amp is connected; so this column is 
useful to check to see if multiple eDAQ Amps are connected properly to 
the e-corder and are on. 

Computed Input

Click the Computed Input column to open the Computed Input dialog 
box. This is the same as choosing the Computed Input… command from 
a Channel Function pop-up menu. The dialog box lets you choose to 
process signals as they are recorded, converting the raw data from any 
input into computed data. Raw Data means the sampled data with no 
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computed function applied, and is the default setting. The channel entry 
displays the computed function being applied, if any, and the input 
from which the raw data came. The column is a useful way to check 
what is going on in each channel. 

Units

Click the Units column to open the Units Conversion dialog box for a 
channel, letting you change the standard voltage reading for a channel 
into useful units, such as °C, µA, kPa, and so on. This is similar to 
choosing units conversion through the Input Amplifier dialog box, and 
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applies only to subsequent recording. If units conversion has not been 
applied, the default units are shown in the column in italics.

Color

The pop-up dialog boxes in the Color column let you choose the color 
of the data trace in a channel, and whether the data points are 
displayed joined by lines or as unjoined dots. You can also set here the 
thickness of the data trace that appears in the Zoom window (data 
traces are always drawn one pixel thick in the Chart window).

Calculation

The pop-up menus in the Calculation column let you apply calculations 
to channels of recorded data. The options are the same as those in the 
lower half of a Channel Function pop-up menu. No Calculation is the 
default setting, and means the displayed data in the channel are 
recorded data (either raw data or computed data) with no extra 
calculation applied. Chart has the Smoothing, Arithmetic, Cycle 
Variables, Differential and Integral calculations available, and Chart 
extensions such as Spirometry can add others. The calculations do not 
replace the recorded data in a channel, and can be used in channels 
that are turned off. They may be online (you see the results as you 
sample) or offline (you see the results of the calculation only after 
sampling finishes). 

Separator

The checkbox lets you turn a channel separator off (unchecked) or on 
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(checked). Turning off the channel separator between two channels 
overlays them in the Chart window, allowing you to compare their 
waveforms directly: the line between channels in this dialog box also 
disappears so that the setting is easy to see at a glance. 

Number of Channels

This control, at the bottom of the dialog box, lets you choose the 
number of channels displayed in the Chart window. It both turns them 
off, so that no data are recorded, and hides them, so that the data 
display area is not cluttered with channel separators. Click the up or 
down arrows to increment or decrement the number, or type a value in 
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Figure 3–12  
The Trigger window.
the text box directly. The lower channels are turned off and hidden first: 
their rows are blank and borders grayed out, so that they can be 
distinguished from channels that are off. 

Triggering
Triggering determines the way Chart starts and stops recording. A 
trigger is an event such as clicking the Start button or a voltage above 
some preset threshold in an incoming waveform. To set up triggering, 
choose Setup > Trigger: the Trigger window appears. You can use the 
controls to set up the type of trigger event you want, the delay until 
recording, the duration of recording, and so on. 

The Trigger window is a normal window, and can be moved around 
the screen or left in the background while the Chart window is active. 
By default, the Source and Stop pop-up menus are set to User, and the 
other controls are dimmed. In this case there are no special trigger 
conditions, and recording starts or stops when the Start or Stop button 
in the Chart window is clicked. 

Choose the trigger state change 
here: up for +ve, down for –ve

Set the starting 
condition here

Use the 
slider bar 
or text 
entry box 
to set 
triggering 
voltage

Choose 
how 
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Set the 
stopping 
condition 
here

Use the 
arrow 
buttons or 
text entry 
boxes to 
set times

Use this pop-up menu to mark the event in 
a channel 

Enter the number of blocks after which to stop 
recording here (for multiply triggered events)

Chart 
reacts to 
the trigger 
event here
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Setting the Controls

Source

You can choose the event that triggers recording from the Source pop-
up menu, which gives you the choice of User, Ext Trigger, Internal 
Timer, or one of the Chart channels. If you select User or Internal Timer, 
Chart starts recording when you click the Start button. 

If you choose one of the other options, clicking the Start button gets 
Chart ready to record: the Recording Status indicator shows the 
message ‘Waiting for trigger’, and the Record/Monitor button will be 
dimmed. The chosen trigger event then starts Chart recording.

If you select Ext Trigger, the event comes from an external source 
connected via the Trigger connector on the front of the e-corder. When 
External Trigger is selected in the Trigger dialog box, an Options... 
button appears. Clicking this button allows you to choose between TTL 
Voltage Level (a voltage pulse), and Contact Closure mode (when a 
contact is made between the two terminals of the input cable). An 
external voltage pulse must be over about 3 V for 5 µs or longer to 
register (see your e-corder Manual for details. Many instruments 
provide either TTL or contact closure trigger signals and these settings 
can be used to synchronize the Chart recording with such devices. 
Note that the external trigger does not function at a sampling rate of 
200 000 samples per second.

If you choose a channel, a voltage above some threshold in the signal 
of that channel starts Chart recording. The channel must be turned on 
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for its signal to be chosen as a triggering event. 

The Source time controls are only active when Internal Timer is selected 
in the Source pop-up menu, and are used to set the intervals at which 
recording starts. Click the up or down arrows to increment or 
decrement the numbers, or type values in the text boxes directly. The 
internal timer requires fixed-duration sampling. Chart records a block of 
the set duration, then counts down until the time set with the Source time 
controls has passed. After recording, the Recording Status indicator 
shows the message ‘Int. Timer’ and the time remaining. Chart then 
records another block, and so on until the number of blocks set in the 
Stop Cycling control is reached or the Stop button is clicked, at which 
stage recording stops. 
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The internal timer is not intended for uses requiring very high accuracy. 
It should be accurate to a quarter second, as a rule, but since it is 
controlled from the computer, its accuracy depends on how fast the 
computer is, and how busy. Holding down a menu may delay the 
internal timer until the menu is released, for instance. 

Slope and Level

When Ext Trigger or a channel is selected in the Source pop-up menu, 
the slope of the triggering voltage can be set. The trigger level is an 
absolute voltage: the slope determines whether triggering occurs when 
the voltage goes up (positive) or down (negative) through the trigger 
level. The active Slope button is highlighted: click the inactive button to 
change the slope. 

The Level controls are used to set the trigger level voltage for a channel 
when one is selected in the Source pop-up menu (else it is dimmed). The 
range of voltages available depends on the range set for the trigger 
channel. You can either use the slider bar, enter a value directly in the 
text box or use the arrows beside it to change the trigger level. 

Start

When Ext Trigger or a channel is selected in the Source pop-up menu, 
the Start pop-up menu becomes active. It offers the choice of At Event, 
Post-Trigger, or Pre-Trigger, to determine how Chart reacts to the trigger 
event, that is, whether there is a period of time between the triggering 
event and the start of recording. 
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When At Event is selected, sampling starts as soon as the trigger event 
occurs, and no Start time controls appear. When Post-Trigger is 
selected, sampling starts at the time set with the Start time controls after 
the trigger event occurs. This is useful in cases of delayed response, if 
the signals you want to record will occur some time after the trigger 
event. When Pre-Trigger is selected, sampling starts before the trigger 
event occurs. Anticipation is limited to 16 000 samples (at present), 
since it relies on data buffered in memory, so the available time range 
for Pre-Trigger recording depends on the sampling rate. Pre-triggering is 
useful to record the onset of an event before the trigger level voltage is 
reached. It may result in negative values in the Time axis for the time 
preceding the trigger event (which takes place at zero time in some 
time modes). Pre-triggering ignores trigger events that occur before the 
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pre-trigger time is up, rather than starting if a trigger event occurs within 
that time. If you set the pre-trigger time to 5 seconds, say, Chart will 
sample for 5 seconds before even looking for a trigger. 

The Start time controls are used to set the time before or after the trigger 
event when recording starts, and are only visible when either Post-
Trigger or Pre-Trigger is selected in the Start pop-up menu. Click the up 
or down arrows to increment or decrement the numbers, or type values 
in the text boxes directly. If the time set exceeds the limit for pre-
triggering, then when sampling starts it will be reduced to a shorter time 
(and Chart will alert you to the fact).

Stop

You can determine how Chart stops recording using the Stop pop-up 
menu: User, Fixed Duration, or End of Trigger. When User is chosen, 
recording continues until you click the Stop button (or memory runs out), 
and the Stop time controls are unavailable. When Fixed Duration is set, 
recording continues for a set period after the trigger event occurs. 
When Internal Timer is set in the Source pop-up menu, the Fixed 
Duration option is set automatically: if you change the option, you get 
an alert when you try to sample. When End of Trigger is selected, 
recording starts at the trigger event, and continues for a set period after 
the end of the trigger event (when the voltage passes through the 
trigger level again). If multiple trigger events occur during recording, 
recording continues until the set period after the end of the last one. 
You might use this to record while a nerve was firing, for example, and 
for some time afterwards: recording would start when the nerve 
potential starts, and stop a set time after the nerve potential falls below 
a certain value. 
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The Stop time controls are used to set the time for which recording 
continues, and are only visible when either Fixed Duration or End of 
Trigger is selected in the Stop pop-up menu. Click the up or down 
arrows to increment or decrement the numbers, or type a value in the 
text boxes directly. You should check to see if there is enough memory 
to record for the time entered (since Chart does not). The internal timer 
requires the value set in the Stop time controls (the time for which to 
record) to be less than the value in the Source time controls (the time 
between each cycle). If you set the stop time to more than the timer 
cycle, you get an alert when you try to sample. If you set it to zero, 
Chart still records two samples per cycle. 
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Stop Cycling

The Stop Cycling control lets you set up triggering for repeated events. 
The checkbox can be turned on or off when Fixed Duration is set in the 
Stop pop-up menu, and User is not active in the Source pop-up menu. 
Otherwise it is dimmed and unable to be used. 

If the checkbox is off, then Chart just records a new block (of the 
duration fixed with the Stop controls) for each specified trigger event 
until it reaches its recording limits. If used with the internal timer, Chart 
starts recording a new block at each interval set in the Source time 
controls. If the trigger event is the external trigger or a channel voltage, 
then Chart starts recording a new block at each such event (ignoring 
those events that occur while already recording). This is obviously useful 
to record a series of sporadic events, for example.

If the checkbox is on, then you can enter a number in the text entry box 
to specify the number of blocks to record, from 1 to 16 000 (about the 
maximum number of blocks in a Chart file). Chart will record that 
number of blocks before it turns off. 

External Trigger Marker

If you choose a channel from the External Trigger Marker pop-up menu, 
then the point when an external trigger pulse occurs is marked by a 
small data spike (this adds to any data in the channel). If you choose 
Off, no mark is recorded. The external trigger marker does not work at 
fast sampling rates (over 1000 samples per second). 

You do not need to start sampling with the external trigger to use the 
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mark; you could note the beginning of some phase of an experiment, or 
mark a particular event automatically at the instant it occurs by using a 
signal source connected to the external trigger. Unless you needed 
extreme accuracy, though, you would usually use comments or 
automatic comments for this purpose. 

Making Changes in the Chart Window

If you have selected channel event triggering, you can change the 
trigger level voltage and slope, and the event channel, from the Chart 
window. If channel triggering is active, the Trigger Marker (an arrow, a 
T, and a triangle) is shown in the (vertical) Amplitude axis of the event 
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Figure 3–13  
The Trigger Marker.

▼ Refer
The Stimulator Panel,  
p. 65
channel with the triangle pointing at the triggering voltage level. The 
trigger slope is represented by the arrow: up for positive and down for 
negative. 

Double-clicking the Trigger Marker changes the slope. You can drag 
the Trigger Marker up or down to change its settings — a gray box and 
line appear, to indicate where it will go. When the box and line are at 
the desired voltage in the desired event channel, release the mouse 
button to apply the new settings to the trigger. 

The Stimulator
The Stimulator lets you generate a stimulus (pulse or stepped 
waveforms), through the e-corder analog outputs. Select Setup > 
Stimulator: the Stimulator window appears which controls set the 
Chart Software

stimulus type and properties. The stimulus (output waveform) is 
generated via the sockets marked ‘Output’ on the front of the e-corder. 
The stimulator settings are independent of the sampling rate, but 
variable stimuli can only be generated while the e-corder is sampling, 
or while the Computed Input dialog box is open. 

The Stimulator window is a normal window, and can be moved around 
the screen or left in the background while the Chart window is active. 
Parameters can be changed while sampling occurs. By default, the 
stimulator is off: Off is selected in the Mode pop-up menu, and the 
controls are inactive. The active controls in the window change with the 
chosen mode. You can turn stimulation off or on without losing the 
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Figure 3–14  
The Stimulator window.

Figure 3–15  
Types of stimulus 
waveform.
values you enter. Stimulation parameters can also be controlled using 
the Stimulator Panel.

Mode

The Stimulator Mode pop-up menu lets you choose the stimulus type — 
pulse, step, ramp, triangle, or sine, Figure 3–14. Once the stimulus 
type is chosen, you can use the window controls to define its 

Click these radio buttons to 
choose continuous stimulation or 
a fixed number of pulses

Select the stimulus 
type from this 
pop-up menu

Set stimulus amplitude parameters 
with the slider bars or text boxes

Set the 
number of 
pulses with 
the arrows 
or text box

Select to use your 
e-corder’s built-in isolated 
stimulator (if there is one)

Choose 
channel in 
which to 
mark 
stimulus

Click to start 
the stimulus 
(when 
Manually 
start mode is 
chosen)

Set stimulus time parameters with 
the slider bars or text boxes
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characteristics precisely. 

Pulse Step

Ramp SineTriangle

Step
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Pulse. This setting generates a rectangular pulse stimulus that starts at a 
baseline voltage, is raised or lowered to the set amplitude for the pulse 
duration, and then falls or rises to the baseline voltage again. 

Step. This setting generates a stepped stimulus that starts at a baseline 
voltage, is raised or lowered to the set amplitude in a series of steps, 
and then falls or rises to the baseline voltage again. Each step can fall 
or rise to the baseline voltage if required.

Ramp. This setting generates a sloping (ramp-shaped) stimulus that 
starts at the start voltage, is smoothly raised or lowered to the end 
voltage, and then falls or rises to the start voltage again. 

Triangle. This setting generates a triangular wave stimulus that is 
symmetrical about a baseline voltage, and rises and falls for the set 
amplitude from the baseline. 

Sine. This setting generates a sine wave stimulus that is symmetrical 
about a baseline voltage, and rises and falls for the set amplitude from 
the baseline. 

Setting the Controls

The slider bars for various stimulation parameters can be used to set the 
value in the normal way, by dragging the sliding handle. The value is 
displayed in the text entry box beside the slider bar. You can also 
change the value by clicking the up and down arrows at the right of the 
text entry box, or by entering a value directly.
Chart Software

Continuous Waveforms

By default, the stimulator gives a continuous stimulus waveform, and the 
top Output radio button (at the top left of the window) will be on 
(Continuously for Pulse, Triangle, or Sine modes; Repetitive otherwise). 
If you choose Step mode, you can specify how many steps, from 1 to 
2000, you want in your stepped waveform. In Ramp mode, the control 
is disabled.
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Discrete Waveforms

If the lower of the two Output radio buttons (at the top left of the 
window) is selected (Fixed Number of Pulses for Pulse, Once Only for 
Step and Ramp, or Fixed Number of Cycles for Triangle and Sine 
modes), then the stimulator will produce a set number of pulses or 
cycles of a waveform; or for Step and Ramp modes, a single stimulus of 
varying intensity.

If you choose Pulse, Triangle, or Sine from the Mode pop-up menu, you 
can specify the number of pulses or cycles to be produced by the 
stimulator, from 1 to 2000, using the Number of Pulses (or Cycles) 
control at the right of the window. If you choose Step mode, you can 
specify how many steps, from 1 to 2000, you want in your stepped 
waveform (but note that only one stimulus is produced). In Ramp mode, 
the control is disabled.

Marker Channel

If you choose a channel from the Marker Channel pop-up menu, then 
the point when a stimulus starts is marked by a small data spike (this 
adds to any data in the channel). If you choose Off, no mark is added. 
The stimulus marker marks the start of each pulse, step, or ramp, or the 
start of each cycle for triangle or sine modes. It works at any sampling 
rate, up to a stimulus frequency of about 10 Hz.

Start Mode

Click When recording starts to start the stimulator when the Start button 
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is clicked. If the stimulus waveform is continuous, the Stimulator Panel 
controls will then include Off and On buttons to allow you to turn the 
continuous stimulation off and back on again.

Click Manually to start the stimulator either when the Stimulate button is 
clicked, either in the Stimulator window or in the Stimulator Panel. (If 
the waveform is continuous, there will be Off and On buttons in the 
Stimulator Panel.)
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Delay

If you wish the delivery of the stimulus waveform to be delayed after 
you click Start in the Chart View, or Stimulate in the Stimulator window 
or the Stimulator Panel, enter a delay time (from 0 to 1 000 000 
milliseconds) into the text box.

Range, Frequency, and Pulse Duration

For Pulse, Triangle, and Sine modes, the (frequency) Range pop-up 
menu lets you select the range for the Frequency control, from 2 Hz, 
20 Hz, or 200 Hz. You can also choose PPM (pulses per minute), since 
it can sometimes be more convenient to have frequency stated in terms 
of minutes. The Frequency control is used to set the pulse or cycle 
frequency within these ranges, from 0.1 Hz to the maximum in each 
hertz range, and from 2 to 200 pulses (or cycles) per minute in the PPM 
range (about 0.033 Hz to 3.3 Hz).

For Pulse mode, the Pulse Duration control sets the time for which the 
pulse lasts. The time is dependent on the frequency set, since the pulse 
must be less than the period of the stimulus waveform. The smallest 
increment is 0.05 ms. 

Range, Step Width, Ramp Duration, and Pulse Duration

For Step and Ramp modes, the (time) Range pop-up menu lets you 
select the range for the Step Width or Ramp Duration controls, from 20 
ms, 200 ms, 2 s, or 20 s. The Step Width or Ramp Duration controls 
set the exact duration for these parameters within these ranges.
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The Pulse Duration control (for Step mode) sets the time for which the 
pulse lasts within the step width — the pulse cannot exceed the step 
width. If the pulse duration is less than the step width, then the voltage 
step returns to the baseline voltage before increasing (or decreasing) to 
the next step. If the pulse duration is equal to the step width, then the 
voltage steps increase (or decrease), and do not return to the baseline 
voltage until the whole stimulus waveform is finished. 
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▼ Refer
Constant Output Voltage,  
p. 66

Figure 3–16  
The Stimulator Panel 
miniwindow.
Range, Amplitude, and Baseline

For Pulse, Triangle, and Sine modes, the (amplitude) Range pop-up 
menu lets you select the range for the Amplitude and Baseline controls. 
Ranges of 200 mV, to 10 V are available. The Amplitude control sets 
the exact voltage, either positive or negative, within these ranges: a 
negative amplitude starts triangle and sine waveforms at the negative 
parts of their cycle. The Baseline control sets the exact baseline voltage 
within the range: triangle and sine waveforms are symmetrical about 
the baseline, and the pulse waveform just adds the (positive or 
negative) pulse to it. The baseline voltage is the same output as in the 
Stimulator Constant Output dialog box, and changing it in either place 
changes it in both. 

Range, End Level, and Start Level

For Step and Ramp modes, the (amplitude) Range pop-up menu lets you 
select the range for the End Level and Start Level controls. Ranges of 
200 mV, to 10 V are available. The End Level and Start Level controls 
set the exact voltage level, for the starting and ending voltages of the 
step or ramp, within these ranges. The start level voltage is the same 
output as in the Stimulator Constant Output dialog box, and changing it 
in either place changes it in both. 

The Stimulator Panel

Once you have set up stimulation using the Stimulator window, you can 
easily start or stop stimulation or change settings while sampling, by 
using the Stimulator Panel miniwindow (see Figure 3–16). Choose 
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Setup > Stimulator Panel to open it.

This button appears 
for discrete 
stimulation — click to 
stimulate

These buttons appear 
for continuous 
stimulation — click to 
start or stop 
stimulating
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Figure 3–17  
The Stimulator Constant 
Output dialog box.
The Stimulator Panel miniwindow ‘floats’ in front of the active window, 
can be moved around with its title bar, and can only be dismissed by 
clicking its close button. If continuous stimulation was chosen, then the 
Panel will have Off and On buttons, so you can turn stimulation off or 
on at will. If you have chosen discrete stimulation, then the Panel will 
have a Stimulate button: click it to deliver a set number of pulses or 
cycles of a waveform; or for Step and Ramp modes, a single stimulus of 
varying intensity. As a shortcut, you can type Option-space bar to 
activate the panel button or buttons, to start a stimulus or turn one on or 
off. 

Click the up or down arrows to increment or decrement the stimulus 
parameters during sampling — the set value is shown beside the 
control (the controls appearing depend on the stimulus mode). 
Changing parameters here changes them in the Stimulator window, 
and vice versa.

Constant Output Voltage

Stimulation voltages are generated by the e-corder via the outputs on its 
front panel. Choose Setup > Output Voltage… to set up a constant 
output. The Stimulator Constant Output dialog box will appear. You can 
use the controls to set continuous voltages. 

The (amplitude) Range pop-up menu lets you select the range for the 
Amplitude control, from 200 mV to 10 V. The Amplitude control is used 
to set the exact voltage, either positive or negative, within these ranges. 
The slider bars can be used to set the value in the normal way, by 
dragging the sliding handle, or clicking the arrows or the slider bar 
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area. The value is displayed in a text box to the right of the slider bar 
— you can enter a value directly here. The dialog box can be brought 
up during recording, so that the voltage can be adjusted, without 
stopping. 
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Figure 3–18  
A pulse with constant 
output voltage setting on 
the stimulator.
The voltage is generated as soon as a value is set (the e-corder does 
not need to be sampling to produce constant voltages, as opposed to 
variable stimuli). The constant DC output voltage continues until Chart is 
quit or another application, such as Scope, uses the e-corder. (If you 
switch out of Chart to Scope and then switch in to Chart again, Chart 
will restore its set constant output voltage.) 

The Stimulator Output

Output voltage signals are generated by the e-corder via the front panel 
output sockets. The outputs are bipolar, thus a 1 V setting produces 
+1 V at the Output + connector, and –1 V at the Output – connector, 
(Figure 3–18). Thus you could generate up to a 20 V output by 
connecting to both the Output + and Output – sockets and using a a 
10 V setting.

The stimulator and constant output voltage work together: the 
stimulation voltage adds directly to the constant voltage, but the total of 
the two cannot exceed ±10 V. The output from the Stimulator Constant 
Output dialog box is the same as the Baseline voltage for Pulse, 
Triangle, and Sine modes or the Start Level voltage for Step and Ramp 
modes set in the Stimulator, and changing it in either place changes it 
in both.) 
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Output + Output –
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C H A P T E R  F O U R

Data Display

Chart allows you great flexibility in displaying data. You can change 

the lines, patterns, and colors of the data display. You can resize the 

Chart window, expand or reduce the horizontal scaling, split the 

screen, and change the size of each channel’s display, overlay 

adjacent channels, or even hide them. You can look at the overall 

trends in the recording, or look at a small section of data in great 

detail. 

This chapter describes the display options available in Chart, from the 

basic settings through to Amplitude axis manipulation, channel titles, 

the Zoom window and displaying digital read-outs. 
69
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Figure 4–1  
The Time Format dialog 
box.
The Chart Window
As well as the essential controls for recording data, many controls to set 
the display format directly are provided within the Chart window. 

Time Format

Click the Time & Date button, the clock at the top right of the Chart 
window, to open a dialog box letting you set the time scale mode, and 
whether to display the date and time when data were recorded. 

Time Scale

The Time Scale controls let you choose the form and units of the Time 
axis. This applies to the whole axis, and can be changed at will just by 
bringing up the dialog box, since all time information about a 
recording is stored. The time at the pointer position along the Time axis 

Display in Chart window
Chart Software

shown in the Rate/Time display will be in the form chosen here. These 
controls are duplicated in the Display Settings dialog box, and 
changing them in either place changes them in both. 

From Start of Block. Time is measured relative to the start of each new 
block of data (this is the default setting). Time is reset to zero at the start 
of each block of newly recorded data, that is, whenever Start is clicked 
or recording is started by triggering or the internal timer. 

From Start of File. Time is measured relative to the start of the file. This 
is useful if you want to know the amount of time lost between sampling 
being stopped and started again. 
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Note
If you record new data in 
old files, and choose 
‘From Start of File’, you 
might end up with very 
large numbers towards 
the right of the Time axis. 
If you append data from 
different files, you could 
even get negative times. 
Check the Time display 
for the dates and times of 
recordings. 
Time of Day. Time is displayed as the time of day the sample was taken 
— it uses either 12-hour or 24-hour display depending on the settings 
in the system’s Date & Time control panel. This is useful if you want to 
know at what time of day an event occurred.

Always Seconds. When the time gets large enough, it is displayed in 
hours, minutes, and seconds unless the Always Seconds checkbox is 
checked, in which case the time will be shown in decimal seconds (at 
high sampling rates, measurements will be shown in milliseconds). This 
checkbox is dimmed and cannot be chosen when the Time of Day radio 
button is selected.

Cursor Clock

The Cursor Clock checkboxes (see Figure 4–1) control the display of the 
time and date in the Chart window. If neither is selected, only the Time 
& Date button (the clock icon) is shown, with no text display. If one or 
both is selected, the Time & Date button displays beside it the date or 
time or both at which the samples at the Waveform Cursor positions 
were recorded, if the pointer is over the data display or Time axis areas 
(otherwise the text area is left blank). This is handy for checking when 
data were recorded. The formats used are those set in the Mac OS X 
Date & Time System Preferences. 

Split Bar
You can split the data display area of the Chart window vertically, into 
two sections or panes, to compare different sections of recorded data, 
or to compare recorded data with newly sampled data. When 
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recording, the new data are shown in the right section of the window. 
You can perform most normal operations in the left-hand pane of the 
window: make selections, use the Zoom and X–Y windows, add 
comments and exclusions, add data to the Data Pad, copy data to 
other files, change data compression, and so on. 

To split the window, position the pointer on the split bar (anywhere 
along its height), so that it changes into the split pointer. The vertical 
split bar is at the left side of the data display area. Drag the split bar to 
the desired position, so that the two panes of the window are the sizes 
you want them — a gray line appears, to indicate where it will go — 
then release the mouse button. You can do this while recording. You 
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Figure 4–3  
The Color pop-up menu.

Figure 4–2  
Splitting the data display 
area: drag the split bar 
to the desired position 
and release the mouse 
button.
can use the scroll bars of the two panes to scroll through the two views 
of recorded data independently; keyboard scrolling commands control 
the right-hand pane. Double-clicking the split bar or dragging it as far 
left as it will go returns it to the ‘off’ position at the left of the data 
display area, and leaves you with a single pane once more. 

Waveform Color

To set the channel’s data trace color directly from the Chart window, 
click the Color pop-up menu, the colored box beneath the Range pop-
up menu, and choose one of the fifteen display colors. The pop-up 
menu also lets you choose whether the data points are displayed joined 
by lines (the default for Chart) or as unjoined dots. Choose Color pop-
up > Dots to show a dot for each sampled data point in the waveform. 
The menu command then changes to Line: choosing this gives you a 
Chart Software

continuous waveform. 

Click here to choose 
how the waveform 
appears ➠

Lines

Dots
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Figure 4–4  
The Set Scale dialog 
box.

▼ Refer
Color,  p. 82
This Color pop-up menu is a simple version of the one that appears in 
the Color column of the Channel Settings dialog box; changing the 
settings in either place changes them in both. 

The Amplitude Axis

The scale of the (vertical) Amplitude axis of each channel can be 
independently dragged, stretched, or set through a dialog box for 
optimum data display. Scale appearance options can be selected from 
the Scale pop-up menu, the button for which is located at the top left of 
each channel’s Amplitude axis. The Bipolar and Single Sided options 
are disabled if units conversion is applied, or if the channel has no 
data. (The Scale pop-up menu for overlaid channels shows the overlaid 
channels as well, so you can see or set the active one.)

Single Sided. This option can be used to view only positive voltage 
signals. It shifts the vertical axis so that zero volts is located at the 
bottom of the display area. Any readings below zero volts will be off 
the screen (to see them, select the Bipolar option or drag the scale).

Bipolar. This is the default mode for each channel in Chart. It shows 
both positive and negative signals, with zero volts at the center of the 
vertical scale if no shifting or stretching has been applied.

Set Scale. This option allows you to adjust the Amplitude axis directly to 
show the range of values you want. It works whether units conversion is 
on or off. When you choose Set Scale…, the Set Scale dialog box for 
that channel appears, Figure 4–4, allowing you to type in directly the 
upper and lower limits of the scale to be displayed.
73

Auto Scale. This option scales the waveform currently visible in the 
channel to fit it vertically to the display area: the upper limit of the scale 

Units of channel (or 
leftmost visible block)

Channel title



74

Normal pointer

Dragging pointer

Stretching 
pointers

Figure 4–5  
Pointer changes in the 
Amplitude axis.
is set to the value of the highest peak and the lower limit to the value of 
the lowest trough. (This applies even if the signal is very small, such as 
background electrical noise.) 

The Scaling buttons are at the bottom left of each channel’s Amplitude 
axis. Click the up button to enlarge or down button to reduce the 
vertical scale, halving or doubling what is shown each time. 

The scale of the Amplitude axis can be shifted or stretched or both. This 
would allow you to enlarge the signal viewed on the screen, for 
instance, or move it to fit better in the display area. The pointer 
changes, Figure 4–5, as it is moved over the Amplitude axis area. At 
the left of the area, it is a normal, leftward-pointing arrow. To the right 
of the area, though, the pointer points to the right, and a small marker 
appears beside it, indicating its function. Between numbers on the 
scale, a double-headed arrow indicates that dragging will move the 
scale. If the pointer is opposite a number on the scale, two triangles 
point away from the mid-point on the axis, indicating that dragging will 
stretch the scale in the direction they point — and dragging in the 
opposite direction will compress it (when you press the mouse button 
down, the number beside the pointer is outlined by a gray box to 
indicate that it is the dragging point). 

The Amplitude axis can be indefinitely expanded and contracted by 
stretching or compressing the scale, or using the Scaling buttons or the 
Set Scale dialog box. Whenever the scale of a channel is altered, the 
numbers for the scale in the Amplitude axis are changed to suit. 

Double-clicking in the Amplitude axis area returns a shifted or stretched 
scale to its normal, unstretched position, with zero at the mid-point of 
Chart Software

the axis (the Bipolar display). Double-clicking in the Amplitude axis 
area repeatedly cycles an unshifted, unstretched waveform through 
Single Sided display, Bipolar display, and Auto Scale display, in order, 
from its current state.

Auto Scale All Channels

You can auto-scale the Amplitude axis in all channels simultaneously by 
choosing Commands > Auto Scale Data or clicking the Auto Scale 
button in the Tool bar. This scales the data currently visible in each 
channel so that the upper limit of the scale is set to the value of the 
highest peak and the lower limit to the value of the lowest trough. If the 
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Figure 4–6  
Changing a channel’s 
size: drag the channel 
separator until the gray 
line is where you want it 
to be, and release the 
mouse button.
Zoom window is open, the Auto Scale Data command scales the data 
in each channel shown there too.

Changing Channel Size

To change the size of a channel’s display, position the pointer over one 
of the channel separators (anywhere along its length), so that it 
changes into the separator pointer. Drag the channel separator to the 
desired position — a gray line appears, to indicate where it will go — 
then release the mouse button. (See Figure 4–6.) You can do this while 
recording, if you need to change the data display. 

When a channel is thin, the title that appears in the Amplitude axis 
disappears, so that only the data trace color and units are displayed. 
When a channel is very thin (a quarter inch, 5 mm, or less at 72 dpi), 
then there is little point displaying the data, so its data display area 
appears gray (as does a channel that is turned off while recording). 
Turning on or off multiple channels (by holding down the Command key 
and selecting the top command from a Channel Function pop-up menu) 
will turn off channels in this state, but won’t turn them on. 

If you drag a channel separator past others, it will pick them up — for 
instance, if you drag the separator of a channel up, you will drag up all 
those of the channels above it as well (a gray line appears for each 
channel). Double-clicking a channel separator also divides the data 
display area evenly into the number of visible channels. 

Note that the resolution of the recorded data is independent of the 
resolution of the display. Unless a channel is turned off, data will be 
▼ Refer
Number of Channels,  
p. 83
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logged in it at full fidelity during recording, even if the channel 
separators have been adjusted so that the channel is very thin (with a 
gray data display area), or not visible on the screen. 
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Figure 4–7  
Overlaying channels: 
top, separate; bottom, 
overlaid.
Overlaying Channels

You can overlay adjacent channels in the Chart window to compare 
their waveforms directly. From two to all of the channels can be 
overlaid, in one or more sets. For instance, you could overlay Channels 
2 and 3, and Channels 6, 7 and 8, in two separate sets. 

To overlay channels from the Chart window, Option-click the channel 
separators between them. The channel separators vanish, and the once-
separate channels are overlaid. You can also use the Channel Settings 
dialog box, which lets you both turn off channel separators to overlay 
channels, and turn them on to separate the overlaid channels again 
(you can’t separate overlaid channels from the Chart window). 

The area used by the overlay is the sum of the areas used by channels 
individually. Waveforms in the data display area are kept at the same 
ratio of amplitude to full scale as they were individually. The channel 
controls of overlaid channels are fitted into the minimum space at the 
top of the channel control area at the right, and there is only one Scale 
pop-up menu in common in the Amplitude axis at the left. 
▼ Refer
Channel Separation,  
p. 83
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The active channel, by default the top channel in a set, has its title, 
scale, and so on shown in the Amplitude axis. Shifting, stretching, and 
scaling operations affect only the active channel. The colored square 
beside the title, the same color as its data trace, helps to identify it. To 
adjust a waveform’s position and scale, choose its channel from the 
bottom half of the Scale pop-up menu, which lists the titles of the 
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Figure 4–8  
The Display Settings 
dialog box.

▼ Refer
Measuring from the 
Waveform,  p. 130
channels in the overlaid set: the chosen channel becomes the active 
one. The active channel has a tick beside it. 

Waveforms are drawn from the top channel first, so the lowest channel 
in a set will be in front of the rest. Each waveform is tracked by a 
Waveform Cursor when the pointer is over the data display area, and 
the read-out shown in the Range/Amplitude display at the right. 
Overlaying in the Chart and Zoom windows is independent.

Display Settings
The Display Settings dialog box lets you choose the form and units of 
the Time axis, the way that Chart displays data as it records and how 
and whether blocks, comments and exclusions are shown. You can also 
use it to change the color and form of the graticule (the display grid) in 
all windows, and choose the line pattern or color of the X–Y plot. 
Choose Setup > Display Settings… to open the Display Settings dialog 
box.
77
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▼ Refer
Time Format,  p. 70

▼ Refer
Slow and Fast Sampling 
Rates,  p. 37
Time Scale

The Time Scale controls let you choose the form and units of the Time 
axis. This applies to the whole axis, and can be changed at will in the 
dialog box, since all time information about a recording is stored. The 
time at the pointer position along the Time axis shown in the Rate/Time 
display will be in the form chosen here. These controls are duplicated in 
the Time Format dialog box, and changing them in either place 
changes them in both.

Sampling

When the Scroll Right to Left option is chosen (the default), recorded 
data scroll across the data display area from the right of the Chart 
window as if the display area were a roll of paper in a mechanical 
chart recorder. New data are drawn at the right and old data are 
moved towards the left. You don’t have to live with an old chart 
recorder’s way of doing things, though. When the Sweep Mode option 
is selected, data are drawn on the screen from left to right, and when 
the right edge is reached, drawing starts again at the left (a vertical line 
precedes the newly drawn data as they cross the screen). Data are 
easier to view while being recorded if they are not moving quickly at 
the same time. 

At the fastest sampling rates, recorded data is drawn as if in Sweep 
Mode, even if Scroll Right to Left is chosen.

Display
Chart Software

Lines Between Blocks. If this control is on, Chart draws a solid black 
vertical line between user-defined blocks of data to indicate some form 
of discontinuity, such as sampling being stopped and then restarted, a 
channel being turned off, or sampling rate being altered. A new scale 
is drawn in the channel if its range is changed. If you turn off this 
control, no separation line or new scale is shown between blocks. This 
is useful when you are recording for limited durations at very fast 
sampling rates, and so getting very short blocks. 

Show Block Numbers. If this control is on, block numbers are shown at 
the start of blocks as white-on-black tags in the Time axis. They mark 
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Figure 4–11  
The Graticule Color pop-
up menu.

Figure 4–9  
A recording of short 
segments: left, with block 
lines; right, without.

Figure 4–10  
The Color pop-up dialog 
box.
blocks even if lines and scales are not being drawn between blocks. 
Turn off this control to hide them. 

X–Y Plot. The Color pop-up dialog box for the X–Y plot is identical to 
those for the various channels in the Color column of the Channel 
Settings dialog box, but applies only to the plot of data from one 
channel against data from another in the X–Y window. There are fifteen 
colors and three thicknesses; click on colors and thicknesses to select 
them. Select Join Points with Line to show a continuous data trace, or 
select Show Points as Dots to show the waveform with a dot at each 
sampled data point. The waveform on the right of the dialog box gives 
you an idea of how the data will look.
▼ Refer
The X–Y Window,  
p. 145
79

Line Graticule and Dot Graticule. Choose the Line Graticule radio button 
to show a grid of dotted lines, or Dot Graticule to show a dot graticule 
of the chosen color. 

Graticule Color. The graticule (or display grid) chosen from the 
Graticule pop-up menu (see Figure 4–13) affects the Chart, Zoom, and 
X–Y windows. The pop-up menu lets you choose the color of the 
graticule from the fifteen colors available; choosing Off hides the 
graticule. The graticule lines up with the unit divisions in the Time and 
Amplitude axes (divisions in the Time axis are always 20 pixels wide).
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Figure 4–12  
Effect of comment 
checkbox settings.

Figure 4–13  
The Comment and 
Exclusion Shading pop-
up menu.
Comments

The Comments controls cover both normal comments and exclusions, a 
special category of comment. The checkboxes affect both. 

Show. If this control is on, comments are marked in the recording by 
numbered comment boxes. They can be hidden by turning this control 
off (this also inactivates the checkboxes below it). This may be useful for 
printing, if you don’t want data obscured by comment boxes, lines, 
areas, and text. (Comments can be printed independently from the 
Comments & Exclusions window, if you don’t want to see them on the 
Chart data printout.)

Draw Lines & Areas. Comments can be associated with points or areas. 
If this control is on, a dotted vertical line is drawn through the point, or 
a light shading is applied to the area, to make location easier. Turning 
this control off may again be useful for printing, if you don’t want data 
obscured. 

Text Label. If this control is on, as much of the text of a comment as will 
fit is shown vertically beside a comment line, or horizontally across an 

All Comments 
checkboxes on

Text Label off Draw Lines & 
Areas off

All Comments 
checkboxes off
▼ Refer
Printing Comments,  
p. 123
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area to the right of the comment box. The comment text appears in the 
channel of a channel-specific comment, or in the top channel of one 
applying to multiple channels. Vertical text dims the waveform beneath 
it. 

Comment & Exclusion Shading. When an area rather than a point is 
commented or excluded, it is marked by a shaded region. The pop-up 
menus let you choose the color of the region from the fifteen light and 
pastel hues available (see Figure 4–13); obviously different shades 
should be chosen for comments and exclusions. Choosing Off hides the 
color, but leaves areas marked with a dotted line around their 
boundaries (if the Draw Lines & Areas checkbox is on). 
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Figure 4–14  
The Channel Settings 
dialog box.
Channel Settings
The Channel Settings dialog box lets you set up multiple channels 
conveniently: you can both see and specify recording and display 
settings for each channel in the one place. To open the dialog box, 
choose Setup > Channel Settings… or type Command-Y. Note that 
when there is no e-corder connected, a smaller version with only 
display settings visible will appear. The columns in the dialog box are 
summarized in the Chapter 3, and most of the recording settings are 
discussed in detail. Most of the display settings are discussed in detail 
in this chapter. 
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Channel Titles

Normally the titles for each channel displayed at the right of the Chart 
window are ‘Channel 1’, ‘Channel 2’, and so on, down from the top. 
You can change the titles, if you wish, to indicate what you are 
recording. To do this, select the text entry box for a channel in the Title 
column of the Channel Settings dialog box, and type in a new title to 
overwrite the default one. Tab down the column to select each title in 
turn, to change many titles at once. Text in the text entry boxes can be 
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▼ Refer
Waveform Color,  p. 72
edited normally. If entries are left blank, the default titles (‘Channel 1’ 
and so on) will reappear when the dialog box is closed. 

Most of the characters found in the system fonts should be available: 
use Key Caps to remind you how to get unusual characters, such as Ω 
(Option-Z), the degree sign, ° (Option-Shift-8), or ∆ (Option-J). 

Superscripts and Subscripts

Superscripted and subscripted characters, such as those occurring in 
Na+ or C2H5OH, can be used in a channel title (and unit definitions). 

• To superscript a character or characters, type Shift-6 (^), the caret 
character, before it or them. 

• To subscript a character or characters, type Option-6 (§), the 
section character, before it or them. 

• To return to normal characters after superscripting or subscripting, 
type Shift-hyphen (_), the underscore character. 

The caret, section, and underscore characters appear in the text entry 
boxes, but not in the channel title. Ten characters at most, including 
those used to superscript and so on, can be entered for a title. 

Once you have changed the titles of the channels you wish to affect, 
click OK to close the dialog box and apply these (and other) changes 
to the Chart window. If the title is too wide to fit in the title area of the 
Channel Function pop-up menu, it is truncated and an ellipsis (…) 
replaces the extra characters in the display. 

Color
Chart Software

The Color pop-up menus for the channels, in the Color column of the 
Channel Settings dialog box, let you set the color and thickness of the 
data trace in a channel, and whether the data points are displayed 
joined by lines or as unjoined dots. Click the Color buttons to open the 
Color pop-up dialog (see Figure 4–10). There are fifteen colors and 
three thicknesses; click on colors and thicknesses to select them. Select 
Join Points with Line to show a continuous data trace, or select Show 
Points as Dots to show the waveform with a dot at each sampled data 
point. The waveform on the right of the dialog box gives you an idea of 
how the data will look (see also the waveforms in Figure 4–3). 
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Figure 4–15  
The Separator control in 
the Channel Settings 
dialog box.
While the color applies to the waveform anywhere, the thickness 
applies only in the Zoom window, and not in the Chart window (or 
Overview miniwindow for that matter), where waveforms are always 
drawn as one-pixel-thick lines or single-pixel dots. For this reason, the 
Color pop-up menu for a channel in the Chart window is a simple 
version of the one here, and does not affect the thickness of the 
waveform.

Channel Separation

The Separator checkbox lets you turn a channel separator off (when it is 
unchecked) or on (checked). Channels that are not separated are 
overlaid in the Chart window, letting you compare their waveforms 
directly: the line between channels in this dialog box also disappears 
when the channel separator is turned off so that the setting is easy to 
see at a glance. You can overlay adjacent channels from the Chart 
window (by Option-clicking the channel separators), but you can only 
turn overlaying off using these checkboxes. 

Number of Channels

The Number of Channels control, at the bottom of the dialog box, lets 
you choose the number of channels displayed in the Chart window. 
Use the up or down arrows to increment or decrement the number, or 
83

type a value in the text entry box directly. The control’s text entry box is 
highlighted when the dialog box is first opened, so that you can quickly 
change the number of channels used by Chart just by typing a number 
and pressing Return or Enter. 

This control both turns channels off, so that no data are recorded (just 
as the checkbox in the On column does), and hides them, so that the 
data display area is not cluttered with channel separators. The data 
display area in the Chart window is divided evenly into the number of 
channels set. The lower channels are turned off and hidden first: their 
rows in the dialog box are blank and their borders grayed out. This 
feature is very useful: not everyone needs all possible channels all the 
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Figure 4–16  
The Overview 
miniwindow.
time, and it is handy to get them out of the way, and not have bunched-
up channel separators using space in the data display area. 

The Overview Miniwindow 
The Overview miniwindow allows you to see all of a channel’s data at 
once, to make locating particular events easier. It is useful for large 
recordings where you don’t want to keep using the View buttons: you 
can look at the data in the main Chart window at a view of 1:1, while 
still having an overview of a channel to see longer-term trends. To open 
the Overview miniwindow, choose Window > Overview or type 
Command-M. 

The Overview miniwindow ‘floats’ in front of the active window, can be 
moved around with its title bar, and can only be dismissed by clicking 
its close button. It can be resized using the size box at its bottom right 
corner. The displayed channel can be changed by clicking the Channel 
Number buttons at the bottom left of the miniwindow — they 

Displayed channel Channel Number buttons

Area shown in 
Chart window
Chart Software

correspond to the numbers in the default channel titles. The number of 
the displayed channel is highlighted. Buttons for channels containing no 
data are dimmed and unavailable. 

The data currently displayed in the Chart window are highlighted 
(black on white) in the Overview miniwindow. You can scroll the 
contents of the Chart window by dragging this highlighted rectangle. If 
you click outside the highlighted area on a particular segment of the 
recording, the highlighted area is centered where you click, and the 
event is also centered in the Chart window. This enables you to locate 
events of interest quickly in large recordings. You can keep track of 
where you are by shrinking the miniwindow to a small size and leaving 
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▼ Refer
Selecting Data,  p. 98

Figure 4–17  
The Zoom window.
it in an unused area of your screen. If you are using it on a huge file, 
the inverted area may be quite narrow: if so, drag the size box to 
enlarge the miniwindow and the area along with it (or use the View 
buttons to increase the data shown in the Chart window).

If the data display area of the Chart window is split into two panes, the 
highlighted area in the Overview miniwindow only shows the display 
area of the right-hand pane. The Overview miniwindow might initially 
take a long time to draw on large files with many data points (although 
it is optimized for most very large files). To interrupt its drawing, type 
Command-period: if you do this, the miniwindow will appear gray. 
Click a Channel Number button or the display area to make the 
miniwindow draw an overview once more. 

The Zoom Window
In the Zoom window, you can look at a small section of data in great 
detail, either in one channel or in several channels over the same 
period of the recording. To zoom in on a data selection, drag to select 
an area of interest in the Chart window (in the Time axis for multiple 
channels), and choose Window > Zoom Window or click the Zoom 
Window button in the Tool bar: the Zoom window appears. 

Overlay button
Stack button

Time and amplitude readings

Pointer
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Marker Channel Number 
buttons

Waveform 
Cursor

Identification bars/Color pop-
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Selection 
History 
buttons
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Figure 4–18  
The Zoom window with 
the Stack button on — 
this is the same selection 
as shown in Figure 
4–17. 
The Zoom window is a normal window, and can be moved around the 
screen or left in the background while the Chart window is active. It 
can be resized using the size box at its bottom right corner. By default, 
the Overlay button is on, and if multiple channels are selected, their 
waveforms are superimposed. Waveforms are drawn from the top 
channel first, so the lowest channel in a set will be in front of the rest. 
Overlaying or lack of it in the Zoom window is independent of any 
overlaying in the Chart window. The numbers of the Channel Number 
buttons at the bottom left corner of the window correspond to channel 
numbers, and buttons for channels with no selected data in the Chart 
window appear dimmed. 

The Stacked View

If the Stack button is clicked, then the Overlay button is turned off, and 
selected channels are displayed stacked one below the other in much 
the same way that they are displayed in the Chart window. The height 
devoted to each channel is in the same proportion as in the Chart 
window, with channel titles and units shown at the left, or just units if 
the channel is thin. Any overlaying in the Chart window is ignored. 
Clicking the Overlay button turns off the Stack button and superimposes 
channel waveforms again. 

Stack button 
selected
Chart Software
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▼ Refer
Display,  p. 78

▼ Refer
Color,  p. 82

▼ Refer
Using the Marker,  
p. 131

▼ Refer
Measuring from the 
Waveform,  p. 130
Data Display

The highlighted Channel Number button indicates the waveform that 
the Waveform Cursor tracks (the active channel), whether the channels 
are overlaid or stacked. The time (t) and amplitude (Y) readings at the 
tracking point are indicated at the top of the window, in the forms of 
time and units set using display settings and units conversion. The active 
channel can be changed by clicking one of the (undimmed) numbered 
buttons at the bottom left corner of the window, or clicking on a 
different waveform. In either case, the button of the selected channel 
will be highlighted to indicate the channel now tracked. 

The Marker from the Chart window is duplicated in the Zoom window 
— moving it onto a waveform in one will do the same in the other, 
double-clicking it will send it home, and so on. Its behaviour is also 
similar in the Zoom window, although there is a slight difference 
because the Waveform Cursor only tracks the active waveform, if there 
are several. When the Marker rests on the active waveform, relative 
measurements (preceded by ∆) are given in the readings for both time 
and amplitude; when the Marker rests on one of the other waveforms, 
the display is of relative times but absolute values. 

A short bar of the color and thickness chosen for the channel waveform 
is shown above the Channel Number button to aid identification. It also 
doubles as a Color pop-up dialog box to let you choose settings for a 
channel’s data trace. It is the same as the Color pop-up menus in the 
Channel Settings dialog box and for the X–Y plot in the Display Settings 
dialog box (see Figure 4–10). There are fifteen colors and three 
thicknesses; click on colors and thicknesses to select them. Select Join 
Points with Line to show a continuous data trace, or select Show Points 
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as Dots to show the waveform with a dot at each sampled data point. 
The waveform on the right of the dialog box gives you an idea of how 
the data will look. The color applies to the channel waveform 
anywhere; the thickness applies only in the Zoom window. 

If the selection in the Chart window is discontinuous (straddling two or 
more blocks), then the Zoom window displays a thin line to indicate a 
block boundary, and a thicker line to indicate a scale change, unless 
you have chosen to turn off the display of lines between blocks. 
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▼ Refer
The Amplitude Axis,  
p. 73
Changing the Selection

You don’t have to return to the main window to change the selection in 
the Zoom window. Instead you can move, scale, and zoom in on data 
from the Zoom window. All changes made to the selection are reflected 
in the Chart window. 

To zoom in further on data simply drag in the data display area to 
highlight an area of interest (you cannot drag in the Zoom window’s 
Time axis). When you let go the mouse button, the selection expands to 
fill the data display area. If channels are stacked, you can change the 
vertical extent of the selection in the channel in which you drag, but the 
full height of the other channels is always selected. The horizontal 
extent will be the same over all channels. 

The Amplitude axis in the Zoom window is the same as the one in the 
Chart window, and the controls function identically. If the channels are 
overlaid, then shifting, stretching, and scaling operations affect only the 
active channel (except for the Auto Scale Data command, which scales 
all channels), which has its title, scale, data trace color, and so on 
shown in the Amplitude axis. 

You can manually scroll data, as you can in the Chart window, by 
holding down the Option key while the pointer is over the data display 
area: this turns the pointer into a hand that can drag the data back and 
forth or up and down, to move the selection where you want it. (You 
cannot ‘push’ the data in the Zoom window, though.) 

Changes made to selections are noted, and can be recalled by the 
Selection History buttons at the bottom right of the window. The up 
Chart Software

button takes you back through the selection states, and the down button 
takes you forward again. The selection history covers all states since the 
Zoom window was last closed, including selections made in the Chart 
window before the Zoom window was opened again. (It does not keep 
track of whether the selection was overlaid or stacked.)

Miscellaneous

The Zoom window might take a long time if the selection has many 
data points (millions). To interrupt its drawing, type Command- period: 
if you do this, the data display area will appear gray. Click the display 
area to make it draw the selection once more. 
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Figure 4–19  
DVM miniwindows — for 
Rate/Time and Channel 
1.
Double-clicking in the Zoom window adds relevant data at the active 
point to the Data Pad, just as it does in the Chart window: the 
expansion of the waveform in the Zoom window display obviously 
allows greater accuracy in selecting data points. 

If you hold down the Command key when clicking a data point in the 
Zoom window, that data point is located and centered (if possible) in 
the Chart window. This is useful if you have selected a large area in the 
Chart window to zoom in upon, so that the data in the Zoom window 
ends up compressed. If you have zoomed in on a particular segment of 
data, and then scrolled through the Chart window to somewhere else, 
then if the selection has not changed, you can Command-click in the 
Zoom window to return to where you were. 

Copying and Printing the Zoom Window

When the Zoom window is active, then the Print option in the File menu 
changes to Print Zoom…, and if the command is selected, the contents 
of the window are printed with the title ‘Zoom of’ and the file name. 
The Zoom window can also be copied as a picture for pasting into 
other applications, by choosing Copy Zoom… from the Edit menu.

Displaying Digital Read-outs
The DVM submenu of the Window menu provides a digital voltmeter for 
each channel (hence the name), and read-outs of the sampling time, in 
the form of resizable miniwindows. The miniwindows can let you keep 
an eye on recorded values from the other side of the room, for instance. 
To open one, choose a menu command from the DVM submenu, or 
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drag the Range/Amplitude display for a channel, or the Rate/Time 
display, to tear it off.

Settings button



90

Figure 4–20  
Tearing off DVM 
miniwindows.
A DVM miniwindow ‘floats’ in front of the active window, and can be 
moved around by dragging its border. It may be resized using the size 
box at its bottom right corner and can only be dismissed by clicking its 
close button. The title bar displays ‘Time’ or the name of the channel to 
which it applies. You can have one miniwindow for each channel, and 
another for Time.

When sampling, the DVM miniwindow shows the current input value in 
the units used for the channel. If the channel is off, the word ‘Off’ 
appears. When not sampling and with the pointer over the data 
display area (or Time axis), the Waveform Cursor tracks the waveform, 
and the DVM miniwindow displays the sample data or time values at 
the Waveform Cursor position. When the miniwindow is resized, the 
text also changes size for optimum fit. Thus, enlarging the window will 
make the text easier to read. The text color for the Time miniwindow is 
black. For channel data it is the same as the trace in the corresponding 
channel.

DVM Settings

Click and drag here to tear off the 
Time miniwindow

Click and drag here to tear off a 
channel miniwindow
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The DVM Settings dialog box (Figure 4–21) is displayed either by 
clicking the Settings button in a miniwindow, or by selecting Settings… 
from the DVM submenu of the Window menu. The Settings dialog box 
provides a means to enable or disable certain advanced features of 
DVM used during sampling. 

Simple Mode

With Simple selected, DVM updates its display whenever Chart has the 
time to do so. This means that the updates are asynchronous, and 
represent whatever sample value happens to be present at the time 
DVM requests it for display. This mode of operation has the advantage 
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Figure 4–21  
The DVM Settings dialog 
box.
of requiring minimum computational overhead, and thus does not 
interfere with Chart sampling at high speeds.

Regular Updates Mode

With Regular Updates selected, DVM synchronizes itself with the data 
stream and processes every sample. This makes possible simple 
computations, such as data-point averaging, as well as periodic data-
logging. It also adds a significant computational overhead, which may 
interfere with high-speed sampling or other tasks. If this overhead turns 
91

out to be too high, Chart will stop sampling and issue a warning. 

When the Regular Updates mode of operation is chosen, data are 
computed periodically, the interval being the value entered in the 
Update Every text box. If the computer is busy, the updates may appear 
at irregular intervals. If the update rate is higher than the sampling rate 
in a channel, Chart will update at the lower rate. Where different 
channels have different sampling rates, the channel with the highest 
rate will be the one used to determine the update rate.

The horizontal arrows allow paging through the settings panels for Time 
and all available channels. The settings panels are only enabled when 
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the Regular Updates mode is selected. Since they don’t apply, some of 
the settings panel items for Time are always grayed out.

In the Regular Updates mode of operation, new display options also 
become available. In addition to the default display, Digital Only, the 
user may select to display either a Bar Graph or an Arrow Indicator. It 
is also possible to keep a History of recent data points, which is a self-
scaling graph of those points. The number of points displayed in the 
graph depends on the time value entered in the Keep text box.

The values displayed and/or logged may be the Value of the last 
sample in the interval, or the Average, Maximum, or Minimum values 
of all the samples in the last interval.

If the Log to DVM Window check box is selected, the data will be 
logged to the DVM Log window, in the column entered in the text box. 
Upon starting each sampling run, and to aid with the identification of 
the columns, the title ‘Time’ or the name of the corresponding channel 
will also be displayed in the same column. The DVM Log window can 
be displayed by selecting it from the Window menu. 

The data in the window may be copied to the clipboard and pasted 
into other applications, such as word processors and spreadsheets. 
They can also be saved to disk as a text file. If more than one channel 
is set to display in a given column, the numbers from the higher-
numbered channel are displayed.

The DVM Log Window
Chart Software

The DVM Log window can be used for the periodic logging of data, 
which can then be exported to other applications for further processing, 
or saved to disk as a text file. It is opened by selecting DVM Log 
Window from Chart’ s Window menu, and only works when Regular 
Updates mode has been selected in the DVM Settings dialog box.

Logged data are displayed in the window as columns. The appearance 
of these columns is controlled by the DVM Log Window Settings dialog 
box, which is displayed by clicking the Settings… button at the top of 
the DVM Log window. Font types and sizes, as well as the column 
width, can be adjusted by clicking on the Display… button.
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Figure 4–22  
The DVM Log window.
Clicking the Copy button places a copy of the entire content of the 
DVM Log window on the clipboard. Clicking the Clear button 
permanently deletes all logged data.
93
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5

C H A P T E R  F I V E

Working With Files

Chart files can be easily accessed with the Experiments Gallery, and 

can be edited, printed, and saved to disk in various formats. This 

chapter describes these operations, and such features as creating a 

single file summarizing results from many files, and saving settings to 

allow easy repetition of an experiment. Other topics covered include 

the transfer of data to other applications, the use of comments and 

exclusions, and the Notebook, and finding particular Chart files 

quickly. 
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The Experiments Gallery
The Experiments Gallery is a framework that provides easy access to 
Chart data and settings files, as well as any related material such as 
documentation, text files or multimedia files.

It is particularly useful in a teaching environment as it allows teachers to 
organize files for different experiments and make them easily accessible 
to students. If you are a researcher you will also find it useful for 
organizing and getting easy access to your recordings.

Using the Experiments Gallery

Before you can use the Experiments Gallery, it must have been created 
and files or folders must have been added. This may have already been 
done in your version of Chart, but if not, see Managing the Experiments 
Gallery, p. 97.

Once the Experiments Gallery is in place, the Experiments Gallery 
dialog box will be displayed when you choose Experiments Gallery… 
from the File menu. If you select the Show at startup checkbox at the 
bottom of the dialog box, it will also be displayed when:

• You start Chart without a document (for example, when you double-
click the Chart desktop shortcut

• You close the last open Chart document.
Chart Software

The left-hand pane of the dialog box contains a folder hierarchy of the 
Experiments Gallery contents. It is similar to the Macintosh Finder and is 
navigated in the same way, clicking on the disclosure triangles to 
expand branches of the folder structure, for example. In the right-hand 
pane are shown the files in the folder selected in the left-hand pane. 
The selected file is indicated by shading, and can be opened by 
clicking the Open button. Alternatively you can double-click files to 
open them.

Depending on how the Experiments Gallery has been set up, there may 
be an information area above the file list (as shown in Figure 5–1), 
containing comments about the contents of the selected folders. 
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Figure 5–1  
The Experiments Gallery 
dialog box.

Figure 5–2  
Creating the Experiments 
Gallery folder.
Individual files may also have labels describing them, in addition to 
their file name.

Managing the Experiments Gallery

If you are a teacher or a researcher, you will probably want to create 
an Experiments Gallery tailored to your own needs.

First, create a folder called ‘Experiments Gallery’ in the same folder as 
the Chart Application (Figure 5–2). Note that this folder may already 
exist, depending on your version of Chart.
h Files 97
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Figure 5–3  
An active point (top) and 
a selection rectangle in a 
channel of the Chart 
window.
Add folders and files to the Experiments Gallery folder you have 
created (if there are no folders or files in the Experiments Gallery folder, 
the Experiments Gallery dialog box won’t appear in Chart). You can 
organize the folders and files in a manner which suits the structure of 
your experiments. You can add shortcuts as well as files, to give access 
to files stored on a network, for example. Remember that it can be 
useful to add documentation, text files, multimedia files and so on to the 
Gallery. The folders and files will be displayed with the same hierarchy 
in the Experiments Gallery dialog box.

To delete the Experiments Gallery, and stop the dialog box from 
appearing in Chart, either remove all the folders and files from the 
Experiments Gallery folder, or delete the Experiments Gallery folder 
entirely.

You can control the way the files in a folder contained in the 
Experiments Gallery appear by creating a ‘configuration file’ and 
including it in the folder. Details on creating configuration files, with an 
example, can be found in Appendix D.

Selecting Data
If you click in the Time axis, a blinking vertical line indicates the active 
point over all channels; if you click in a channel, the blinking line and 
active point are confined to one channel (Figure 5–3, top). An active 
point is distinct from a selected area, and is used for adding comments, 
transferring information to the Data Pad, and so on. Although you can 
copy a single data point to the Data Pad, you cannot copy it to the 
Clipboard, save it as a file, or zoom in on it. 
▼ Refer
Experiments Gallery 
Configuration Files, 
p. 263
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To select an area of data in one channel, position the pointer and drag 
to highlight a rectangular area (Figure 5–3, bottom). Shift-click to 
extend the selection in the channel. The extent of vertical selection 
affects display in the Zoom and X–Y windows, but will not affect 
transfer of information to the Data Pad, printing the selection, or saving 
the selection as a file: these operations will use the full array of data 
points over the recording period of the selection. Command-drag to 
select the full height of a channel. 

To add channels to a selection, hold down the Shift key and drag in the 
display area of the channels you want: the vertical extent of the 
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Figure 5–4  
Selecting data in multiple 
channels: left, from the 
Time axis; right, Shift-
dragging in the channel 
you want to add.
selected rectangle in other channels can be varied, but the horizontal 
extent will be the same as that in the first selected channel. (The 
recording period over which selections are made in multiple channels 
must always be the same.) Command-Shift-click in the display area of a 
channel you want to add to select its full height. Option-Shift-click to 
select the same relative area of an added channel as in the first 
channel. This area takes into account any stretching or scaling of a 
channel’s Amplitude axis, making direct comparison of waveforms 
overlaid in the Zoom window easy. It only deals with the recorded 
data, though, and ignores any scaling due to units conversion. 

To select an area of data in all channels, position the pointer in the 
Time axis area: the pointer will change to a double-headed arrow. 
Drag in the Time axis area to highlight a rectangular area over all 
channels: Shift-click along the Time axis to extend the selection from the 
point at which you started to drag. Shift-click in the display area of a 
channel to deselect it. Double-clicking in the Time axis selects an entire 
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block of recorded data (the whole file, if it is continuous). 

If two or more channels are overlaid, simply drag to create a common 
selection rectangle over both channels. If you overlay separate channels 
with existing selections in one or more of them, you should reselect the 
area to ensure a common selection rectangle. 

Finally, you can select all data in the Chart window by choosing Select 
All from the Edit menu, or typing Command-A.

When there is a selection in the data display area, some of the menu 
commands available change to reflect this. In the File menu, the basic 
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▼ Refer
Display, p. 78
Print command changes to Print Selection…, and Save Selection… 
becomes undimmed. In the Edit menu, Copy Selection… and Delete 
Selection become active as well.

Deleting Data
There are two sorts of data deletion available when the Chart window 
is active: you can clear a selected area of data for all channels, or you 
can clear all of the data recorded in a particular channel. (You cannot 
just delete an area of data in one channel.) These operations cannot be 
undone, so alert boxes ask you to confirm your decisions. If you do 
accidentally delete vital data, and you have saved the file previously, 
you should immediately close the file without saving the changes — the 
file will revert to the last version saved. You may lose some changes, 
but the data just deleted will be there on reopening the file. (Frequent 
saves and backups are, of course, always good practice.)

To delete an area of data common to all channels, drag along the Time 
axis to select the area corresponding to the period between two points 
on the axis. This would be useful to delete stretches of a recording 
where nothing particularly interesting occurred. Choose Edit > Clear 
Selection, or press the Delete key. In fact, if there is any selection in the 
Chart window in one or more channels, then these actions will clear the 
data block from all channels, subject to confirmation through the alert 
box. Since you create a discontinuity in the record by deleting data 
over a specified period, a new block is defined. It is marked by a solid 
vertical line, unless display settings are otherwise set up. (If there is only 
an active point rather than a selection in the Chart window, then 
pressing the Delete key does nothing and the Clear Selection command 
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is dimmed.) 

To delete all data from a particular channel, make a selection in that 
channel (an active point will do), and choose Edit > Clear Channel… to 
clear all data from a particular channel. An alert box will ask you to 
confirm the deletion.
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Figure 5–5  
The Copy as Picture 
dialog box.

▼ Refer
Saving Options, 
p. 104
Transferring Data
It may be useful at times to transfer data from Chart to other 
applications, such as a spreadsheet or drawing program. A file, a 
selection, or the contents of the Data Pad can be saved as a standard 
text file able to be opened by any application that can import text, such 
as a word processor, spreadsheet, or statistics package. (Choose File > 
Save As… to do this.) 

You can copy selected data from Chart and paste the data directly into 
another application. The Copy command in the Edit menu changes to 
show available options when different windows are active, or under 
different conditions. If the Data Pad is the active window, then you can 
copy all of it, or selected rows, to the Clipboard as text. (The menu 
command will be Copy, Copy All, or Copy Selection, depending on 
what is selected.) If either the Zoom or X–Y window is active, then the 
Copy command changes to Copy Zoom… or Copy X–Y… respectively. 
These two commands copy the contents of the window to the Clipboard 
as a QuickDraw picture. When chosen, the Copy as Picture dialog box 
appears (with the name of the window in its title).
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There are three options for picture resolution when copying a picture: in 
each case, a QuickDraw PICT is created at the specified resolution. 
Screen copies the contents of the window at 72 dots per inch, the 
ostensible screen resolution, so the picture you see on the monitor is 
exactly what is pasted into another program. Expanded copies the 
picture at four times the visible size: when pasted into a program that 
can scale it, it can have an effective resolution of 288 dpi. High creates 
a 300 dpi picture, the same resolution as an older laser printer. 

Click a radio button to choose the option appropriate to the program 
where you intend to paste the picture. A drawing application would 
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Figure 5–6  
The Copy to Clipboard 
dialog box.

▼ Refer
Time Scale, p. 70
handle a high-resolution picture, and you could use the extra features 
available to modify it for a report or for display. Some programs might 
convert PICTs into bitmaps. The Expanded resolution option lets you 
create a picture that if converted to a bitmap and scaled to a quarter of 
its size, prints nearly as well as a high-resolution picture.

Copying a Selection

If the Chart window is active and you select an area of data, choose 
Edit > Copy Selection… to copy the data as text: the Copy to 
Clipboard dialog box appears. 

Channels. The Channel Number buttons let you choose the channels to 
be saved (and correspond to the numbers in the default channel titles). 
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Those buttons whose channels have no data or are not selected will be 
dimmed. Highlighted buttons indicate the channels to be included in the 
text (by default, all selected ones with data). Click the buttons to select 
or deselect channels. Channel data will appear as columns in the text, 
in numerical order, left to right, separated by tabs. 

Time. When the Time checkbox is selected, then the time at which each 
sample was taken is listed in addition to the data points themselves, 
preceding the channel data (as the first column of text). The time format 
can be chosen using the controls at the right of the dialog box. The 
options are the same as those for display settings. 
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▼ Refer
Using Exclusions, p. 123
Comments. When the Comments checkbox is selected, comments at 
any data point are included as the last column in the text. If there are 
no comments in the file or selection, this option will be dimmed. If the 
Comments checkbox is the only thing selected, a numbered list of 
comments is copied. (Exclusion comments are ignored.) 

Settings Info. If the Settings Info checkbox is selected, then sampling 
rates, ranges, units conversion information, and recording dates and 
times are noted as data header lines for every block of data in the text. 
Channel titles are also included, but other Chart display settings are 
ignored. This information allows Chart (using a Chart extension, Read 
Text) to reconstruct a Chart file from a text file, and match the original 
Chart file exactly. It is useful for transferring files between versions of 
Chart, retrieving files archived as text, and so on. 

Reduction. By default, the text includes a data point for every sample in 
the file. You might not want all this detail, say, if you have recorded 
something at a high sampling rate, and there are too many data points 
for your graphing application to cope with. By entering a number other 
than 1 (the default) in the Reduction box, you can use fewer samples. If 
you enter 2, the text would include the data points for every second 
sample, if you enter 3, the text would include those for every third 
sample, and so on. Comments are not lost, even if the particular data 
points they were attached to are not included. 

Exclusions (points or areas marked as excluded from analysis) are 
treated as separate blocks containing no valid data, and are not 
copied to the text. Exclusion comment text is also ignored. 

The Clipboard
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Whenever you cut or copy data from Chart, the information is stored 
on the Clipboard. Choose Edit > Show Clipboard to see what has been 
copied: the Clipboard window appears. It is a normal window and can 
be moved around the screen or left in the background while the Chart 
window is active. The Clipboard window can show a representation of 
a picture (sized to fit the window), or in text format, data from the Chart 
window or Data Pad. 

If a large selection is made, then during copying a progress indicator 
and the percentage of the file currently copied as text are shown in the 
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Figure 5–7  
The Clipboard window 
after copying: left, Chart 
window/Data Pad; right, 
Zoom window.

Figure 5–8  
The Save As dialog box 
(see the Macintosh 
system help for the many 
shortcuts available).
text box of the Tool bar (if it is visible), just as occurs with a file being 
saved as text. To stop the process, type Command-period. 

Saving Options
To save a file of recorded data, choose File > Save, type Command-S, 
or click the Save button in the Tool bar. When this is done, an existing 
file will have any changes made to it saved to disk. The first time that 
you save a file, or whenever you choose File > Save As…, the Save As 
dialog box appears. 

Choose a file type 
here
Chart Software
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The dialog box lets you navigate through the filing system of the 
computer to choose where your file will be saved. Once you choose a 
file format from the Format pop-up menu, and enter a name for the file, 
you can then save the file by clicking the Save button. The main formats 
are data file, settings file, text file and Chart for Windows data file. You 
can also save the contents of the Data Pad, Spectrum window or DVM 
Log window as a text file. Other formats can be added by Chart 
extensions. You can save multiple copies of a file in any format or 
formats, if the copies have different names or are in different places. 

Data File

The data file format, the default, saves both data and settings (including 
macros). The file includes the entire recording, and is the usual way to 
save data. Since Chart lets you have open only one data file at a time, 
opening or creating another means you must close any currently open 
file. If such a file has any unsaved changes, an alert box informs you 
and lets you save or discard them, or cancel.

Settings File

The settings file format does not save any recorded data, but stores the 
current settings. These include those that affect recording, such as the 
sampling rate, channel ranges, triggering, and stimulation settings, and 
those that affect the way the data looks, such as the window size, 
channel areas, display settings, and menus. Macros are also stored as 
settings. Using settings files, you can build up a library of settings for 
many different experiments, to enable quick and easy preparation for 
recording. 
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Opening a settings file, if no Chart file is open, creates a new untitled 
data file with the defined settings. If an existing Chart data file is open, 
then an alert box gives you the choice of creating a new untitled data 
file with those settings, or applying the settings to the current Chart file. 
Applying settings to a file affects the display of existing data and the 
recording settings for subsequent sampling. It does not affect the 
recording settings of, or alter, existing data: sampling rates, ranges, 
applied units, and so on are all left unchanged. 
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Figure 5–9  
The Save As Text File 
dialog box.
Text File

This format saves data as a standard text file able to be opened by any 
application that can import text, such as a spreadsheet, word 
processor, or statistics package. Each sample recorded is stored as a 
row of data readings for each channel, separated by tabs and ending 
in a return character (that is, taking up a single line). If you opt to save 
a Chart file as a text file, the Save As Text File dialog box appears 
when you click Save. It is much the same as the Copy to Clipboard 
dialog box (see Copying a Selection, p. 102, for details). 

The size of a text file is much greater than the size of the Chart data file 
from which it is created. While a file is being saved as text, the text box 
of the Tool bar (if it is visible) shows a progress indicator and the 
percentage of the file currently saved. Type Command-period to stop 
the process: you get a text file with as much data as had been dealt 
with at the time you stop.
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Chart allows you to record files with different sampling rates on 
different channels. If you save such a file as a text file, Chart will 
determine the smallest sampling interval (highest sampling rate) used 
and will include data points separated by that interval for all channels. 
For the channels that have longer sampling intervals, the extra data 
values are generated by linear interpolation. For example, if you had 
recorded on Channel 1 at 1000 /s, on Channel 2 at 200 /s and on 
Channel 3 at 100 /s, the text file would include data values separated 
by 0.001 s, for all three channels. In the case of Channel 2, every fifth 
data value included in the file would be ‘real’, with four interpolated 
‘pseudo’ values in between. With Channel 3, every tenth data value 
would be ‘real’ and there would be nine interpolated values between.
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Figure 5–10  
The Translation Options 
dialog box.
Chart for Windows Data File

This format saves a file as a data file that can be read by Chart v4.2 
for Windows or later. Choose Chart (Win) Data in the Format pop-up 
menu: the ‘.edcht’ suffix will be appended to the name. Windows 
needs this to identify the file type. The data and channel titles are 
exported. The settings for range, computed input, units conversion and 
macros are not exported and need to be redefined if they are required 
for new data. Most display settings, such as data trace colors, channel 
heights, and so on are ignored.

If you save a Chart file containing calculated data, a dialog box 
appears that lets you choose to save the calculated data, or just the 
underlying recorded data. 

Note that the Chart for Windows program reads all the data in an 
exported file as recorded data — only the result of a calculation is 
saved, not the settings that generated the calculated data. For this 
reason, if the calculation can be applied in Chart for Windows, 
exporting the data and then applying the calculation in Chart for 
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Windows is preferable to applying the calculation in Chart for 
Macintosh and then exporting.

Exclusions are treated as normal comments. Excluded data are treated 
as valid, so they are included in the export. Commented and excluded 
areas become commented points in Chart for Windows, positioned at 
the start time of the area. If the extent of an area in a Chart for 
Macintosh data file is important for the translation, it should be noted in 
the comment text.
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▼ Refer
The Data Pad, p. 136
The Spectrum Window, 
p. 147
The DVM Log Window, 
p. 92
Data Pad, Spectrum and DVM Log Window Text Files

The contents of the Data Pad, Spectrum window and DVM Log Window 
can be saved as standard text files able to be opened by any 
application that can import text, such as a word processor, 
spreadsheet, or statistics package.

Data Pad text file. To save the Data Pad contents as a text file, choose 
Text – Data Pad from the Format pop-up menu in the Save As dialog 
box. Each row in the Data Pad becomes a line in the text file, with the 
contents of the column cells in the row separated by tabs. Empty 
columns are not included in the file. Titles can be added to the top of 
each column by using the Data Pad’s Add Titles command prior to 
adding the data.

Spectrum text file. To save the Spectrum window contents as a text file, 
choose Spectrum Text from the Format pop-up menu in the Save As 
dialog box. The text file contains two columns separated by tabs, one 
column for frequency and one column for the height of the spectrum at 
that frequency.

DVM Log window text file. To save the DVM Log window contents as a 
text file, choose DVM Log Window from the Format pop-up menu in the 
Save As dialog box. The text file contains columns for each channel 
that has been set up to log to the DVM Log window, and one for time 
too, if it is being logged.

Auto Save
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Choose File > Auto Save… to set up Chart to automatically save while 
sampling (you need to do this before you start sampling). The Auto 
Save dialog box appears (Figure 5–11).

Select the Auto Save while sampling checkbox to turn on automatic 
saving. You can choose the period between saves, from one to 1000 in 
units of minutes or hours. Choosing the Append to current file option 
simply means that your data will be saved to the same file each time an 
autosave runs. Choosing the Use new file each time option means that 
your data is saved to a new file each time an autosave runs, with files 
named file(001), file(002), and so on, where file is the name of your 
Chart file. This is useful for breaking up a very large file into smaller 



Chapter 5 — Working Wit

Figure 5–11  
The Auto Save dialog 
box.

▼ Refer
Saving Options, p. 104
pieces, to reduce the risk of losing everything in case of file corruption. 
You can also specify whether you want a save to occur when sampling 
stops. Note that Chart stops sampling while the save occurs, so bear 
this in mind when setting the autosave period and mode.

Saving a Selection
You can choose to save a selected area of data instead of the whole 
file, letting you extract and place into a new file only the part of the 
recording that you need. You can save the data between any two 
points on the Time axis for any combination of channels. If there is a 
selection in the Chart window, then File> Save Selection… is available; 
otherwise it is dimmed and cannot be chosen. Choose the command to 
open the Save Selection dialog box.

This dialog box is similar to the Save As dialog box, except that you 
have a choice of only two file formats from the Format pop-up menu, 
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data file and text file: the other options are dimmed and unavailable. 
Once you choose a file format from the Format pop-up menu, and enter 
a name for the file, you can save the file by clicking the Save button. 
Saving a selection does not save the contents of the Data Pad. If you 
save the selection as a text file, the Save As Text File dialog box 
appears when you click Save (Figure 5–9). If there are any comments 
in the file, the Comments checkbox there will not be enabled. If, 
however, none are in the selection, a created text file will have tabs at 
the end of each line (since these would have preceded any recorded 
comments), unless the checkbox is turned off. In conjunction with the 
Append feature, you could use the ability to save a selection for quick 
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Figure 5–12  
The Save Selection 
dialog box.
creation of new files containing summarized results from much larger 
recordings. 

Appending Files
This feature allows any Chart file to be appended to the end of an open 
Chart data file in order to produce a single file with the desired 
contents. By combining this feature with Chart’s ability to save 
selections of data as files, summary files can be created using only 
those recording segments that have significance. Choose File > 
Append… to append a file to an open data file. The Append dialog 
box will appear. 
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The Format pop-up menu lets you choose the sort of file to open: only 
the chosen types will be visible in the scrolling list. Chart files are 
usually the only choice available, but others may be added through 
Chart extensions. Select the file to append to the currently open file and 
click the Open button to append it. All comments will be copied across 
and renumbered, following on after the last comment in the original file. 
Settings from the appended file are not copied across, so the Discard 
Existing Macros checkbox is dimmed and unavailable. Recording 
settings such as channel ranges and sampling rate will be the same for 
subsequent recording as they were prior to appending the file. Each 
appended file is treated as a new user-defined block or set of blocks. 
The appended file’s Data Pad is appended to the current file’s Data 
Pad (so it helps if you have titles to separate the data sets). You can 
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Figure 5–13  
The Append dialog box.
append files to the currently open file as long as there is enough 
memory to perform the operation. 

Appending a settings file is the same as opening one with an existing 
Chart data file open. An alert box gives you the choice of creating a 
new untitled data file with those settings, or applying the settings to the 
current Chart file. Applying settings to a file affects the display of 
existing data and the recording settings for subsequent sampling. It 
does not affect the recording settings of, or alter, existing data: 
sampling rates, ranges, applied units, and so on are all left unchanged.

Printing
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Printing a Chart file or part of it gives you a hard copy of data for use 
in write-ups of experiments, reports, presentations, and so on. There are 
two menu commands in the File menu to do with printing: Page Setup… 
and the basic Print command (with a keyboard shortcut of Command-P), 
which changes depending on what can be printed. 

Page Setup

To print, you need to set up the document correctly for the printer being 
used. Choose File > Page Setup… to open the Page Setup dialog box: 
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Figure 5–14  
Chart’s Page Setup 
options.

▼ Refer
Display Settings, p. 77
its appearance depends on your printer and software (the printer 
driver). The documentation that came with your printer and computer 
should explain most of what is involved. Select the paper size that you 
will print on (A4, Letter, and the like), page orientation (portrait or 
landscape), and so on. Chart has its own specific options in the dialog 
box: choose Chart from the pop-up menu to set them (Figure 5–14).

High-Resolution Printing

Selecting this option allows you to print the Chart, Zoom or X–Y 
windows at the maximum resolution of the selected printer. If you are 
using a 600-dpi laser printer, Chart will print with a resolution of 600 
dots per inch. This will result in print of the best quality, but, since every 
data point and connecting line is drawn at full resolution, printing may 
be quite slow, especially for the Chart window. 

Without high-resolution printing, the drawing resolution is limited to the 
nominal resolution of the computer screen (around 72 dots per inch). 
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This is, however, adequate for drafts and overviews, and will result in 
quicker printing — especially for overviews where the file is 
horizontally compressed, since a lot of data must otherwise be drawn 
unnecessarily. If your computer and printer are slow, we recommend 
that in most cases you use high resolution only for the final copy. 

Print Using Color

Selecting this option enables color printing of your data. You can set up 
data display colors using the Display Settings dialog box. Some colors 
may not be supported by certain color printers, or the colors actually 
printed may differ from those that appear on a color monitor. Try a few 
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Table 5–1  
Printing commands.
samples with your setup to establish color compatibility. Colors will 
print as grays on a grayscale printer.

The Print Command
If the Trigger, Stimulator, or Clipboard windows are active, the Print 
command is dimmed and cannot be chosen. In other circumstances, 
though, the command will be available and will appear in various 
forms depending on which window is active and whether any selection 
has been made (Table 5–1). Clicking the Print button in the Tool bar is 
in all ways equivalent to choosing the basic Print command.

Print All… can print the whole Chart file. When using a compatible 
continuous-feed printer, this provides a continuous record just like that 
obtained from a mechanical chart recorder. You can specify a more 

Print Command Active Window What Prints
Print All… Chart The whole file
Print Selection… Chart The selected area
Print Zoom… Zoom Zoom window con-

tents
Print X–Y… X–Y X–Y window contents
Print Comments… Comments & Exclu-

sions
List of comments in 
file

Print Data Pad… Data Pad Data Pad contents
Print Notebook… Notebook Notebook contents
Print Spectrum… Spectrum Spectrum window 

contents
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limited printing range in the Print dialog box provided by the operating 
system, but it is better to select the data you want printed. Print 
Selection… prints the selected area or areas in the Chart window. If 
there is no selected area in the Chart window (only an active point, 
say), then Print All… is the available command. If you have used the 
View buttons to compress a file horizontally (up to 2000:1), then the 
file or selection will print at the chosen compression. 

When printing the contents of the Zoom, X–Y or Spectrum windows, the 
Page Layout dialog box lets you adjust the size and location of the 
image. The shaded rectangle shows the dimensions and orientation of 
the printed page, as chosen in the Page Setup dialog box. Drag the 
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Figure 5–15  
The Page Layout dialog 
box.
image to reposition it on the page (the gray border shows where it will 
go), and drag the gray box at the bottom right of the image to adjust its 
size. You can double-click the image to scale it to the maximum size 
that will fit on the page. With the Zoom and X–Y windows, the Keep 
Shape checkbox is present in the Page Layout dialog box. If this is 
deselected, then the image can be reshaped at will. Otherwise the 
image is scaled in proportion to its original dimensions (which are 
those of the Zoom or X–Y window) or the dimensions set when the 
checkbox was off. 

Turn off this checkbox to 
reshape the image

Picture size and page 
orientation
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The Data Pad and Spectrum windows are printed out looking much like 
they do on screen, except that empty columns are not included in the 
Data Pad printout. The Notebook pages are also printed out much as 
they appear on screen (Chart will not print empty Notebook pages). 
The Print dialog box that appears when you select the Print command 
will depend on your printer and software (the printer driver). The Print 
dialog box lets you select a page range when you choose the Print 
All… command, but Chart works out the page breaks as it prints, so 
you may not get what you want. It is better to select the data to print 
and print that selection.
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When printing the contents of the Chart, Zoom or X–Y windows, Chart 
includes a footer on each page consisting of a separating line, beneath 
which are the date and time of printing, the computer owner’s name if 
it is in the system already (for file sharing), and the page number of the 
printed page. If the file has been saved, its title appears at the top of 
the first page. The Marker is drawn if visible, but the pointer and 
Waveform Cursors are not. When printing a selection or the first page 
of a file, channel titles and units are included at the left of the print-out, 
and the ranges of the channels are also drawn, much as things appear 
in the Chart window. The date and time at the start of each block is 
shown along the top of the print-out, where the block is wide enough.

When printing the Spectrum window, Chart includes a title containing 
the file name and channel from which the selection was taken. 
Information on the data selection (start time and duration) and calculation 
shown in the Spectrum window are also noted.

The Notebook
The Notebook is like a laboratory notebook attached to (and saved 
along with) a Chart file. It can be used to explain experiment protocols, 
macros, and expectations. It lets you make general notes about the 
recording as a whole, in contrast to comments, which are meant for 
brief information specific to a particular time, channel, or data 
selection. To use the Notebook, choose Window > Notebook. The 
Notebook window appears. It is a normal window, and can be used 
and moved while sampling, or left in the background while the Chart 
window is active. 
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The Notebook has a total of eight numbered pages that can be used for 
jotting down general notes about a file. Each page can contain up to 
32 000 characters, and you can autoscroll vertically through the 
contents using the up and down arrow keys on your keyboard. (Only 
about the first 1200 characters will print if the Notebook is printed, 
though: transfer the text to a word processor if this is a problem.) 
Clicking the ‘dog-ears’ at the lower left of the window turns the pages 
back and forth. Click the Date or Time buttons at the bottom of the 
window to add the date or time to your notes at the insertion point (in 
the format set for your computer in the Date & Time control panel). The 
commands Cut, Copy, Paste, and Clear can be used to edit text 
normally, although you cannot paste graphics into the Notebook. 
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Figure 5–16  
The Notebook window.

▼ Refer
Appending Files, p. 110
The contents of the Notebook window are saved with both Chart data 
and Chart settings files. However, if you append a settings file 
containing Notebook information to a data file that also contains 
Notebook information, the data file’s Notebook contents will not be 
replaced.

Printing the Notebook

When the Notebook window is active, then the Print option in the File 
menu changes to Print Notebook…, and if the command is selected, the 
contents of this window are printed rather than those of the Chart 
window. The Print dialog box allows you to print the contents of the 

Write your 
notes here

Click here to 
move to next 
page

Click here 
to move 
back a 
page

Click here to 
add the time

Click here to 
add the date
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Notebook, or any selected page range (Chart will not print empty 
Notebook pages). The pages are printed out as they appear on screen, 
stretched to fit the text to some extent, but text in excess of 1200 
characters or so will be truncated. You can copy the contents of the 
Notebook, page by page, to the Clipboard for pasting into a word 
processor if you want to use the text elsewhere. 
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Figure 5–17  
Comment entry during 
recording.
Comments and Exclusions
Comments are normally used to note brief information specific to a 
particular time, channel, or data selection. (You can make more 
general and extensive comments about the recording as a whole in the 
Notebook.) 

Comments let you annotate your recording, marking times, points, and 
areas of interest. They provide a quick and accurate method of locating 
specific data and times in a file. Exclusions are a special category of 
comment marking points and areas to be excluded from data searches, 
Data Pad calculations, saving as text, and so on. The mechanics of 
adding, viewing, and editing comments and exclusions are much the 
same, but the effects are different: comments merely mark a point or 
area, but exclusions can change the way a point or area is treated. The 
discussion here applies to both categories unless otherwise indicated. 

Using the Comments Bar

The Comments bar is used to add comments to single data points while 
recording (it does not appear when Chart is not sampling). It cannot 
add exclusions or comment upon areas, but is useful for quickly noting 
events as they occur. Type in the text entry area at the bottom of the 
Chart window, and press the Enter or Return key to add the comment to 
the file at the time the key is pressed. 

By default, the comment applies for all channels, and the numbered 
comment box is preceded by an asterisk. To comment on a specific 
channel, select the asterisk by clicking it or pressing the Tab key, and 
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type the number of the channel, or click the channel in the data display 
area: the channel number appears (for Channels 1 to 8; you can’t 
make a specific comment for 9 to 16 here while recording). To apply a 
comment to all channels, select the comment channel number and type 
a character other than 1 to 8, or click the gray area at the bottom of 
the Chart window (the Time axis area when not sampling). 

Channel the comment 
applies to (* for all)

You can add your 
comment text here

Comment 
number box
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Figure 5–18  
The Add Comment and 
Add Exclusion dialog 
boxes.

▼ Refer
Automatic Comments, 
The Automatic Comments feature lets you add predefined comments 
while recording, at the press of a Function key. These are also single 
commented points, not areas or exclusions. These comments are 
entered in the Automatic Comments dialog box. (You could also just hit 
the Return key and edit the comment later, if you are unprepared.)

Adding Comments to Recorded Data

Comments and exclusions can be added to existing data once it has 
been recorded. (This can be done while sampling if the Chart window 
is split and recorded data are selected in the left-hand pane.) First 
ensure there is a suitable active point or area selected. To add a 
comment, choose Commands > Add Comment…, type Command-K, or 
click the New Comment button in the Tool bar. The Add Comment 
dialog box appears. To add an exclusion, choose Commands > Add 
Exclusion… or type Command-E. The Add Exclusion dialog box 
appears.
p. 226
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A comment can be typed or pasted into the Comment text entry box. 
For practical purposes, the text should not exceed 60 to 70 characters, 
since more than that will neither be clearly visible in the pop-up 
comment box nor print in full when a list of comments is printed.

You may choose at the outset to apply the comment to all channels, a 
specific channel, or a set of channels, by clicking or making a suitable 
selection in the Time axis area or the channel of interest. When the 
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▼ Refer
Display Settings, p. 77
dialog box appears, the Channels text entry box shows your initial 
selection, but you can change it. Enter ‘All’ for all channels (1–16), or 
the numbers of channels to be affected, in one or more sets. Spaces are 
ignored, commas separate, and hyphens indicate a range, so entering 
‘2, 4, 6–8’ would apply the comment to Channels 2, 4, 6, 7 and 8. 
You can apply a comment to a channel currently hidden or off. 

Click OK, or press the Enter or Return key, to add the comment to the 
file at the active point or over the selected area, in the chosen channels. 
If Chart cannot make sense of an entry (if a channel number was over 
16, say), it will instead apply the comment to your initial selection. 

Appearance

The appearance of comments in the Chart and Zoom windows is set in 
the Display Settings dialog box. They can be hidden altogether, shown 
as numbered boxes, marked by dotted lines or areas of a chosen 
shade, and may have the comment text visible as well. 

Comments are automatically numbered in the order in which they are 
added to a file, regardless of category (comment or exclusion), and not 
necessarily left to right across a file. Numbered comment boxes are 
shown in the Time axis for comments applying to all channels, in the 
channel of a channel-specific comment, or in the top channel of a 
comment applying to several channels. The boxes are filled with the 
shade assigned to the comment category. 

Commented points are marked by a dotted vertical line, and areas are 
marked by a chosen shade (comments use a solid shade; exclusions 
are striped). Comments apply to a time or time range, so they always 
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mark the full height of the channel or channels to which they apply. As 
much of the comment text as will fit is shown vertically beside a 
comment line, or horizontally across an area to the right of the 
comment box. The text appears in the channel of a channel-specific 
comment, or in the top channel of one applying to multiple channels. 
Vertical text dims the waveform or block boundary beneath it. 

Text labels are obviously very useful, since one can immediately read 
what the comment or exclusion marks, if the text is brief. If the comment 
is too long to be seen in the space available, you can read it by 
positioning the pointer over the comment box and pressing the mouse 
button (Figure 5–19). As well as the text of the comment, the pop-up 
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Figure 5–19  
General and channel-
specific commented and 
excluded points and 
areas, and the pop-up 
comment box.

Figure 5–20  
Changing a comment’s 
time (left), and time 
range (right) in the Chart 
window.
comment box shows its number, category, and time or time range. A 
comment read like this in the Chart window is highlighted in the 
Comments & Exclusions window, and scrolled to if it is not visible, if 
that window is open. 

Changing Times

Comments can be edited in various ways. Changing the time or time 
range is done in the Chart window. To do this, click the comment box 
for the comment to be changed. A commented point will show a single 
control handle (a black box) at the top of its dotted line and an area 
will show three control handles at the top of its area. The control 
handles still appear even if lines and areas are not displayed. Drag the 
(middle) control handle to move the comment. Drag the outer control 
handles of an area to increase or decrease the area’s extent, and 
Chart Software

hence the comment’s time range. A highlighted line or area shows 
where things will end up when you release the mouse button. You can’t 
move or extend comments beyond a block boundary. If you need finer 
control of comment position, use the Zoom window to look at a 
selection in more detail: comments are duplicated there, and can more 
easily be assigned to particular data points or areas. 
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Figure 5–21  
The Comments & 
Exclusions window.
The Comments & Exclusions Window

The Comments & Exclusions window lets you look at comments in the 
file together, locate or delete them, or edit their text. To use the 
window, choose Window > Comments & Exclusions or type Command-
L. The Comments & Exclusions window can be moved around the 
screen or left in the background while the Chart window is active. 

The comments are listed down a scrolling field in the order that they 
appear left to right across a file (and so not necessarily in numerical 
order). The comment numbers appear in boxes, as they do in the Chart 
window, with the box preceded by the number of a specific channel it 
applies to, or an asterisk if it applies to more than one channel. The 
category of the comment (comment or exclusion) is listed at the right. 

Channel 
Number 
buttons

Comment 
text

If text is entered 
here, only 
comments 
containing that 
text will be listed
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Use the scroll bar to the right of the window to go through long lists of 
comments. 

A number of features in this window help in searching large files for 
comments by restricting which comments appear in the scrolling list. 
The Channel Number buttons at the top of the window let you hide 
channel-specific comments. Comments for channels with highlighted 
buttons appear (by default, all of them): click to deselect or reselect a 
channel. Comments applying to all channels are not affected by these 
buttons. The Show Comments and Show Exclusions checkboxes let you 
choose which categories of comment appear: by default, both are on, 
but you can turn a checkbox off to hide all comments in that category 
(at least one must be on). Type text in the Filter text entry box to show 
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only comments containing that text (ignoring case and context, so ‘new’ 
also covers ‘New’ or ‘newer’). 

The Show Times checkbox (on by default) precedes comments with the 
times at which, or time ranges over which, they appear. If you turn it 
off, then times do not appear, either in this window or in the list of 
comments printed from it. 

The Time column shows the times or time ranges in the form set by 
display settings. Column widths can be changed, for instance to give 
more room if comments in the list are truncated, or if the times are short 
rather than time ranges or times of day. Position the pointer on the 
dividing line so that it changes into the resizing pointer, drag until the 
column is the desired width — a gray line appears, to indicate position 
— then release the mouse button. 

Once a comment in the list is selected (by clicking it), then it may be 
edited, deleted, or located (comments selected in the list will show 
control handles in the Chart window). The pointer changes to an I-beam 
over text in a single selected row, and the text can be edited normally. 
The channel identifier, comment number, time, and category cannot be 
altered here. If the Delete button is clicked, a selected comment is 
deleted. To choose multiple comments for deletion, drag or Shift-click to 
select contiguous comments, or Command-click to select or deselect 
multiple comments individually. 

If a comment is selected and the Go To button is pressed, the Chart 
window becomes active, the comment is located and centered in the 
data display area, and a brief animation shows its position. Currently 
hidden comment boxes are made visible again. Lines and areas, or text 
Chart Software

labels, may also be made visible if their checkboxes are on in the 
Display Settings dialog box. This is very useful for locating commented 
features or excluded areas in the file. If you have multiple comments 
selected, the comment at the top of the list is the one centered in the 
data display area. If the data display area is split into two panes, 
comments are located in the right pane. 

Comment Numbering

When comments are deleted, the numbers for the remaining comments 
in a file do not change (this helps to prevent confusion when editing 
files). When a file is appended to another file, the comments in the 
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appended file remain in the same order, but are renumbered following 
on from the highest comment number in the file to which it was 
appended. 

Identifying a Data Point

If the Marker is dragged to a comment box in the Chart window, the 
box will highlight. When released, the Marker locates itself on a data 
point recorded at the time the comment was made (the start of a 
commented area). If the comment is channel-specific, the Marker is 
located on the waveform of that channel, if it has data; else (if the 
comment applies to all channels, say), the Marker is located on the 
waveform of the top channel. 

Printing Comments

If the ‘Text Label’ checkbox is on in the Display Settings dialog box, 
comments are printed where they in the data print-out when you are 
printing a whole file or a selection. When the Comments & Exclusions 
window is active, then the Print option in the File menu changes to Print 
Comments…, and if the command is selected, the contents of this 
window are printed rather than those of the Chart window. Comments 
are printed out as a numbered list, with the numbers boxed. Only those 
comments chosen for display using the Channel Number buttons in the 
Comments & Exclusions window will print. If the Show Times checkbox 
is on, then times (start times, not time ranges) will be printed; if it is off, 
times are not printed. Categories are not printed. This helps if you have 
long comments, since comment text longer than one line will not be 
printed — an ellipsis (…) in the print-out indicates truncated text.
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Using Exclusions

Artifacts in a recorded signal can interfere with analysis. Large data 
spikes can result from bumping laboratory equipment, adjusting 
measuring electrodes, and so on, especially with sensitive recordings. 
Temporary loss of a signal can result from a loose connection. When 
recordings are analyzed, such glitches, unrepresentative of the signals 
being measured, can show up as serious anomalies in derived readings 
such as frequency, peak height, cyclic variables, and so on. 
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Exclusions are a way to mark invalid data without removing them from 
the file. If you just delete the data, the action creates a time 
discontinuity (and hence a new block boundary). A selection must also 
be deleted over all channels. An exclusion can apply to a single 
channel, so otherwise unaffected data on other channels are not lost, 
and it doesn’t create a new block: excluded data are simply ignored 
for most calculations and analysis, saving as text, and so on. The text of 
the exclusion can be used to indicate why the point or area was 
excluded. Since exclusions are easily added and deleted, you can also 
use them to exclude data temporarily to see what effect this has on 
particular readings. 

Finding Files
It is simple enough to organize a small number of data files with a very 
basic filing system using a few folders. Once a large number of files 
have been recorded, especially if there are many similar ones, the task 
becomes harder. Chart’s file information feature helps you to keep track 
of data files. Suitable information can be stored in a file, and then 
(along with any comments in the file) can be searched for, so that you 
can quickly find a specific file when it is wanted. 

File Information

Choose File > File Information… to prepare a file for later searches: the 
File Information dialog box appears. Enter text in the various fields 
according to some suitable system. The title can be a longer version of 
the file title. The Other field lets you enter extra keywords, for instance, 
or descriptive text (perhaps transferred from the Notebook). The Ask for 
Chart Software

Information pop-up menu determines when all this is asked for. By 
default it is set to Manual, which means you must remember to choose 
the menu command to add the information. You can make Chart 
request file information by choosing one of the other options. If Before 
Saving is chosen, then the File Information dialog box appears for you 
to enter information when you save a file. If Before Sampling is chosen, 
then the dialog box appears when you click the Start button. Click the 
Cancel button to dismiss the dialog box without entering information, or 
the OK button to accept any entered text. The text is not saved with 
settings, but the state of the pop-up menu is. 
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Figure 5–23  
The Find File dialog box.

Figure 5–22  
The File Information 
dialog box.
Searching for Files

Choose File > Find File… to find a Chart file using its internal file 
information: the Find File dialog box appears. 

The Search in pop-up menu lets you choose where to search: local 
disks, all currently available disks including mounted servers, or any 
specific disk. The Search field pop-up menu lets you choose which of 
the five fields Title, Author, Keyword, Other and Comments to search 
in. The first four of these fields correspond to those in the File 
Information dialog box, and the last lets you search the comment text of 
files, which is useful for files that lack specific file information. Enter the 
text to search for in the Contains text box (ignoring case and context, 
so ‘new’ also finds ‘New’ or ‘newer’), and click the Find button to look 
for files. 
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Figure 5–24  
The Found Files dialog 
box.
While the search is under way, the Found Files dialog box appears. 
The search criterion is shown under the dialog box title: as files 
matching it are found, they are added to the File List in the top half of 
the dialog box. To halt the search at any time, click the Stop button. 

Once the search is finished, the File List shows which files have been 
found, with the context of the found text shown at the right. Click to 
select one of the found files: its location is shown in the File Location List 
in the lower half of the dialog box. If the search proved unsatisfactory, 
you can click the Find Again… button to open the Find File dialog box 
once more, and try a different approach. Click the Open button to 
open a selected Chart data file. 
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Backing Up Files
It is always good practice to back up computer files. Computers are 
reasonably reliable, but file corruption, disk failures, and accidental 
deletion of data can still occur. If your Chart files are important, you 
should back them up. You can get data backup software to do this 
automatically, or you can set up a backup schedule yourself. Off-site 
and Internet-based backup services are available as well. It helps if 
things are well organized, and your files and folders sensibly named 
and arranged. (If it takes you as long to find the backup as it would to 
record the data again, you haven’t saved yourself much work.) 
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Chart data compression is very good, so you don’t save too much 
space by archiving data files. Simply copying them to another disk is 
enough (having copies on the same disk doesn’t help if the disk fails). 
The most reliable backup media are recordable CDs, magneto-optical 
disks, or hard disks (including servers, especially if they also have tape 
backup). Floppy disks are best treated as temporary media only. 

If you back up files onto a computer using the Windows OS, be 
careful. Try to make sure the files are only handled from the Mac OS. 
Windows systems typically do not understand Macintosh files, and may 
discard information such as the file type or resource fork if the files are 
manipulated by the OS or an archiving program. Chart files should still 
be recoverable even if the file type and resource fork are lost. It may be 
necessary to add “.cfm” to the file name in the Finder to force Chart to 
recognize it as a Chart file.

Always test your backup procedures as fully as possible. Try backing 
up and retrieving sample files to make sure things work before working 
with critical files. 
h Files 127
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C H A P T E R  S I X

Data Analysis

The whole purpose of recording data, of course, is to find things out 

through analysis of the recording. Chart offers a wide range of online 

and offline calculations and makes it easy to extract parameters and 

statistics from your data.

This chapter discusses Chart’s many analysis options.You can measure 

absolute or relative quantities with the Waveform Cursor, and 

calculate, store and export further parameters with the Data Pad. You 

can plot data from one channel against that from another using the X–Y 

window. You can arithmetically combine data in different channels, 

smooth data, and analyze the cyclic components or the derivatives and 

integrals of your signals. This can be done during sampling by 
129

applying Computed Input functions, or after recording by using channel 

calculations. You can also use the Spectrum window to analyze the 

frequency components of your data.



130

Figure 6–1  
Measuring waveform 
data.

▼ Refer
Cursor,  p. 192
Measuring from the Waveform
When you have finished recording, you can scroll through your data 
and make measurements directly from the recording — since everything 
is digital, you are given a direct read-out, with no chance of the 
measurement errors that could occur in analyzing a paper-and-ink 
record. You can make direct or relative measurements. 

When the pointer is over the data display area (or Time axis), the 
Waveform Cursor for each channel tracks the waveform at the time 
position of the pointer. In this case, the Rate/Time display shows the 
time at the pointer location, and the Range/Amplitude display for each 
channel shows the amplitude of the waveform at the Waveform Cursor 
location. The Waveform Cursor only gives discrete measurements, 
jumping from data point to data point (you can see this more clearly in 
the Zoom window). It cannot provide a reading on the line that is 
drawn between the points for display purposes. 

Time at pointer 
(and Waveform 
Cursor) position

Amplitude at 
Waveform 
Cursor position

Pointer

Waveform 
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The pointer appears as a cross over the data display area (or a double-
headed selection arrow along the Time axis). The Waveform Cursor’s 
shape is a cross by default, but can be changed in the file preferences 
to suit the waveform. 
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Figure 6–2  
Measuring relative 
waveform data.
Using the Marker

The Marker can be found at the bottom left of the Chart window. It is 
used to set a particular data point as a zero reference point, so that 
relative measurements can be made with respect to that point. 

To set the reference point, drag the Marker into the channel of interest; 
it will lock onto the waveform there when you release the mouse button. 
Watch the changing numbers in the Rate/Time and Range/Amplitude 
displays to help to select a data point. If you need finer control of 
where the Marker ends up, use the Zoom window to look at a selection 
in more detail: the Marker is duplicated there, and can more easily be 
assigned to a particular data point. 

If there is a selection in the Chart window, you can choose commands 
from the Set Marker submenu of the Commands menu to locate the 
Marker where you want it: Minimum Point, Maximum Point, First Point, 
or Last Point. The Marker is then moved to the lowest, highest, left-most, 
or right-most points in the selection respectively, either in a specific 
channel, or the top one of several. If there is an active point in the 
Chart window, any of the commands moves the Marker to the position 
of the active point. 

Once the Marker is in position, measurements relative to it (preceded 
by ∆) are given in the readings for time in the Rate/Time display as the 
pointer moves. The reading in the Range/Amplitude display for the 
channel where the Marker is located is also relative to the Marker, but 
the values at the Waveform Cursor positions for the waveforms in other 
channels are absolute. The ‘∆’ (delta) symbol before a value indicates it 
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is a difference, not a direct reading. Derived values (in the Data Pad 
and so on) take the Marker into account when appropriate. 

The Rate/Time display indicates if the pointer is not in the same block 
as the Marker, and if the block has a different scale or different units to 
the one the Marker is in, the Range/Amplitude display reads ‘∆ Range 
Invalid’ as well. 

If the Marker is dragged to a comment box in the Chart window and 
released, the comment box highlights and the Marker locates itself on 
the data point recorded when the comment was made, either in the 
channel of a channel-specific comment, or the top channel otherwise. 

Double-clicking the Marker or clicking its box at the bottom left of the 
Chart (or Zoom) window sends it back to its box. 

Setting and Removing Baselines

The Set Baseline command is used for setting relative amplitude 
measurements where the voltage (amplitude) baseline of a channel is 
not zero. Once you have recorded a waveform, you may find that the 
baseline value is not zero volts (or set units) when it should be — that 
is, there is some slight offset. To remedy this, select an active point or 
area along the waveform where the measurement should be zero, and 
choose Commands > Set Baseline. The value at that point or the 
average of the selection is set at zero, and scale units of the Amplitude 
axis change to show this. The position and size of the waveform in the 
channel display does not change: if you want it altered, simply drag or 
stretch the scale. 
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The baseline is set for the particular block or blocks of data in a 
channel that the selection intersects. To set the baseline across the 
whole channel for all blocks of data, hold down the Command key 
while choosing Commands > Set Baseline. Remove Baseline removes a 
baseline previously set, and also affects the selected block or blocks of 
data in a channel. Holding down the Command key while choosing 
Commands > Set Baseline removes any set baselines across the whole 
channel. 
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Figure 6–3  
The Find and Select 
dialog box.
Finding Data
The Overview miniwindow gives an overview of a channel, where you 
can see longer-term trends, and find particular events on a large scale. 
The events you want to find may be of smaller scale, and may not be 
obvious in overview. Chart therefore provides another method to find 
and select data of interest in a recording, according to criteria you 
specify. It also helps in automating searching by macros. To find data, 
choose Commands > Find… or type Command-F: the Find and Select 
dialog box appears (Figure 6–3). 

Channel 
to search

General 
search 
criteria Specific 

search 
criteria

Selection 
criteria

Explanation 
of selected 
option

Search 
direction 
arrows
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You can set up search and selection criteria as desired, to search any 
channel for comments, peaks and troughs in the waveform, block 
boundaries, and so on, and to set the active point at the position found, 
or select data for a period before, around, or after it, for the active 
channel or all channels. 

Search Criteria
You can search for an event in a specific channel or in the current 
channel (the default), that is, the one with a current selection or active 
point. If the active point or selection in the Chart window extends 
across multiple channels, then the topmost one is searched. Use the 
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▼ Refer
Using Exclusions,  
p. 123
Channel pop-up menu at the top left of the dialog box to choose the 
search channel from the list of channel titles. Two scrolling lists let you 
select from the many forms of information that could be sought. The left-
hand list gives the general type, and the right-hand one options 
available in that set. The selected option is briefly explained in a box 
beneath the two lists. The exact controls in the dialog box depend on 
what is chosen in the scrolling lists.

Go

Go can find the start or end of the file or the current block within the 
file, the start of the next block, or the end of the previous block. You 
can also move forward or backward through a file by a set time in 
seconds. If you select the Move Forward or Move Backward options, a 
text entry box appears, in which you can type in a number from 
0.00001 to 10 000 seconds, in increments of 0.00001 seconds (the 
time between samples at 10 000 samples per second). This always 
moves at least one data point, whatever the sampling rate. 

Find Comment

Find Comment searches for text in comments (including exclusions). 
There is only one option in the list; the search direction is set by the 
direction arrows to the right of the Channel pop-up menu. Click the 
right one to search forward, the left one to search backward. 

Two more controls appear beneath the scrolling lists: type text in the 
text entry box to find only comments containing that text (ignoring case 
and context, so ‘new’ also finds ‘New’ or ‘newer’). Turn on the Just this 
Channel checkbox to find only comments that apply to the search 
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channel (ignoring channel-specific comments in other channels). 

Find Data

Find Data can search for local maxima or minima, or data points 
above or below a set value. The search direction is set by the direction 
arrows to the right of the Channel pop-up menu. Click the right one to 
search forward, the left one to search backward. These searches ignore 
excluded data (points and areas marked by exclusions). 

If you select the Local Maxima or Local Minima options, Find Data 
searches for peaks or troughs respectively. A text entry box appears, in 
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which you can type in a number from 1 to 90 to set a noise threshold 
for the event, as a percentage of the range of the channel (the default 
value is 5%, which is 1 V for a ±10 V range). For a data point to be 
recognized as a peak or trough, the data points that follow must 
decrease (for a local maximum) or increase (for a local minimum) by at 
least the noise threshold value. Local maxima and minima in the 
waveform with smaller amplitudes than this value will be ignored. Raise 
the value to get rid of unwanted small fluctuations (noise and so on); 
lower it to detect missed events. 

If you select the Data Above or Data Below options, a text entry box 
appears, in which you can type in a value from ±0.00001 to ±10 000 
to set the value, in whatever units are assigned to the search channel. 
The first matching data point above or below the set value is found.

Selection Criteria
Once an event is found, an active point or selected area is set in the 
Chart window, using the controls at the bottom of the dialog box. 

The Select All Channels checkbox is off by default, in which case the 
active point or selected area set by the command is confined to the 
search channel. If the search channel is in a set of overlaid channels, 
then all channels in that overlay will be selected. A selected area will 
extend to the full height of the channel or channels. Click the checkbox 
to turn it on and set an active point or selection area over all channels, 
as if you had clicked or dragged in the Time axis.

Choose the Set Active Point radio button to set an active point at the 
time of the event. Choose the Select to Previous Point radio button to set 
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a selection area from the time of the event to the nearest boundary of 
the previous selected area, or the previous active point. If you choose 
the Select radio button, a text entry box and pop-up menu appear. 
Type in a time from 0.00001 to 32 000 seconds to set the horizontal 
extent (duration) of the selected area. Choose one of the options in the 
pop-up menu: After, Around, or Before. After selects an area from the 
time of the event forwards; Before selects an area from the time of the 
event backwards. Around selects an area of data symmetrically around 
the time of the event. 

The active point or selection area set is shown in the Chart window if it 
is not visible already. You can choose from the Data View pop-up menu 
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▼ Refer
Macros,  p. 202

Figure 6–4  
The Data Pad window.
whether the found data are merely visible, or shown at the left or right 
of, or centered in, the Chart data display area. Setting a fixed position 
is useful for repeatedly finding data, since you can keep looking at the 
same area of the screen as you go through the file. 

Repeatedly Finding Data
Once the criteria for finding and selecting an event have been set up, 
you can choose Commands > Find Next or type Command-G to find 
and select the next such event. You can repeat this command as 
needed to find multiple events (it will repeat at your keyboard’s auto-
repeat rate if you hold the keys down). This is easier than scrolling 
through manually to look for events, and is very useful in conjunction 
with macros, for instance, to select events in a channel automatically 
and record information to the Data Pad. 

If the Find… or Find Next commands fail to find an event (because the 
selection would move outside the file boundaries, for instance), then 
Chart will beep. 

The Data Pad
The Data Pad is used to analyze waveform data. It is easy to set up and 
use; you can record up to 32 columns of data in it, either direct 
waveform values or calculated values from any channel, from active 
points or over selected areas. The Data Pad can store large amounts of 
data — up to 32 000 rows, with each row having a maximum of 255 
Chart Software
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characters per cell, and a total of 2000 characters per row over the 32 
columns. Its contents can be saved as a text file or copied in whole or 
part to the Clipboard for transfer elsewhere. To open the Data Pad, 
choose Window > Data Pad. 

The Data Pad is a normal window and can be moved around the 
screen or left in the background while the Chart window is active. 
Information on the current selection or active point is displayed just 
above and beneath the column headings: the readings beneath the 
column headings are separated from recorded data by a heavy line, 
and are centered rather than left-justified to help to distinguish them. As 
data are added to the Data Pad, new rows of values are created below 
existing rows in the data area. Each cell contains only one entry, the 
value added to the Data Pad at the time the calculation for its column 
was made. The column heading shows the title of the channel from 
which the reading currently derives. Use the scroll bars to move down 
or across through rows and columns. 

The two tools used to deal with data in the Data Pad are chosen using 
buttons at the top left of the window. By default the Row tool is selected 
(and the leftmost button, with the pointer-like arrow, highlighted): in this 
case, the pointer changes to a heavy cross when over the data area. 
Click to select a row, drag or Shift-click to select contiguous rows, or 
Command-click to select or deselect rows individually; the data can 
then be cleared, or cut or copied to the Clipboard as tab-separated 
text, using the commands in the Edit menu (Cut, Copy, Paste, Clear). If 
the Cell button (with the A) is clicked, the pointer changes to an I-beam 
when over the data area, and text in each cell can be edited in the 
normal way. Clicking the Cell button deselects all selected rows. 
s 137

The pop-up menu to the right of the window lets you add to the Data 
Pad either blank lines (rows), or the full current column headings as 
three lines — useful to keep track of changed settings, or when 
transferring data to other applications. (Superscripts and subscripts in 
column headings are converted to plain text when added to the Data 
Pad.) You can also choose whether to keep or clear the Data Pad 
contents when a new file is created: a tick appears beside the lowest 
menu command when it is active (it applies only to the current file). 

The width of columns can be changed to suit the displayed data and 
headings. You might want to narrow columns to display more on 
screen, for example, or have a wide column to the right in which to 
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Note
Other functions may be 
added to the Data Pad 
through Chart 
extensions.

▼ Refer
Using Exclusions,  
p. 123
add comments. Position the pointer on the heavy dividing line between 
column headings, so that it changes into the resizing pointer, drag until 
the column is the desired width — a gray line appears, to indicate 
position — then release the mouse button.

Adding Data to the Data Pad

To add data on a selection or active point in the Chart window to the 
Data Pad, choose Commands > Add to Data Pad or type Command-D. 
As a shortcut, you can double-click in the data display area to transfer 
data at a point (double-clicking in the Time axis selects a block, though, 
and transfers no data). If you need finer control of what is transferred, 
use the Zoom window to look at a selection in more detail: a particular 
data point can be double-clicked more easily. 

If a selection straddles two or more blocks and the blocks have different 
units, the selection will be noted as having multiple units rather than any 
Data Pad calculation being attempted. Exclusions (points or areas 
marked as excluded from analysis) are treated as separate blocks 
containing no valid data, so no calculations based on that data are 
attempted. Exclusion comment text is also ignored. Time and selection 
values for excluded data are returned, however. 

The data recorded depends on the choices made in the Data Pad 
Column Setup dialog box. By default, the first few columns are set to 
record the mean of the selection in a channel (or, when there is an 
active point, the waveform value at that point). Any column can record 
data from any channel, though (so you could have any number of 
variables deriving from Channel 1, for instance).
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Setting Up the Columns
The data recorded in the Data Pad depends on the choices made in the 
Data Pad Column Setup dialog box: it appears on clicking a column 
heading, and will have the column number (1–32) in its title. 

To move to the dialog boxes of adjacent columns (and set up many 
columns quickly), click the arrows by the dialog box title, or press the 
right or left arrow keys on the keyboard. Click OK to close the dialog 
box after you have set up all the columns you need. Two scrolling lists 
let you select from the many forms of information that could be 
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Figure 6–5  
The Data Pad Column 
Setup dialog box.
recorded, whether derived or direct. The left-hand list gives the general 
information type, and the right-hand list options available in that set. 
The selected option is briefly explained in a box beneath the two lists. 
The channel from which data are taken is selected in the Channel pop-
up menu at the right of the dialog box. 

Off simply turns the column off: no data are recorded in it. This will 
disable and dim the radio buttons and Channel pop-up menu. 

General Statistics

Mean calculates the mean of the data points in the selection, or returns 
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the value at the active point. Standard Deviation calculates the standard 
deviation of the data points in the selection. Standard Error calculates 
the standard error of the mean of the data points in the selection. 
Maximum Value returns the value of the largest data point in the 
selection. Time at Maximum returns the time at which the largest data 
point in the selection was recorded. Minimum Value returns the value of 
the smallest data point in the selection. Time at Minimum returns the 
time at which the smallest data point in the selection was recorded. 
Max–Min calculates the difference between the largest and the smallest 
data points in the selection (zero for an active point). 
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Integral returns the integral of the selection, calculated as the sum of the 
data points multiplied by the sample interval; ∑y ∆t. Integral from 
Minimum returns the integral of the selection, calculated as the sum of 
the data points minus the minimum value in the selection, multiplied by 
the sample interval; ∑(y–ymin) ∆t. Integral from Start returns the integral 
of the selection, calculated as the sum of the data points minus the first 
value in the selection, multiplied by the sample interval; ∑(y–yfirst) ∆t. 
Integral from Baseline returns the integral of the selection, calculated as 
the sum of the data points minus the value on a baseline (drawn from 
first to last data points in the selection), multiplied by the sample 
interval; ∑(y–ybaseline(t)) ∆t. 

Number of Points returns the number of data points in the selection (one 
for an active point). RMS calculates the RMS (root mean square) value 
of the data points in the selection, or returns the value at the active 
point. 1/3Max + 2/3Min calculates 1/3 of the maximum value plus 
2/3 of the minimum value of the data points in a selection, or returns 
the value at an active point. 

Selection Information

Start returns the start time of a selection, or the time at the active point. 
End returns the end time of a selection, or the time at the active point. 
Duration returns the duration of a selection, or the sample interval for 
an active point. Number of Points returns the number of data points in 
the selection (one for an active point). 

Cursor & Comments
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Time returns the start time of a selection, or the time at the active point. 
Value returns the value at the start of a selection, or the value at the 
active point. Comment Full extracts the full comment text. Comment 
Numbers Only extracts the first number from comment text (e.g. ‘Add 
100 mL of 2 mM’ would return ‘100’). Comment Number returns the 
number of a comment. Comment Time returns the start time of a 
commented area, or the time at a commented point. For comments, in 
each case the Data Pad looks for the first comment to the left of an 
active point or from the right edge of a selection. Comment Duration 
returns the duration of a comment.
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▼ Refer
Cycle Variables,  p. 176
Slope

Average Slope returns the average slope (time derivative) of the data 
points in a selection, or the slope at an active point. The average slope 
is calculated from the least-squares line of best fit. Maximum Slope 
returns the maximum slope of the data points in a selection, or the slope 
at an active point. Minimum Slope returns the minimum slope of the 
data points in a selection, or the slope at an active point. Time at Max 
Slope returns the time at which the maximum slope in a selection 
occurs, or the time at an active point. Time at Min Slope returns the time 
at which the minimum slope in a selection occurs, or the time at an 
active point. 

Block Information

Range returns the range used when recording for the block containing 
the active point or selection. Sample Interval returns the time between 
samples for the block containing the active point or selection. Block 
Number returns the block number for the block containing the active 
point or selection. Block Duration returns the total time of the block 
containing the active point or selection. Samples in Block returns the 
total number of samples in the block containing the active point. Start 
Time returns the time of day at the start of the block containing the 
active point or selection. Start Date returns the date at the start of block 
containing the active point or selection. Sampling Rate returns the 
sampling rate used when recording the block containing the active 
point or selection. If a selection straddles two or more blocks, however, 
then it will be noted as discontinuous.
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Cycle Variables

Cycle Variables parameters are for analyzing periodic waveforms. The 
calculation of each parameter is based on waveform cycles. When a 
Cycle Variables parameter is selected in the Data Pad Column Setup 
dialog box, an Options… button appears. Clicking this button allows 
you to set up the way in which waveform cycles are detected, in the 
same way as you do when using the Cycle Variables channel 
calculation.

The way in which you set up cycle detection applies to the detection of 
all cycle variables in the channel chosen in the Data Pad Column Setup 
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▼ Refer
The Spectrum Window,  
p. 147
dialog box’s Channel pop-up menu. This is handy when you have 
multiple columns in the Data Pad showing various cyclic calculations for 
a single channel, since the detection parameters only need be set up or 
changed once for the whole lot. Any changes made to the cycle 
detection settings for a particular channel here will affect the Cycle 
Variables calculations for that channel as well, and vice versa.

Cycle Variables parameters can only be calculated if there is a valid 
selection. The Data Pad and Data Pad miniwindow displays show 
certain messages when Cycle Variables cannot produce a useful result. 
‘No Selection’ shows if there is no selection, but only an active point, 
for example. ‘Invalid’ shows if the selection crosses a block boundary 
or is in a channel with no data, or if no Cycle Variables or cycles are 
detected (for instance, there is less than a full cycle from which to 
calculate a peak-to-peak value).

Event Count counts the number of events in a selection. Cycle Count 
counts the number of cycles in a selection. This will be zero if there is 
only one event. Frequency calculates the average frequency of the 
cycles in the selection in cycles per second (Hz). Rate calculates the 
average frequency of the cycles in the selection in reciprocal minutes 
(BPM, beats per minute). Average Period calculates the average period 
between the cycles in the selection. Minimum Period calculates the 
minimum period between the cycles in the selection. Maximum Period 
calculates the maximum period between the cycles in the selection. 
Average Minimum calculates the average of the cyclic minima in the 
selection. Average Maximum calculates the average of the cyclic 
maxima in the selection. Average Peak-to-Peak calculates the average 
of the cyclic peak-to-peak (maximum minus minimum) differences in the 
selection. Average 1/3Max+2/3Min calculates the average of the 
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cyclic 1/3Max+2/3Min values in the selection. (1/3Max+2/3Min 
calculates 1/3 of the maximum value plus 2/3 of the minimum value of 
the data points in a cycle.)

Spectrum Parameters

Spectrum parameters are based on spectra which are calculated 
according to the settings in the Spectrum Settings window, and 
displayed in the Spectrum window. When a Spectrum parameter is 
selected in the Data Pad Column Setup dialog box, an Options… 
button appears.
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Figure 6–6  
The Spectrum Parameter 
options dialog box.
If there is a selection of valid data in the Chart window, Spectrum can 
perform a range of calculations in the Data Pad to determine the 
spectral parameters. The Spectrum window does not need to be visible 
in order for these parameters to be calculated. The Data Pad and 
miniwindow displays show ‘Invalid’ if there are no selected data. To 
preset frequency limits, or choose whether or not to display (in the Data 
Pad headers) the frequency limits within which the parameters are 
calculated, click the Options… button at the bottom of the Data Pad 
Column Setup dialog box. The Spectrum Parameter Options dialog box 
appears.

If you know the range of frequencies in which you are interested, you 
can turn on the Preset Frequency Limits checkbox and enter them in the 
text entry boxes. Parameters are then calculated from between those 
frequency limits (or as close as possible, given the frequency 
resolution). If the checkbox is off, then parameters are calculated over 
the frequency limits of any selection in the Spectrum window, or else 
the frequency range visible in the window if there is no selection. 

Turn on the Show Frequency Range in Data Pad checkbox to display 
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the frequency range used by Spectrum in calculating parameters, in the 
Data Pad column headers, and in the Data Pad miniwindows (it 
appears in brackets after the units). 

Maximum Power displays the maximum power. Minimum Power 
displays the minimum power. Maximum Amplitude displays the 
maximum amplitude. Minimum Amplitude displays the minimum 
amplitude. Frequency at Max displays the frequency at maximum 
power/amplitude. Frequency at Min displays the frequency at minimum 
power/amplitude. Power displays the power. % of total Power displays 
the percentage of the total power. Mean Amplitude Freq displays the 
mean amplitude frequency; ∑ Ai Fi / ∑Ai where A is amplitude, F is 
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Figure 6–7  
Data Pad Value 
miniwindows.
frequency, and i is the ‘bin’ number. Mean Power Freq displays the 
mean power frequency; ∑ Pi Fi / ∑Pi where P is power, F is frequency, 
and i is the ‘bin’ number. These options are calculated over all the 
frequency bins in the frequency range. The range used is set by either 
the preset frequency limits, or failing that, the frequency limits of any 
selection in the Spectrum window, or failing that, the frequency range 
visible in the window. 

Start of Selection displays the time at the beginning of the data 
selection used to generate the spectrum. End of Selection displays the 
time at the end of the data selection used to generate the spectrum. 
These options refer to the selection in the Chart window.

The three radio buttons indicate when information is to be recorded. If 
the top one is selected, then if there are any data selected in the Chart 
window, information will be recorded about the channel selected in the 
Channel pop-up menu (if you have selected an area in Channel 2, 
information on Channel 3 would still be recorded, for instance). If the 
middle radio button is selected, information is recorded about the 
column channel only if that channel is included in the selection. If the 
bottom radio button is selected, information is recorded only about the 
lowest-numbered channel if more than one is selected (Channel 2 if 
Channels 2 to 4 are selected, for example). Data transfer from the 
Zoom window is always as if the top radio button were selected, 
regardless of the settings. 

The Compact Data checkbox works together with the middle radio 
button: if you select data from different channels at different intervals 
after the same stimulus, say, it will place all the data on the same line in 
the Data Pad (if the checkbox is off, then each entry will be recorded 
on a new line). It doesn’t work if you record times as well, so it is only 
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useful for simple data capture.

Its various functions make the Data Pad useful for quickly finding out 
information about a file or blocks in it: you can leave the Data Pad 
itself, set up to display the required information, as a slim visible 
background window that will be constantly updated. In addition, 
miniwindows can be created to display the current values of statistics or 
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Figure 6–8  
The X–Y window.
measurements set up in particular columns from the Data Pad. To show 
or hide the miniwindow for a column, turn on or turn off the 
Miniwindow checkbox in the Data Pad Column Setup dialog box, or 
drag the column heading to tear it off. Drag the miniwindow by its title 
bar to where you want it, click the close box to dismiss it, or click its 
body to open the dialog box again. Its title bar contains its column 
label and its body the heading, to indicate what it displays. Data Pad 
miniwindows can be resized by dragging their bottom right corners.

Printing

When the Data Pad window is active, then the Print option in the File 
menu changes to Print Data Pad…, and if the command is selected, the 
contents of the window are printed with the title ‘Data Pad from’ and 
the file name. The Data Pad will print across two or more pages if it is 
wide enough, but empty columns are not printed. 

The X–Y Window
By using the X–Y window, you can plot data in one channel against 
data in another over the same period of the recording. To open the X–Y 
window, drag in the Time axis to select an area of interest (over two or 
more channels) in the Chart window, and then choose Window > X–Y 
Window. 

X and Y values at 
the pointer position
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Y channel

Channel Number buttons

Pointer

X channel

The axes act like the 
Amplitude axis in the 
Chart window



146

▼ Refer
Display Settings,  p. 77
The X–Y window is useful to establish how two time-related variables 
relate themselves, by eliminating time: you could measure pressure and 
temperature versus time, say, then use the X–Y window to show 
pressure versus temperature. It would also show phase relationships, 
such as the hysteresis loop of a changing external field versus its 
induced ferromagnetism. The values along the x-axis (X) and y-axis (Y) 
at the pointer position are indicated at the top of the window, in the 
units assigned to the channels. The waveform is not tracked: there is no 
Waveform Cursor.

The Channel Number buttons at the bottom left (horizontal x-axis) and 
right side (vertical y-axis) of the window correspond to the numbers in 
the default channel titles. Buttons for channels not included in the 
selection, or without data, appear dimmed. The highlighted Channel 
Number buttons indicate which two channels are used in the plot: the 
bottom one provides the x-values, and the one on the right the y-values. 
The channels plotted against each other can be changed by clicking the 
(undimmed) numbered buttons: the buttons of the newly selected 
channels will be highlighted.

Both X and Y axes in the X–Y window have the same controls as the 
Amplitude axis in the Chart window, and function identically. Changing 
the display in the X–Y window does not affect the selection in the Chart 
window. The display will appear gray if no channels are selected in the 
Chart window or if no Channel Number buttons are selected. The X–Y 
window does not indicate if the selection in the Chart window is 
discontinuous (crossing block boundaries), but the X–Y plot will 
probably look strange if it is. The color for the waveform is chosen in 
the Display Settings dialog box. Comments and exclusions are ignored 
by the X–Y window, since they are time-based, and the X–Y plot 
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eliminates time. 

Copying and Printing the X–Y Window

When the X–Y window is active, then the Print option in the File menu 
changes to Print X–Y…, and if the command is selected, the contents of 
the window are printed with the title ‘XY Plot of’ and the file name. The 
X–Y window can also be copied as a picture for pasting into other 
applications, by choosing Copy X–Y… from the Edit menu. 



Chapter 6 — Data Analysi

Figure 6–9  
The Spectrum window: 
the type of spectrum 
(power or amplitude) and 
channel name are shown 
in the title bar. 
The Spectrum Window
The Spectrum window can calculate and display various power and 
amplitude spectra of selected data. Spectra indicate the strength of the 
various frequencies in a time-varying waveform. This may make 
apparent significant frequencies in a waveform that would not 
otherwise be easily observed. Spectra (various forms of power or 
amplitude spectra) are calculated using the discrete Fast Fourier 
Transform (FFT) to convert data from the time domain to the frequency 
domain. Technical details of the FFT used by Spectrum are included in 
Appendix C.

Frequency and amplitude readings FFT 
information

Settings 
button

Default Axes 
button
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To display spectra, select the area of interest in the Chart window and 
choose the Spectrum command from the Window menu. The Spectrum 
window appears. Only the horizontal extent of the selection affects the 
computation. If more than one channel has data selected, the top one is 
chosen. If a selection is made over two or more blocks, Spectrum uses 
only the data in the left-most block. The data display area will appear 

Waveform CursorScaling 
buttons
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Figure 6–10  
Enlarging a selection in 
the Spectrum window: 
click the Zoom button or 
double-click the selected 
area.
gray if there is no selection (in which case the title of the window will 
just be Spectrum), or if 32 or fewer data points are selected: the reason 
will be noted in the selection information at the right of the window. 

The Spectrum window displays information on the data selection. As 
the pointer is moved over the Spectrum data display area, the 
Waveform Cursor tracks the data, and the frequency and amplitude 
readings at its position are displayed at the top of the window. The 
spectrum is drawn in the data trace color used for the channel, and can 
be drawn as lines, bars, or connected points. The graticule is the same 
as that used in the Chart window.

The two axes of the Spectrum window can be shifted, stretched, and 
dragged for optimum data display, just like the Amplitude axis of a 
channel in the Chart window. In addition, you can use the Scaling 
buttons in the bottom left corner of the window: click the up arrow to 
double or the down arrow to halve the current scale of the axis to 
which they apply. If no units are present in the source channel the 
Amplitude axis will show units as ‘unknown’. 

You can drag within the data display area of the window to select an 
area to examine in more detail: the area becomes highlighted, and the 
Zoom button appears at the top left of the Spectrum window (replacing 
the Default Axes button). Click the Zoom button or double-click the 
selected area: the selection expands to fill the data display area, and 
the axes show the new scale.

A gray area may appear at the edge of the Spectrum window. This is a 
data limit area (as appears in the Chart window) that indicates the 
Chart Software
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Figure 6–11  
The Spectrum Settings 
window.
recorded or calculated limit of data in the window. To hide the data 
limit area, drag the axes or use the Scaling buttons.

Altering the data displayed in the Spectrum window does not change 
the selection in the Chart window. Once you have altered the axes, 
zoomed in, and so on, the Default Axes button appears (replacing the 
Zoom button if it was showing). Click it to revert to the default axes, 
and show the full spectrum of the selection in the Chart window again. 
The Default Axes button is dimmed and inactive when the default axes 
are showing (since there’s nothing to revert) or when the data display 
area is gray.

Spectrum Settings

Clicking the Settings button at the top left of the Spectrum window 
opens the Spectrum Settings window, where parameters for calculation 
and display of the spectrum can be set. The Spectrum Settings window 
can be moved around the screen or left in the background while the 
Chart or Spectrum window is active. You can keep it active and 
change the settings, and observe the changes in the Spectrum window 
in the background, if that window is visible: the spectrum will be 
recalculated or redrawn as you change settings.

FFT Size. The Discrete Fourier Transform is computed using a Fast 
Fourier Transform (FFT) method. The FFT works on a certain number of 
data points at a time over the selection to be analyzed. The larger that 
number, the greater the frequency resolution (the number of frequency 
‘bins’ into which the signal is resolved). Smaller FFT sizes give a higher 
s 149
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amplitude accuracy, but a lower frequency resolution. The FFT sizes 
available in the pop-up menu are various powers of two: 128, 256, 
512, 1024, 2K (= 2048), 4K (= 4096), and so on, up to 128K (= 131 
072 = 217) data points. This is indicated in the window above the 
graph.

Data Window. Windowing functions reduce the importance of data at 
the edges of the data segments used by the FFT, thus preventing 
spurious peaks arising from edge-related effects. There are many such 
functions, but they are all basically similar. By default, Cosine Bell is 
chosen in the Data Window pop-up menu, but you can choose Cosine 
Bell, Hamming, Blackman, or Welch windowing functions. More details 
on the windowing functions can be found in Appendix C. To turn off 
the windowing functions, if none of them are suitable, choose None 
from the pop-up menu.

Method. If the number of selected data points is greater than the FFT 
size, Spectrum determines the spectra of selected data for successive 
segments of a particular FFT size and then calculates an average 
spectrum from these FFTs. You can choose from the Method pop-up 
menu whether successive segments follow one after another with no 
overlap, or overlap by 50% of the FFT size (the default). If a windowing 
function other than None is chosen, the Method of computing the 
spectrum changes to 50% Overlap.

If No Overlap were chosen from the Method pop-up menu, a data 
selection of 1024 points with an FFT size of 512 points, for example, 
would be divided into two segments: points 1–512 and points 
513–1024. If 50% Overlap were chosen for the same data, the 
segments would change to points 1–512, points 256–768, and points 
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513–1024. The 50% Overlap option (Welch’s method) better 
approximates the moving average of the selected data, by doubling the 
number of computations and overlapping the segments from which 
spectra are computed. On the other hand, the extra calculations take 
more time, and may slow things down if your computer is an older 
model. 

Selection. There are two choices in this pop-up menu. The Use Current 
option brings the total data points in a selection to a multiple of the FFT 
size by padding the data with zeroes (adding points with a value of 
zero) on the right-hand side.
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The Adjust to Best Fit option adjusts Spectrum’s ‘internal’ data selection 
so that it is a multiple of the FFT size, by extending (symmetrically, if 
possible) the data points selected for use within the same block. Note 
that the visible selection in the Chart window is not altered, only 
Spectrum’s internal data selection, so care must be taken when using 
this feature. 

Display. Spectrum can calculate various forms of power or amplitude 
spectra: you can choose which is shown from the Display pop-up menu. 
Details on how these are computed are given later. In each case, the 
height of the spectrum at a particular frequency is representative of the 
power or amplitude contained in the waveform at that frequency. 
Appropriate units are shown in the axis labels.

Spectrum displays the results of the discrete Fourier transform in various 
ways. The Power spectrum is basic; other forms are derived from it. The 
power in a ‘bin’ of the spectrum is the modulus squared of the discrete 
Fourier transform at that frequency. The amplitude in a bin is the 
amplitude of a sine wave whose average power is the same as the 
bin’s power. Power and amplitude values are always positive or zero; 
they cannot be negative.

Power Density and Amplitude Density show the power or amplitude per 
unit frequency. Density is calculated by dividing the computed values 
by the width of each horizontal frequency bin (this width narrows as the 
frequency resolution increases and a greater number of discrete 
frequencies are recognized). The units of power density are (y-axis 
units)2/Hz, and the amplitude density units are (y-axis units)/√Hz.

The Log of Power and Log of Amplitude options show the power and 
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amplitude spectra as log10 values. The logarithmic display makes 
discernible smaller components that might otherwise be difficult to see 
in the graph because of the wide range of values. 

The Power Attenuation and Amplitude Attenuation options give a 
logarithmic display showing the relative attenuation of spectral lines 
with respect to a reference value (Pmax for a power spectrum, Amax for 
an amplitude spectrum). The reference value is always taken as the 
largest value in the spectrum and shows as 0 dB. Power attenuation is 
calculated as dB = 10 log10(Pi /Pmax), and amplitude attenuation as dB 
= 20 log10(Ai /Amax), where Pi is the ith power component and Ai is 
the ith amplitude component.
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▼ Refer
Using Exclusions,  
p. 123

▼ Refer
The Data Pad,  p. 136

Figure 6–12  
A spectrum displayed as 
lines, bars and 
connected points.
Display As. FFTs are often drawn as bar graphs, with a vertical line or 
bar for each data point. You can use this pop-up menu to display the 
FFT as lines, bars, or connected points, to suit the waveform or personal 
taste. The Waveform Cursor will track the left edges of bars, when 
these are displayed.

Remove Zero-Frequency Component. This option removes any zero-
frequency value (that is, the DC offset, or the average value of the 
original data) from the data before the spectrum is calculated. The 
checkbox is on by default since the zero-frequency component often has 
the largest amplitude of all components in a spectrum, and is usually 
unimportant. Click the checkbox to turn it off or on.

Exclusion Aware. Chart data can be marked with exclusions — points 
or areas to be excluded from analysis for various reasons. By default 
the Exclusion Aware checkbox is on and Spectrum takes exclusions into 
account, ignoring excluded data. In this case, exclusions are treated as 
separate blocks containing no valid data. Thus a spectrum will not be 
calculated for a selection lying wholly within an exclusion, and if a 
selection intersects with an exclusion, only the left-most unexcluded data 
will be used. If the checkbox is turned off, Spectrum ignores exclusions 

Lines Bars  Connected Points
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and treats all data as valid.

Data Pad Functions

As well as calculating and displaying spectra in the Spectrum window, 
you can also log parameters based on calculated spectra to the Data 
Pad. Spectrum Data Pad functions are discussed in the Data Pad 
section of this chapter.

Any changes made in the Spectrum Settings window will affect the 
Spectrum Data Pad functions.
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Sensitivity 
control

Threshold 
control

Signal tracking 
controls (for 
triggering 
Ratemeter and 
so on)

Figure 6–13  
The Computed Input 
dialog box — click OK 
to apply the changes to 
the channel in the Chart 
window.
Computed Input
Often some computation based on raw signal data may be of more 
use, or may be required in addition to the original signal. For example, 
if you have an oscillating signal it may be of use to show a trace of the 
period or frequency of the oscillations, or you may want an RMS 
calculation of a vibration signal, or to plot the differential (rate of 
change of the signal. Chart has a number of powerful computed input 
functions that allow the online processing of raw signals. 
The Computed Input dialog box (Figure 6–13) lets you process signals 
as they are recorded, converting the raw data from any e-corder input 
into computed data. Both raw and computed data are displayed there, 
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for optimal settings adjustment. The dialog box appears if you choose 
Channel Function pop-up > Computed Input… for a channel, or click 
the Computed Input column in the Channel Settings dialog box. The 
channel is indicated in the dialog box title. To set up many channels 
quickly, click the arrows by the dialog box title, or press the right or left 
arrow keys on the keyboard, to move to the dialog boxes for adjacent 
channels. This skips channels that are turned off. Click OK to close the 
dialog box afterwards. 

Choose a computed function hereChoose the raw data input here after a 
computed function has been chosen
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▼ Refer
Channel Settings,  p. 81
The Computed Input… command from a Channel Function pop-up menu 
is ticked if the channel has computed input applied. You can easily 
check all the channels at once to see the computed function applied, if 
any, by looking in the Computed Input column of the Channel Settings 
dialog box. 

The Computed Input dialog box has two main areas: the left side shows 
the signal display for the raw data (similar to that in the Input Amplifier 
dialog box), and the right shows the signal display for the computed 
data. Initially the right display is gray, and few controls appear; if 
something other than Raw Data is chosen from the Computed Function 
pop-up menu, then computed input is active, the computed signal is 
shown in the right signal display area, and more controls are available. 
Different functions may have different controls. 

Sampling Rates

You might have to reduce the sampling rate or turn off channels to 
sample when using computed inputs, since they can use a lot of the 
e-corder’s processing power. Chart will give an alert if the sampling 
rate is too high for your setup. All computations are done on raw data 
taken at 2000 samples per second or higher in the e-corder and then 
processed to give derived values at the sampling rate set in Chart (this 
means that if you choose a sampling rate of 2000 /s or slower, 
computations use raw data sampled at 2000 /s, and if you choose a 
sampling rate above 2000 /s, computations use raw data sampled at 
the set rate). The sampling rate you can set is limited by the number 
and type of computed inputs chosen (since different functions use 
different amounts of processing power), as well as the computer and 
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the connection. 

Signal Displays

The raw and computed data are displayed so that you can see the 
effect of changing the settings. No data are actually recorded when 
setting up computed input, although stimuli can be generated while the 
dialog box is open (so that Stimulator output waveforms can be 
observed). The current signal value is displayed at the top left of each 
display area. Slowly changing waveforms will be represented quite 
accurately, whereas quickly changing signals will be displayed as a 
solid dark area showing only the envelope (shape) of the signal formed 
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Figure 6–14  
The computed data 
display area with an 
integral function selected.
by the minimum and maximum recorded values. You can shift and 
stretch the vertical Amplitude axis of each signal display to make the 
best use of the available display areas. Apart from being at the right, 
each is the same as the Amplitude axis in the Chart window, and the 
controls function identically. 

Raw Data Controls

By default, Chart channels record the raw data for the corresponding 
e-corder inputs. When first turned on, higher-numbered channels with 
no matching physical inputs record the Ratemeter computed function 
based on the raw data of e-corder Input 1. 

The Raw Data Input pop-up menu lets you choose any e-corder input as 
the source signal upon which computations are performed. This means 
that raw data from any e-corder input can be processed and the 
computed results displayed on any channel. You can show raw data on 
one channel and computed data on another, to compare them, or use 
several channels to show various computations based on raw data from 
the same input. It is even possible to show the raw data from one input 
on the channel corresponding to another input, although this could be 
unnecessarily confusing in practice. Note that whenever you record 
computed data in a channel, you replace any raw data that would 
otherwise have been recorded there, so any original signal in that 
channel would be unavailable for further analysis. 

Clicking the Input Amplifier… button opens the Input Amplifier dialog 
box, allowing convenient access to filtering options, the display offset, 
and so on for the raw data signal. The Range pop-up menu lets you 
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select the range of the input to get the best signal response. Changing 
the range in this dialog box is equivalent in all respects to changing it 
in the Chart window: the pop-up menu is duplicated here for 
convenience. 

The Threshold and Sensitivity and the Baseline Tracking controls are 
available when one of the cyclic rate functions (Ratemeter, Period, 
Frequency, and Counter) or cyclic amplitude functions (Cyclic Mean, 
1/3Max+2/3Min, Cyclic Minimum, Cyclic Maximum and Cyclic 
Height) is selected.
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Threshold control

Sensitivity control

Figure 6–15  
Using the Sensitivity 
control to stop noise 
triggering the computed 
input.
Threshold and Sensitivity

The Threshold control sets the minimum level at which the signal will 
trigger the computed input for a cyclic rate or cyclic amplitude function. 
The incoming signal must cross through the threshold level in order to 
register an event. The Sensitivity (or hysteresis) control allows you to 
adjust how sensitive the trigger is to small signal fluctuations. 

The Threshold control is initially set to zero: if the signal has a lot of 
noise in this region, it is best to move the trigger away from zero. You 
can drag the Threshold control up or down to change its settings — a 
gray box and line appear, to indicate where it will go. When the box 
and line are in the desired position, release the mouse button to apply 
the new settings. The Sensitivity control is automatically moved with the 
Threshold control. It can itself be dragged up to adjust the sensitivity 
bandwidth symmetrically above and below the threshold level — 
again, a gray box and line appear. When the box and line are in the 
desired position, release the mouse button to apply the new settings. A 
highlighted area indicates the hysteresis region. For a signal to trigger 
the computed input function, it must go above the highlighted area and 
cross back through it: a signal remaining within the region will not 
trigger the computed function. 

Once the incoming signal is stabilized for cyclic rate and cyclic 
amplitude functions, a threshold and hysteresis should be defined. 
Because the signal is periodic for functions where this applies, it doesn’t 
matter in many cases where the threshold is, because it will occur in the 
same place in each cycle. It is best to move the threshold if there is a lot 
of noise around zero, though, or if the repeating waveform has multiple 
peaks. 
Chart Software

Valid trigger pulse

Hysteresis region

Noise
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Figure 6–16  
Applying a sudden 
change to the input 

Figure 6–17  
A square wave (left) 
distorted at fast tracking 
speeds (right).
Baseline Tracking

Baseline tracking is used to remove any constant or slowly changing 
signal from the raw data before computed function triggering occurs. In 
effect, it acts as a variable-frequency high-pass filter, ensuring that the 
threshold and sensitivity settings follow the waveform. It works by 
applying a suitable averaging technique to the raw data and 
subtracting the result to modify the signal. The amount of averaging 
depends on the position of the Baseline Tracking slider (Slow gives a 
little, Fast gives a lot). Modified data are shown in the data display. 

Figure 6–16 shows the differences at slow and fast tracking speeds 
when applying a sudden change to the input signal. The signal is 
outside the trigger band for much longer with a slow tracking setting. 
When using faster baseline tracking settings, the shape of the signal 
may become distorted, but because data are only being used for 
triggering when baseline tracking is available, the distortion does not 
affect calculation accuracy. Figure 6–17 shows the distortion of a 
square wave with a fast tracking setting. 

Data limit 
area

Slow tracking Fast tracking

Data limit 
area
signal at slow and fast 
tracking speeds.
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The gray data limit area that can appear at the top and bottom of the 
data display area indicates the full scale of the e-corder input at the 
current range setting. If the gray area moves down and meets the 
signal, the input amplifier is overloaded (this is the same as having the 
signal go off scale in the Input Amplifier dialog box). If this occurs, 
select a higher input range value. In general, the baseline tracking rate 
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Figure 6–18  
The Computed Function 
pop-up menu.
should be set as fast as is possible without decreasing the reliability of 
triggering. Baseline tracking also has an Off setting, so it can be turned 
off. This is useful where tracking the waveform could be 
counterproductive: say, when recording a digital pulse. 

Computed Input Controls

The Computed Function pop-up menu gives the range of available 
functions. Raw Data means the sampled data with no computed 
function applied, and is the default setting. The other functions are in 
related groups: cyclic rate (Ratemeter, Period, Frequency and Counter); 
cyclic amplitude (Cyclic Mean, 1/3Max+2/3Min, Cyclic Min, Cyclic 
Max and Cyclic Height); absolute value (Abs Smoothed and RMS 
smoothed); envelope (Envelope Min and Envelope Max); and calculus 
(Differential and the five forms of Integral: normal Integral (∫), ∫ 
Absolute Value, ∫ Positive Only, ∫ Negative Only, and ∫ Reset Each 
Cycle). The functions are discussed in detail below. 

The Units and Range controls are available when one of the cyclic rate 
or calculus functions is selected, and the Average control is available 
when Ratemeter, Period, or Differential is selected. The Time controls 
are available when one of the integral functions is selected, with the 
exception of ∫ Reset Each Cycle, and the Reset control is available for 
all of the integral functions.

Clicking the Units… button opens the Units Conversion dialog box, 
letting you change the given units for the computed channel to the units 
of your choice. The waveform in the right data display area is 
transferred to the data display area of the Units Conversion dialog box, 
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if you do this. The conversion will only apply to subsequently recorded 
signals, so it is more limited than choosing units conversion directly, 
since you cannot convert individual blocks of data. Units conversion is 
performed on the computed data, not the raw data.

The Range pop-up menu lets you select the range for the computed 
signal to get the best display. This range applies only to the computed 
signal, and is independent of the range for the raw data signal from the 
e-corder input. The Range pop-up menu for a channel in the Chart 
window duplicates this one when the computed function is applied to 
the channel, and the range can be changed in either place. 
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The Average control allows smoothing of the data when you want to 
see a trend in a Ratemeter or Period waveform rather than sample-by-
sample changes. Click the up or down arrows to increase or decrease 
the averaging: the sequence is 1, 2, 4, 8, with 1 being no averaging. 
The Average control is also available for the Differential computed 
function, with the sequence reaching 64. The control works by 
averaging the values of the specified number of preceding samples, 
and so may give rise to a slight phase shift in the waveform, especially 
with the Differential function. If you need to know exact times, you 
should record the raw data separately as well.

The Time controls let you choose how an integral function resets to 
zero. For periodic waves, resetting corrects for cumulative errors, such 
as those due to DC offset. If No Reset is chosen in the pop-up menu, the 
text box is dimmed and inactive; otherwise you can enter a value of up 
to 3600 seconds for Timed Reset or 65 seconds for Time Const, in 
increments of the sampling interval (0.1 seconds if you sample at 10 
samples per second, say). Timed Reset resets the signal to zero after 
each multiple of the entered time. Time Const introduces an exponential 
decay, so that (given a zero input signal) the integral drops to 37% of 
its initial value over the set time. 

The Reset button resets the signal in the computed input data display 
area to zero when clicked. It is only used for convenient zeroing of the 
display signal while in the dialog box. 

Computed Input Functions

Ratemeter
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Frequency, or rate, is how often a given event occurs within a certain 
time. The Ratemeter function measures lower-frequency periodic signals 
and gives the output in reciprocal minutes (BPM, beats per minute) up 
to 2000 BPM. The Ratemeter function first calculates the waveform 
period (see below) and then takes its reciprocal and scales it 
appropriately. 

Since the period is the difference between valid triggering signals, if 
triggering is lost, then the period will get larger. In this case, the period 
is constantly updated to show that it is currently at least a certain 
length. The computed signal thereupon falls exponentially (since it is 
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computed input.

Figure 6–21  
Period: left, raw data 
(showing two threshold 
settings, either setting 
would work well); right, 
computed period signal.

pulses; right, the 
computed ratemeter 
signal in BPM.
Period Period The Period shows the period variations clearly 
Figure 6–19  
Ratemeter: left, the raw 
data showing periodic 
Figure 6–20  
Loss of Ratemeter 
triggering signal: left, 
raw data; right, 
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based on the reciprocal of the period), which gives an indication that 
triggering has been lost: if just a straight line were presented, 
continuing to show the last valid rate, it might be assumed incorrectly 
that things were still all right. 

Period

A period is the time taken to complete one cycle of a regularly 
recurring waveform. The Period computed function is basically the 
Ratemeter without the reciprocal, and gives information about the 
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Figure 6–22  
Frequency: left, the 
gradual change used by 
Chart, right, if summation 
were coarser.
periodic behavior of a waveform. Note that the measurement is 
independent of where the trigger point is in the cycle. 

The period is the difference between valid triggering signals, so if 
triggering is lost, then the period will get larger. In this case, the period 
is constantly updated to show that it is currently at least a certain 
length, and will increase until the maximum period for the set range is 
reached. Period can be more a useful measure than frequency for 
waveforms with very slow cycles, such as waves in water or tremors in 
earth. 

Frequency

Frequency is how often a given event occurs within a certain time. The 
Frequency function measures the frequency of the waveform in hertz 
(cycles per second) up to 2000 Hz, and is suitable for measuring 
periodic signals of higher frequency than those for which the Ratemeter 
is used. The calculation is done differently to that for the Ratemeter, to 
ensure accuracy. The Frequency function works by breaking each 
second into 20 ‘bins’. Each time the threshold is crossed from lower to 
higher, the count in the current bin is increased by one. (That is, it 
counts the number of times the signal crosses the threshold in one 
direction every 0.05 s.)

Chart shows the sum from the last 20 bins. This gives a faster and 
smoother result than if summing were just done for one second. For 
example, if recording a 100 Hz signal that changed to 200 Hz over 
one second, you would see the frequency gradually changing from 100 
to 200 Hz. If results were summed over one second, you would just see 
a jump from 100 to 200 Hz, with an intermediate value (the average 
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of the two signals). 

1 second 1 second

Change from 100 to 200 Hz Change from 100 to 200 Hz



162

Figure 6–23  
Cyclic Mean: summed 
area for different 
thresholds (shown 
shaded).
Counter

The Counter function just counts transitions from below to above the 
threshold, displaying up to 20 000 registered events versus time. It 
wraps back to zero when it gets to the maximum number of counts in 
the current range. If you set the range to 200, for example, then after 
the count reaches 199, the waveform will reset, so that the next, 200th, 
count will be 0 again. This lets you quickly get a total count over a time 
by looking at the number of resets, plus the last number shown for the 
count. This function has a number of useful purposes, for instance 
tallying the radiation blips registered by a Geiger counter. 

Cyclic Mean

A cyclic mean is the average amplitude of a waveform over a cycle. 
Variations indicate some form of asymmetry. The Cyclic Mean function 
sums the values of the data points between two successive threshold 
transitions and divides by the number of points summed. Note that this 
calculation is only useful for truly cyclic (oscillating) signals, it should 
not be used to try to determine the mean of a noisy signal. The 
threshold controls where the summation starts and ends, but because 
the input is a cyclic wave, the result should not depend on threshold 
position. Only when the waveform has some other periodic signal 
superimposed on it does the actual threshold affect accuracy of 
calculation. The results you get from the cyclic mean are the same as if 
you selected an exact period of the raw data, integrated that selection, 
and divided the integral by the period. 

Note that in Figure 6–23, summing starts and ends at different times 
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when the threshold is in different places, but the results are the same. It 
would be much better in this case to leave the threshold in the center of 
the waveform, because it will still work even if the amplitude of the 
signal changes slightly. In the right-hand example, if the amplitude were 
much smaller, the triggering would be lost.
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Figure 6–24  
Cyclic Max: the largest 
value obtained by the 
waveform in the previous 
cycle is retained.
1/3Max+2/3Min

The 1/3Max+2/3Min function adds, for each cycle, one third of the 
maximum amplitude of the waveform to two thirds of the minimum, to 
give an approximate mean and is included for historical purposes. A 
more accurate mean is obtained using the Cyclic Mean computed 
function.

Cyclic Max, Min, and Height

In the Cyclic Max function, the trigger threshold identifies cycles. At the 
end of a cycle, the maximum data point found within that cycle is 
shown until another cycle has been measured. The Cyclic Min function 
works similarly, save that the minimum value of a cycle is found, and 
displayed during the next cycle. The Cyclic Height function determines 
the maximum minus the minimum value. These functions are useful for 
showing the cycle-by-cycle minima or maxima or the difference 
between the two. 

perio

Maximum from previous cycle
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Abs and RMS Smoothed

Abs Smoothed smooths using the absolute values of the preceding data 
points over the time set in the Smooth pop-up menu. RMS Smoothed 
(root-mean-square) smooths using the square root of the average of the 
squared values of the preceding data points over the time set in the 
Smooth pop-up menu. (In each case, the data points are sampled at 
2000 samples per second or faster.) These two functions provide 
similar ways of getting the same thing, a modified moving average, set 
by time, not by number of samples, and ignoring whether peaks are 
positive or negative (that is, regardless of whether the waveforms are 
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Figure 6–25  
Envelope Max: sample 
times are independent of 
the waveform period — 
note that the raw 
sampled data, shown as 
open circles, could be 
quite misleading in this 
case.
biphasic). They are useful in electromyography and studies of 
spontaneous neural activity, to provide an indication of the average 
amount of activity. 

Envelope Max and Min

Envelope Max finds the maximum value of the data points over the time 
between samples at the sampling rate set by the user, and displays it 
during the next time period. Remember that the e-corder always 
samples data for computed input at least 2000 samples per second, 
even if the apparent rate is much less. If you set a sampling rate of one 
sample per second in Chart, then the maximum value of the samples in 
the previous second would be shown each second in the display. 
Information is not required about cycles or periods in the incoming 
data, so the triggering controls don’t appear. 

The Envelope Min function works similarly except that the minimum 

Time between samples

Maximum from time between previous e-corder samples

sample times
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value over a time is found, and displayed during the next time period. 
These functions are useful if the specifics of the signal are of no interest, 
but the maxima or minima are important, since they let you record at a 
much lower sampling rate than would otherwise be the case. As you 
can see from Figure 6–25, you would need to record at a far higher 
rate to get an accurate depiction of the waveform. These functions 
could be used, for instance, to record the maximum and minimum 
amplitudes of a oscillating signal: no additional information is gained 
by sampling these more than once per oscillation.
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Figure 6–27  
Integral: the integral of a 
square wave (left) is 
simply a triangular wave 
(right).

Figure 6–26  
Differential: the 
derivative of a triangular 
wave (left) is simply a 
Differential

The Differential function gives the first derivative with respect to time of 
a selected channel’s waveform. It is useful when the slope, or rate of 
change, of a signal is more informative than the raw signal itself. For 
example, the volume of fluid in a container could be weighed as it is 
collected, using a force transducer. The differential of this plot would 
give the rate of change of volume, that is, the flow rate. 

This function is particularly sensitive to noise, so the data smoothing 
provided by the Average control has been extended beyond that 
offered for Ratemeter or Period functions, with your choice of 1, 2, 4, 
8, 16, 32 or 64 preceding samples being averaged. (Note that this 
may give rise to a slight phase shift in the waveform.)

Integral

The Integral measures the area under a waveform, calculated as the 
sum of the data points multiplied by the sample interval. You could 
integrate the signal from an instrument that measures flow rate to 
calculate volume, for instance. 
square wave (right).
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Five types of integral function are available, each useful for a different 
purpose.

∫ (Integral). This, the normal integral, is simply calculated as the sum of 
the data points multiplied by the sample interval. The integral over time 
of a signal with equal positive and negative summed values would be 
zero. 
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Figure 6–28  
A steady offset, and its 
integral, using two forms 
of resetting.
∫ Absolute Value is calculated as the sum of the absolute values of the 
data points multiplied by the sample interval. The integral over time of a 
signal with equal positive and negative summed values would be 
double the summed values of either. 

∫ Positive Only is calculated as the sum of the positive values of the 
data points multiplied by the sample interval. The integral over time of a 
signal with positive and negative data points would only include the 
summed values of the positive data points.

∫ Negative Only is calculated as the sum of the negative values of the 
data points multiplied by the sample interval. The integral over time of a 
signal with positive and negative data points would only include the 
summed values of the negative data points.

∫ Reset Each Cycle, like the normal integral, is calculated as the sum of 
the data points multiplied by the sample interval. The integral over time 
of a signal with equal positive and negative summed values would be 
zero. This function also, however, resets the integral to zero every time 
the original waveform passes from below to above zero, so it is 
particularly useful for periodic waveforms subject to drift (with an 
uncontrolled offset voltage). 

Resetting helps to compensate for drift that might otherwise take an 
integrated signal off the scale. All integrals reset to zero when they 
reach the positive or negative limits set by the Range control. The 
∫ Reset Each Cycle resets the integral each time the original waveform 
passes through zero from below; other forms of integral reset the 
integral as specified in the Time controls. The reset effectively subtracts 
the range whenever the range is exceeded, so you can count the 
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number of resets to get the total value.

Integral with time constant

Integral with timed reset

Raw signal
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▼ Refer
Channel Settings,  p. 81
Times entered in the text entry box smaller than the sampling interval 
may round down to zero, in which case no resets occur. Values should 
be longer than the interval over which integration is desired, in any 
case. ∫ Timed Reset resets the signal to zero after each multiple of the 
entered time. This method copes with drift, and computes an accurate 
integral before the reset. ∫ Time Const introduces an exponential decay, 
so that (given a zero input signal) the integral drops to 37% of its initial 
value over the set time (up to 65 seconds). This avoids drift and sudden 
resets, but the resultant integral will be inaccurate: this inaccuracy 
increases as the time constant gets smaller.

       

Channel Calculations
The options in the lower half of a Channel Function pop-up menu allow 
you to apply calculations to channels of recorded data. No Calculation 
is the default setting, and means the displayed data in the channel are 
recorded data (either raw data or computed data) with no extra 
calculation applied. The Smoothing, Arithmetic, Cycle Variables, 
Differential and Integral calculations are built into Chart, and are 
described here. Other channel calculations may be added with Chart 
extensions. Channel calculations may be online (you see the results as 
you sample) or offline (you see the results of the calculation only after 
sampling finishes).

To turn on a channel calculation, choose its menu command from a 
Channel Function pop-up menu. To revert to the data recorded in a 
channel (if any) choose No Calculation. A tick beside the option shows 
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which is active: only one can be at any time. Calculations apply to the 
entire length of the channel, and operate on the displayed data of the 
source channel (Arithmetic can also operate on underlying recorded 
data). You can turn off a channel calculation without losing the values 
you enter in its dialog box. You can easily set up many calculations at 
once, or check all channels at once to see if any calculations are 
applied, by using the Calculation column of the Channel Settings dialog 
box. 

If a channel calculation is applied to a channel, an = sign appears in 
the Channel Status indicator (the diamond at the right of the channel’s 
Range/Amplitude display). Clicking the indicator pops up a list 
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▼ Refer
Comments and 
Exclusions,  p. 117
showing the sampling rate, range, what is to be recorded (raw data or 
a computed function, and from which input), and any active channel 
calculation. 

Common to most channel calculation dialog boxes is a source pop-up 
menu, which lets you choose the waveform in any Chart channel as the 
source to be processed. You may want to use one channel to display 
the source signal, and another to display the calculation, for 
comparison between the two. To display only the calculated signal, you 
would choose the same channel for the source as for the display.

The calculation for a channel calculation is generally done when its 
dialog box is closed. Quite often, you might want to adjust some 
settings (such as the degree of smoothing) repeatedly and observe the 
effect on a waveform. This requires bringing up the dialog box each 
time you do it, so a keyboard shortcut has been provided to ease the 
process and avoid the stress of a long trip to the pop-up menu. The 
latest calculation to be applied in the Chart window (Smoothing in 
Channel 4, say) gains a keyboard shortcut, Command-=, which 
appears beside it in its Channel Function pop-up menu: just type 
Command-= to recall the dialog box. If No Calculation is chosen, no 
keyboard equivalent appears, and any existing one is dispelled.

Channel Calculations and Exclusions

Exclusions are a special type of comment that mark data to be excluded 
from searches and analysis. All the channel calculations built into Chart 
(Smoothing, Arithmetic, Cycle Variables, Differential and Integral) do 
not recognize exclusions, and make the same calculation whether or 
not they are present. Channel calculations added by Chart extensions 
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vary in their handling of exclusions: check their accompanying 
documentation for details.

Channel Calculations and Computed Functions

There is some overlap between computed functions and channel 
calculations: which is best in a situation depends on the data and what 
you want to do with them. Computed functions must be chosen before 
sampling is started, and can apply to individual blocks of data. 
Channel calculations can be turned on or off as required, and always 
apply to the entire length of the channel in which they are active. They 
can be applied before, during, or after sampling, and can be used to 
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Table 6–1  
Comparing computed 
input with channel 
calculations.
analyze data recorded at faster rates than possible using computed 
inputs, which use some of the e-corder’s processing power. Channel 
calculations do not replace the recorded data in a channel, and can be 
used in channels that are turned off. They are useful when you need to 
retain the raw data as well as manipulate it in some way, and don’t 
have enough channels to do everything at once. Some calculations 
work online and offline, but the more complex ones tend to be offline 
only, so you can’t see results as you sample. Computed functions are 
always online, so that you can see results as you record. 

In addition to differences in the way computed inputs and channel 
calculations are used, there may also be differences in the accuracy 
and precision of the results of corresponding computed functions and 
channel calculations, such as integral and rate computations. Details 
are given in Appendix C, but the following general rules apply:

• When computations rely on a window of points, channel 

Feature Computed Input Channel Calculation
Results visible during 
sampling

Yes Simpler ones, yes; 
others, no

Raw data retained Only if recorded on 
another channel

Yes

Can be applied after 
sampling

No Yes

Channel can be off No Yes
Can record at the 
highest sampling 
rates

No Yes
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calculations have a greater accuracy than the corresponding 
computed input functions; otherwise accuracy will be the same.

• If the sampling rate is < 2000 Hz, computed input functions have a 
greater precision than the corresponding channel calculations; 
otherwise precision will be the same.

Hidden Data

If a channel contains recorded data and channel calculations for that 
channel are turned on, its displayed data will be the calculated data. 
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The recorded data (either raw data or computed data) still remain 
underneath, and can be seen simply by turning the calculation off. 

If the display in a channel uses calculated data from other channels, a 
warning icon flashes in the channel control area to the right of the 
Range/Amplitude display, on top of the Channel Status indicator. This 
is a reminder that what you see in the channel is not necessarily what 
you are recording on that channel. If you click the icon, an alert box 
tells you the area of concern (in this case, that the channel has recorded 
data hidden by calculated data from other channels). If the calculation 
for a channel manipulates any data from the channel (even if data from 
other channels are included), then there is no warning icon or alert, 
since the data must bear some direct connection to the recorded data. 
The icon and an appropriate alert may appear at other times, such as 
when a calculation in a file was set with a Chart extension no longer 
present.

Channel calculations normally work on the displayed data in a 
channel, so you can use them in sequence. For instance, you could 
smooth a waveform in one channel using the Smoothing calculation 
and then show the log of that smoothed waveform in another using the 
Arithmetic calculation. Some calculations, such as Arithmetic, let you 
choose to work on the underlying recorded data of a channel as an 
alternative to the displayed data.

Applying Calculations Permanently

Channel calculations are usually temporary, and can be created and 
discarded at will. You can, however, apply a channel calculation 
permanently to a channel, so that the calculated data become the 
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recorded data for the channel. Beware! This replaces any recorded 
data already in the channel. Once gone, such original data cannot be 
retrieved, so an alert box will ask you to confirm your decision. When 
applying calculations like this, it is a good idea to use channels with no 
recorded data in them or to work with a copy of the original file. 

To apply a calculation to a channel, hold down the Command key 
while opening the channel’s Channel Function pop-up menu, and 
choose the Apply Calculation… menu command that replaces the No 
Calculation menu command: the calculation is applied, subject to 
confirmation through the alert box. The calculated values effectively 
then become the recorded data. If no channel calculation is active in 
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The Smoothing dialog 
box.

Figure 6–30  
The effects of smoothing 
on a waveform.
the channel, the Apply Calculation… menu command will be dimmed 
and unavailable.

Smoothing

The Smoothing calculation lets you remove unwanted high frequencies, 
noise, or clutter from a waveform. Smoothing always operates on the 
displayed data of the source channel. This in turn may have been 
calculated by another channel calculation (such as Arithmetic). The 
Smoothing channel calculation is offline, so you can see the smoothed 
data only when Chart is not sampling (during sampling, you see any 
recorded data). 

Choosing the Smoothing… command from a Channel Function pop-up 
menu opens the Smoothing dialog box for that channel. 

Increasing the width of the averaging increases the 
number of points used to smooth the waveform

Any channel’s data can be chosen to be smoothed

Original waveform 
with no smoothing 
Figure 6–29  
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Smoothing 
width of 3

Smoothing 
width of 5

Smoothing 
width of 9
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Expression 
text entry 
box

Select a 
channel

Set the scale
automaticall

Set the 
Amplitude axis 
scale manually

Figure 6–31  
The Arithmetic dialog box 
— click OK to show the 
function in the display 
channel in the Chart 
window.
By default, the channel in the dialog box title is chosen in the Source 
channel pop-up menu, but you can choose any channel as the source 
signal to be processed. If you want to display both the smoothed and 
the recorded data, to compare them, you could apply the function to an 
unused channel, leaving the source recorded data channel intact.

Smoothing works by taking a certain width of data, the sample point 
and an equal number of points on either side, weighting the points 
suitably, and averaging them to give the smoothed value for the sample 
point. The points are weighted using a triangular (Bartlett) window, so 
that the central point affects the result more strongly, with points further 
out affecting the result less and less. (For 3-point smoothing, the central 

point would be weighted by 1/2, and the two points beside it by 1/4; 
for 5-point smoothing, the central point would be weighted by 1/3, the 
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two points beside it by 2/9, and the two outlying points by 1/9; and 
so on.) This is a modified moving average that avoids phase shift, and 
doesn’t smooth or smear the waveform as much as simply averaging 
together a number of points. 

The width is always an odd number. Click the up and down arrows to 
increment or decrement the number, or type in the number of points, 
from 3 to 201, in the text entry box. At the start and end of the 
waveform, fewer points can be taken on one side, so the number of 
points used in the average decreases at the extremes. 

Select a 
function

Enter units for the calculated channel 
y
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Smoothing affects different waveforms in different ways: quickly 
changing waveforms cannot be smoothed too much without distortion, 
but those that change slowly can be smoothed a lot more.

Arithmetic

The Arithmetic calculation allows you to arithmetically combine 
waveform data from different channels. It works online (during 
recording) as well as offline. Choosing the Arithmetic… command from 
a Channel Function pop-up menu opens the Arithmetic dialog box. The 
channel from which the command is chosen, and in which results will 
be displayed, is indicated in the dialog box title.

Entering an Expression

To enter an expression, click in the expression text entry box and type, 
or click the various buttons and choose channels and functions from the 
pop-up menus. For channel data, type ‘Channel1’ or ‘Ch1’ and so on 
(case is unimportant, but no spaces should be used), or choose a 
channel from the Channel pop-up menu. For functions, choose a 
function from the Function pop-up menu, or type the text of the function 
as it appears there (case is unimportant). Any combination of channels, 
functions, and operations can be entered. The normal order of 
operations applies, and brackets should be used as appropriate: 
4*9+6 gives 42; 4*(9+6) gives 60. If you enter a simple arithmetic 
operation (say, 4*9+6) without references to channel data or time, you 
will get a straight line in the channel logging the result. 

By default, Arithmetic operates on the displayed data of the channels 
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you specify. The data in these channels may be calculated by other 
channel calculations (for instance, smoothing may have been applied). 
You can choose to work on the recorded data of an input channel, 
ignoring any other calculations that may be active, by typing ‘R’ before 
the channel expression (‘RChannel1’ or ‘RCh1’), or choosing a channel 
from the Recorded Data submenu in the Channel pop-up menu. The 
recorded data is the signal that comes from the e-corder to Chart before 
any channel calculations are applied, and can be either raw data or 
computed data. 
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Checking the Expression Syntax

When you click OK, Arithmetic checks to see if it can understand the 
expression. If it cannot, an error message will be displayed. Possible 
causes of problems are missing brackets or having nothing at all 
entered. Also, note that most functions that includes brackets, such as 
Abs(), require an argument (that is, something to operate on) within the 
brackets.

Math Functions

Basic mathematics functions (+ add, – subtract, * multiply, / divide) can 
be entered by typing, using the buttons, or choosing from the Math 
submenu of the Functions pop-up menu. 

Trigonometric Functions

Trigonometric functions can be chosen from the Trig submenu of the 
Functions pop-up menu. Sin(), Cos(), and Tan() return the sine, cosine, 
and tangent. These functions expect an argument in radians. 

ASin(), ACos(), and ATan() return the arc sine, arc cosine, and arc 
tangent, that is, the angle whose sine, cosine, or tangent is equal to the 
given value. These functions are the inverse functions of sine, cosine, 
and tangent. The result is expressed in radians. ASin() and ACos() need 
arguments from 1 to –1 inclusive (since sine and cosine produce no 
values outside those limits), so you may need to scale data to fit. 

DegToRad() converts degrees to radians, and RadToDeg() converts 
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radians to degrees (2π radians is equal to 360 degrees).

Logarithmic Functions

Logarithmic functions can be chosen from the Logs submenu of the 
Functions pop-up menu. Log10() returns the base 10 logarithm of a 
number. Ln() returns the natural, base-e, logarithm of a number. The 
constant e equals approximately 2.7182818. Exp() returns the 
exponential of a number, that is, ex (e raised to the power of the 
argument). The exponential is the inverse function of the natural 
logarithm.
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Noise Functions

Random() returns random numbers from a uniform distribution between 
–1.0 and 1.0 inclusive. Gaussian() returns random numbers from a 
normal distribution with a mean of 0.0 and a variance of 1.0. 

Other Functions

The function Sign() returns the sign of a number, that is, Sign(x) = 1 if x 
≥ 0, –1 if x < 0. Abs() returns the absolute value of a number, that is, 
negative numbers are made positive. Sqrt() returns the square root of a 
number (the square root of a negative number returns zero).

Pi returns the constant π, approximately 3.1415927, when used in an 
expression. SampleTime returns the time in decimal seconds from the 
start of the data block. 

Round() rounds a number to the nearest whole number (0.5 rounds up). 
Int() returns the integer part of a number, truncating any fractional part, 
regardless of sign. For instance, Int(2.999) will return 2. 

Units and Scaling

If units conversion is applied in a channel used in an expression, 
Arithmetic ignores the units and just uses the displayed values in that 
channel for its calculations. Note, though, that the linear scaling 
performed by units conversion may affect numeric values. For this 
reason, you will be alerted if a channel used in an expression has 
different units in different blocks. Units conversion does not work in a 
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channel where the Arithmetic calculation is active. So that units can be 
provided for a calculated channel where you want them, the Unit 
Name text entry box lets you type in up to 10 characters for a unit 
name. As with normal units, superscripts and subscripts can be used.

By default, the Auto Scale checkbox is selected, which causes 
Arithmetic to estimate the most appropriate scale for the channel (when 
there is data to base a scale on). If channel data and operations are 
unusual and the checkbox is deselected, a scale can be assigned 
manually. 
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You can type in directly the lower and upper limits of the scale to be 
displayed, in the Top and Bottom text entry boxes. (This deselects the 
Auto Scale checkbox.) This option allows you to adjust the Amplitude 
axis directly to display a desired range of values, just as you can with 
the Set Scale dialog box, available from the Chart window. The scale 
will affect the accuracy (in significant figures) of the displayed numbers. 

Channel calculations in Chart use single-precision floating point 
arithmetic, so results are accurate to six decimal places. The number of 
decimal places set in the dialog box, from 0 to 6, affects only the 
display, not the internal accuracy of the calculation. 

Using Unconverted Voltages

Data in volts, millivolts, or microvolts (with no units conversion applied), 
are all dealt with by the Arithmetic calculation as volts. This means care 
must be taken when using lower ranges, and when dealing with data 
recorded at ranges with different orders of magnitude. Depending on 
the data and the operations performed, the numbers calculated may be 
very large or very small. They can be adjusted to be easier to use by 
using a scaling factor in the expression.

If you recorded signals on the 10 mV range, for example, and used 
Arithmetic to add a two such channels together, the results would be 
expressed in volts, not in mV. To get a derived value in mV, you need 
both to type ‘mV’ into the Unit Name text entry box, and to bracket the 
sum of the channels and multiply it by 1000: (Ch1+Ch2)*1000. This 
scales the expression correctly. 

In general, you have to work out what you want the results displayed in 
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and apply an appropriate scaling factor to the expression: 1000 if the 
data are to be in mV or 1 000 000 if the data are to be in µV. As 
always, it is important to be sure about what you are looking at and 
calculating.

Cycle Variables

Cycle Variables is a calculation for analyzing periodic waveforms. 
Since it works offline, it can be used after recording, for analysis of 
data recorded at faster sampling rates than is possible using cyclic rate 
and cyclic amplitude computed input functions. 
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Select the 
source 
channel

Signal display 
area

Duration of 
displayed 
waveform

Figure 6–32  
The Cycle Variables 
dialog box — click OK to 
apply the chosen function 
to the display channel in 
the Chart window.

▼ Refer
Computed Input 
Functions,  p. 159
Choosing the Cycle Variables… command from a Channel Function 
pop-up menu opens the Cycle Variables dialog box. The results will be 
displayed in the channel indicated in the title bar.

Setting Up Cycle Variables

The signal display area in the dialog box shows the waveform for the 
source channel. If a selection has been made in the Chart window, 
data are shown over the approximate recording period of that selection 
(starting from the left edge of the selection, and using only the data in 

the left-most block of a selection containing two or more blocks). If there 
are too many trigger points in the selection, Cycle Variables limits the 
display to show a sensible number. The duration of the displayed 
waveform is shown in the bottom left of the signal display area. If there 
is no selection, the data visible in the Chart window (or the largest 
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visible block if two or more blocks are visible) are shown. This 
displayed waveform is used to set detection parameters, such as noise 
threshold. 

Whether the source signal is recorded or displayed data is shown in 
the bottom right of the signal display area. Displayed data are simply 
what is shown in the source channel, whether calculated, raw, or 

Choose the function to 
be calculated here

Display channel

Trigger 
points

Type of source 
data, recorded or 
displayed
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▼ Refer
Find Data,  p. 134
computed. If Cycle Variables has been chosen as a channel calculation 
in the source channel, though, the dialog box will show recorded data 
(raw or computed). This is because the detection parameter settings 
apply to this underlying data and make no sense in relation to the 
calculated waveform.

You can change the initial display by using the controls at the bottom of 
the signal display area. The scroll bar lets you move through data in the 
Chart window if the block used by Cycle Variables is not wholly 
displayed. The box in the scroll bar shows where the display area is in 
relation to the block. Drag the box to move left or right. Click the left or 
right arrows to move left or right by 10% of the visible waveform; click 
in the gray region to either side of the box to move left or right by 90% 
of the visible waveform. View buttons, like those in the Chart window, 
let you compress or expand the data shown. To see more of the source 
waveform, click the left (far mountains) button to compress it. To expand 
the source waveform for a closer view, click the right (near mountains) 
button. Click the Reset button between the two to revert to the initial 
display.

Cycle Detection

Cycle Variables detects cycles by finding local maxima and minima, in 
a similar way to the Find command. Detected trigger points are marked 
on the displayed waveform in the dialog box as small blobs. Whether 
maxima or minima are used depends on which radio button in the 
Trigger panel is chosen. This makes no difference to the method of 
cycle detection, but may make a difference to the results, depending on 
the waveform. (If, for instance, a waveform contains a well-defined 
upwards spike and two similar downwards spikes in each cycle, it 
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would make more sense to trigger on the maximum.)

Detection parameters (noise threshold, triggering, tracking) apply to the 
detection of all cycle variables in the same source channel. In other 
words, Cycle Variables will use the same parameters whenever it bases 
calculations on that source channel. This is handy when you have 
multiple channels showing various cyclic calculations for a single source 
channel, since the detection parameters only need be set up or changed 
once for the whole lot.
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Figure 6–33  
Adjusting tracking and 
noise threshold to detect 
significant peaks in a 
waveform of varying 
amplitude.
Noise Threshold

The Noise Threshold control lets you adjust how sensitive the trigger is 
to small signal fluctuations. The noise threshold for the event is a 
percentage of the range of the channel (the default value is 5%, which 
is 1 V for a ±10 V range). For a data point to be recognized as a 
peak, say, the data points that follow must decrease by at least the 
noise threshold value. Peaks or troughs with smaller amplitudes than 
this value will be ignored. Raise the value to get rid of unwanted small 
peaks (noise and so on); lower it to detect missed peaks. The noise 
threshold percentage can be set by using the text box or the slider bar. 
When the noise threshold is changed, the trigger points, marked on the 
displayed waveform as small blobs, will shift after a short delay, so you 
can see the effect of the change.

Tracking

In the case of a waveform with an amplitude that drifts significantly 
over time, or a low signal-to-noise ratio, the usual triggering scheme 
may run into difficulties. Tracking helps to solve these problems. The 
Tracking pop-up menu in the Trigger panel is normally set to Off. You 
can choose a tracking interval from this pop-up menu to turn tracking 
on. The noise threshold is now taken to mean a percentage of the 
maximum amplitude within the tracking interval rather than a 
percentage of full scale. (The noise threshold usually needs to be 
increased relative to its normal settings when using tracking.) The 
tracking interval is centered on the current data point, and moves along 
as the detection algorithm is applied. This helps deal with changes in 
the overall signal amplitude.
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Even if the tracking interval has been set to less than or equal to the 
sampling interval, it will always be set wide enough to include at least 
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three data points. Changes in amplitude of less than 5% of the current 
data range are not tracked, so the range should be chosen so that data 
are making reasonably good use of it. Note that tracking slows down 
the Cycle Variables calculation a bit. 

Functions

The Function pop-up menu gives the list of cyclic variables that can be 
calculated. There are rate functions (Ratemeter, Period, and Frequency) 
and amplitude functions (Cyclic Height, Cyclic Mean, Cyclic Maximum, 
Cyclic Minimum, and 1/3Max+2/3Min). The functions are similar to 
cyclic rate and cyclic amplitude computed input functions, but may give 
slightly different results, for reasons explained in Appendix C.

The Default Scale pop-up menu lets you select the range of the channel 
to get the best display of the calculated function. This menu is only 
available when one of the rate functions (Ratemeter, Frequency, or 
Period) is chosen in the Function pop-up menu. Changing the range in 
this dialog box is equivalent to changing it in the Chart window. It is 
useful if you know the approximate settings already; you cannot see the 
resultant waveform in the Cycle Variables dialog box as you can in the 
Computed Input dialog box.

Ratemeter. Frequency, or rate, is the number of times that a given event 
occurs within a certain period. The Ratemeter function gives output in 
reciprocal minutes (BPM, beats per minute) up to 2000 BPM (about 
33 Hz). 

Period. A period is the time taken to complete one cycle of a regularly 
recurring waveform. This function determines the period between 
Chart Software

adjacent cycles in a waveform. The period is taken as the time between 
two successive crossings of the threshold from higher to lower. Its 
accuracy will depend on the number of samples taken during that time. 
Period can be more a useful measure than rate or frequency for 
waveforms with very slow cycles.

Frequency. Frequency is the number of times that a given event occurs 
within a certain time. The Frequency function measures the frequency of 
the waveform in hertz (cycles per second) up to 2000 Hz. 

Cyclic Mean. A cyclic mean is the average amplitude of a waveform 
over a cycle. Variations indicate some form of asymmetry. The Cyclic 



Chapter 6 — Data Analysi

Figure 6–34  
Source (top channel) and 
the cyclic mean (bottom) 
calculated from it, for a 
block of data.
Mean function sums the data points between two successive peaks and 
divides by the number of points. This is useful, say, for determining the 
mean displacement of a vibrating object. The results you get from the 
cyclic mean are the same as if you selected an exact period of the 
source, integrated that selection, and then divided by the period. 

1/3Max+2/3Min. The 1/3Max+2/3Min function adds, for each cycle, 
one third of the maximum amplitude of the waveform to two thirds of 
the minimum, to give an approximate weighted mean and is included 
for historical puposes. A more accurate mean can be obtained using 
the Cyclic Mean function.

Cyclic Maximum and Minimum. The Cyclic Maximum function displays 
the maximum value found within a cycle. The Cyclic Minimum function 
works similarly, except that the minimum value of a cycle is shown.

Cyclic Height. The Cyclic Height function calculates the difference 
between the maximum value and the minimum value in a cycle.

Average

Calculations work from 
the first to last cycles in 
each block
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The Average control lets you set the number of cycles, from one to 50, 
over which the chosen cycle variable is averaged. The average is 
calculated over cycles after and including the current one, so if an 
average of four were chosen, the current cycle and the next three cycles 
would be used. By default, the average is set to one. Click the up and 
down arrows to increment or decrement the number, or type a value in 
the text box directly. Averaging smooths fluctuations in the cyclic 
variable, and is especially useful with erratic data. The number set in 
the Average control must be substantially less than the number of cycles 
in the data (perhaps less than half), or the values will not make sense.
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Figure 6–35  
The Save Cycle Variables 
as Text dialog box.
Display in the Chart Window

Once the controls in the Cycle Variables dialog box have been 
adjusted, click OK to apply the calculation to the display channel in the 
Chart window. The calculated variable applies to the whole channel, 
but is calculated and drawn only as blocks become visible (else the 
process would take a long time for very large files). It draws from the 
first detected cycle to the last in a block. Where there is no sensible 
value (such as at the very start and end of a block), the value of the plot 
is set to ‘Out of Range’. 

Saving a Text File

A text file containing any or all of the cyclic variables associated with a 
waveform can be saved to disk. To save the text file, click the Save As 
Text… button in the Cycle Variables dialog box. The Save Cycle 
Variables as Text dialog box appears.

Select the checkboxes in the Include panel to include variables in the 
text file to be produced. Just what part of the data is saved depends on 
the radio button selected in the Save panel. Note that the Selection 
option uses the selection as a guide only: Cycle Variables works from 
the left of the selected data, and may shift to the right to get a whole 
number of cycles. 

The standard text file created can be opened by any application that 
can import text, such as a word processor, spreadsheet, or statistics 
Chart Software
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▼ Refer
The Data Pad,  p. 136
package. The data for each cycle is stored as a row of numbers, 
separated by tabs and ending in a return character. The first number in 
each row is the time at which the cyclic transition was found. The time 
is from the start of the block, and if you select the Always Seconds 
checkbox, it will always be in seconds. The time is followed by one 
result corresponding to each checkbox selected in the Save Cycle 
Variables as Text checkbox. Because there is only one point per cycle 
for the time and derived values, a text file of cycle variables data will 
generally be a lot smaller than a text file of Chart data.

When you click OK, a standard Save As dialog box appears. Type in 
a file name as required and click the Save button to create the cycle 
variables text file.

Data Pad Functions

Cycle Variables adds functions to the Data Pad. These functions are 
similar to those available as channel calculations, and are based on the 
same cycle detection settings. Cycle Variables Data Pad functions are 
discussed in the Data Pad section of this chapter.

Any changes made to the cycle detection settings of the Cycle Variables 
calculation for a particular channel will affect the Cycle Variables Data 
Pad functions as well, and vice versa. 

Differential

The Differential channel calculation calculates the first time derivative of 
the data in a channel. The calculation is offline, so you can see the 
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derived data only when Chart is not sampling (during sampling, you 
see any recorded data). Choosing the Differential… command from a 
Channel Function pop-up menu displays the Differential dialog box for 
that channel.

As with most channel calculations, you specify a source channel in the 
Source channel pop-up menu.

The slider bars for the Smoothing and Multiplier controls can be used to 
set values in the normal way, by dragging the sliding handle, or 
clicking the slider bar area. The value is displayed below the slider bar. 
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Figure 6–36  
The Differential dialog 
box.

▼ Refer
Computed Input,  p. 153
By default, the Smoothing and Multiplier controls are set to No 
Smoothing and ×1 respectively. 

The Smoothing control lets you set the amount of smoothing used in the 
differentiation, either none, or from 2 to 50 samples. The differential at 
any sample point is effectively the average of the slope of two lines. 
One is from the sample point to a point n samples before it, and one is 
from the sample point to a point n samples after it, where n is the 
number of samples set using the Smoothing control.

The Multiplier control lets you amplify the differential waveform up to 
1000 times. This is used to enlarge the differential waveform to make it 
easier to deal with, since it can end up quite small if the signal changes 
slowly.

Integral

The Integral calculation provides the ability to calculate time-integrals 
Chart Software

both online and offline. It is more versatile than the Computed Input 
Integral functions, in that the integral can optionally be reset to zero by 
‘events’ (threshold crossings of a signal in any Chart channel).

Choosing the Integral… command from a Channel Function pop-up 
menu opens the Integral dialog box for that channel, in which you 
choose the source channel, the type of integral, the resetting mode and 
the scale with which the integral is displayed.
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Figure 6–37  
The Integral dialog box.

▼ Refer
Computations with 
Computed Input 
Functions and Channel 
Calculations,  p. 261
Integral Type

There are four types of integral that you can select from the Integral 
type pop-up menu. They are similar to the computed input integrals, but 
may give slightly different results, owing to the fact that computed input 
functions always have a precision based on a sampling rate of 2000 
Hz or higher, regardless of the sampling rate set in Chart.

∫ (Integral) calculates ∑y ∆t, where ∆t is the interval between samples. ∫ 
Absolute Value calculates ∑|y| ∆t. ∫ Positive Only calculates ∑y+ ∆t, 
where y+ = y if y > 0 and is zero otherwise. ∫ Negative Only calculates 
∑y– ∆t, where y– = y if y < 0 but is zero otherwise.

Resetting Mode

Auto puts ‘.s’ (for 
seconds) after existing 
unit. Fixed lets you define 
the unit.
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Every integral is set to zero at the start of a data block. The nature of 
most data integrals is to increase (or decrease) continuously. It is, 
therefore, usually necessary to introduce a resetting mechanism to keep 
the integrated signal within bounds. Resetting modes are:

• No Reset. The integral is not reset.

• Timed Reset. Reset to zero occurs regularly at an interval entered in 
a text box.
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Figure 6–38  
The More Integral 
Options dialog box.
• Reset Each Cycle. The integral is reset each time the source signal 
passes through zero to a positive value.

• Time Constant Decay. The integral is not reset sharply, but tends to 
decline towards zero with a time constant as set in the text box. 
With no input to the integral, its value decays to about 37% (1/e) 
in each time constant. This is like a ‘leaky’ analog integrator.

• Reset By Event is a generalization of Reset Each Cycle. The resetting 
event can be on any channel or threshold level on a rising or falling 
signal. You can also set a Skip time that locks out the event 
detection for a specified time after an event occurs. The Skip time is 
useful for preventing premature resetting by certain multi-peaked 
repetitive waveforms. To set these options, click the More Options… 
button in the Integral dialog box, which displays the More Integral 
Options dialog box (Figure 6–38).

Integral displayed 
as sawtooth

Integral displayed as 
stepped waveform

Further reset events 
ignored during this 
time

Select to calculate 
integral over 
defined time limits

Channel in which 
reset event is 
looked for. Data 
channel means the 
channel chosen as 
the source for the 
integral

Set whether resetting is 
triggered by a rising or a 
falling signal

Set threshold level 
for reset event
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Other Integral Options

The More Integral Options dialog box (Figure 6–38) provides controls 
for two further options, in addition to controls for resetting by event.

For integrals that have a timed reset, or are reset by cycle or event, you 
can display the calculated integral as continuously increasing during 
each cycle (giving a sawtooth-like appearance), or you can display it 
as showing the value reached during the previous cycle, until the 
integral is reset (giving a stepped appearance).



Chapter 6 — Data Analysi
Selecting the Partial Integral checkbox means that integrals are 
calculated as definite integrals over the chosen limits. Before the first 
limit, the integral is zero. After the second limit, the integral holds its 
value constant. This mode is most likely to be useful in a recording with 
multiple data blocks.
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C H A P T E R  S E V E N

Customizing & 
Automating Chart

Chart can be extensively customized and automated, to increase its 

convenience and ease of use. It can be simplified or modified by 

locking, hiding, or altering controls, menus, and menu commands. 

Macros can be created to speed up and automate tasks, and added to 

menus and the Tool bar; and new menus can be created. A time 

schedule can be defined to control recording, voltage output, and so 

on. External devices can be controlled, and comments inserted 

automatically in response to external events. Chart extensions (software 

plug-ins) are available to add extra features to Chart. 

This chapter looks in detail at Chart preferences, customizing options, 

and recording automation and control functions. 
189
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Figure 7–1  
The External Trigger 
Options dialog box.

e-corder Startup,  p. 229
Preferences
The various options in the display settings and recording controls allow 
basic customizing of Chart. You can also choose to lock, hide, or alter 
controls, menus, and menu commands (and their keyboard equivalents). 
This can be particularly useful in simplifying Chart for teaching 
purposes. The commands in the Preferences submenu of the Edit menu 
let you manage aspects of Chart behavior and display (Chart and 
e-corder startup, the external trigger, the Tool bar, cursors, menus, 
controls, Chart extensions, memory allocation and data buffering). 

External Trigger

On selecting Chart > Preferences > External Trigger…, the External 
Trigger Options dialog box appears which lets you choose, whether a 
TTL voltage level or a contact closure event will trigger recording. 

The Current State indicator shows if the external trigger (Ex) is off (gray) 
or on (yellow), so that you can apply voltage levels or a contact closure 

External trigger 
state indicator

On

Off
▼ Refer
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and observe the effects. The state indicator replicates the behavior of 
the Trigger light on the front of the e-corder, and is useful if the e-corder 
hardware can’t be clearly seen. 

Tool Bar

On selecting Chart > Preferences > Tool Bar…, the Tool Bar Settings 
dialog box appears. It lets you choose whether the Tool bar is shown, 
and which buttons appear in it and how they are arranged. Initially, the 
Visible scrolling list displays all the standard buttons that appear, and 
the Hidden scrolling list displays, for all available macros, the name of 
the menu that the macro is in, a colon, and the name of the macro. 
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Figure 7–2  
The Tool Bar Settings 
dialog box.
Names that are too wide are truncated: an ellipsis (…) replaces extra 
characters. Once things are arranged, click the OK button to apply the 
settings or the Cancel button to close the dialog box without making 
changes.

Turning off the Show Tool Bar checkbox hides the Tool bar. This is 
useful if you don’t have much room on your screen or don’t much care 
for Tool bars. (The Tool bar can be moved by Shift-dragging it if you 
just want it elsewhere.)

The order of items from top to bottom in the Visible scrolling list 
indicates the order of buttons from left to right in the Tool bar. A 
separator (dotted line) in the list adds a space between buttons, so that 
buttons with similar functions can be logically grouped. 

Items can be moved to alter the default arrangement. Just drag an item 

Choose a 
button icon from 
the Icon list

Assign a 
Function-key 
equivalent from 
the pop-up 
menu

Drag to place a 
separator in the 
Visible list
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by its title (to the left of the vertical bar) to move it. The pointer changes 
to an arrow-headed cross, and as you drag, a gray outline indicates 
where the item will go. When items are moved to, or about in, the 
Visible scrolling list, a horizontal line and left-pointing triangle indicate 
the insertion point. Items moved to the Hidden scrolling list are just 
added to the bottom; separators are discarded, since new ones can 
always be added to the Visible list by dragging from the (left side of 
the) permanent one at the top of the Hidden list. 

The icon for a standard item cannot be changed, but a macro item can 
be assigned an icon by dragging one from the Icon scrolling list. The 
pointer changes to an arrow-headed cross, and a gray outline shows 
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Figure 7–3  
The Waveform Cursor 
dialog box.
where the icon will go. The item highlights if the pointer is over it: the 
icon appears at its left when dropped, replacing any icon already 
there, and will appear on its button if it is in the Visible scrolling list. 

Use an item’s pop-up menu, to the right of the vertical bar, to assign 
one of the 15 Function keys (F1 to F15) to a button, for use with an 
extended keyboard (the default is none, a blank). Pressing the assigned 
key activates the macro, even if the button or Tool Bar is hidden. Note 
that Function keys assigned to a button on the Tool Bar override those 
same keys assigned for automatic comments. 

Cursor

Choose Chart > Preferences > Cursor… to open the Waveform Cursor 
dialog box (Figure 7–3). Click one of the radio buttons to choose a 
Waveform Cursor shape that is easy to see when tracking the 
waveform. The line cursor is a vertical line that crosses all channels, 
with short bars where the waveforms are intersected. It is useful with a 
large screen or noisy waveforms, when the other Waveform Cursors 
might be harder to see. Click the OK button to apply your choice. 
Chart Software

Menus

The six Chart menus (File, Edit, Setup, Commands, Macro, Window) 
and their commands can be modified from the default settings by using 
the Menus dialog box. Choose Chart > Preferences > Menus… to open 
this dialog box. You can hide or lock any menu or menu command to 
create a very simple Chart setup, if you want to limit the actions that 
can be performed. This is particularly useful for teaching in a laboratory 
environment, where you might want students to be able to use some 
features of Chart, but not to edit, delete, or change the data in files. 
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Figure 7–4  
The Menus dialog box.
The dialog box will initially display just the menu names in the left-hand 
pane: to see the items for a particular menu, select the menu name.

By default, menu titles and all items within the menus will have selected 
checkboxes to their left, and all menu commands will have open 
padlocks beside them as well, indicating that everything is visible and 
unlocked. Items in submenus cannot be edited, but the submenus 
themselves can be hidden. Locking or hiding a menu command will 
have no effect on the equivalent Tool bar button.

Deselecting the checkbox beside a menu title will hide the menu: it will 
not appear in the menu bar when you return to the Chart window, and 

Click on a 
keyboard shortcut 
to change it

Click on a padlock to 
disable a menu item

Deselect checkboxes to hide 
menus and menu items
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any keyboard shortcuts in it will not work. Deselecting the checkbox 
beside a menu command or a dividing line hides it: it will not appear 
in the menu, and neither will any keyboard shortcut work. Selecting a 
checkbox again will show the previously hidden item beside it. 

Clicking an open padlock (with a U for unlocked on it) changes it to a 
closed padlock (with an L for locked on it), and locks the menu 
command beside it. The command still appears in the menu, but if it is 
chosen or the keyboard shortcut typed, an alert notifies the user that it is 
locked and cannot be used. Clicking a closed padlock changes it to an 
open one, and unlocks the previously locked menu command beside it.
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▼ Refer
Shortcuts and Tips,  
p. 237

Figure 7–5  
The Controls dialog box.
Keyboard Shortcuts

Keyboard shortcuts for menu commands can be added or changed. 
Click the shortcut text next to a menu item to select it: the text highlights 
and the letter key appears selected. You can either change it, or delete 
it so that no keyboard shortcut is available. To assign a keyboard 
shortcut, type a single lower-case letter or number in the text entry box 
(letters are automatically capitalized; invalid characters will be 
rejected).

If you choose a character already in use, an alert box will warn you of 
the fact and tell you where it is assigned. If you choose the character 
anyway, your choice overrides the previous assignment, and the 
keyboard shortcut (Command-S, or whatever) will only work for (and 
appear beside) the menu command that you have chosen.

Controls

On selecting Chart > Preferences > Controls…, the Controls dialog box 
appears. By default, all the checkboxes are highlighted, and their 
functions active. Click the checkbox or the function beside it to toggle 
the function off or on. The dialog box allows you to remove Chart 
functions that could be confusing or are unnecessary for a student or 
new user, who might easily feel lost and bewildered by choice. Click 
OK to apply your changes. 

Allow Printing of Whole File. Turning this checkbox off disables the Print 
All… command in the File menu — other printing commands such as 
Print Selection… are still available, but the whole file cannot easily be 
Chart Software
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printed. This is useful in student labs, where usually only a small portion 
of a file would need printing. 

Record/Monitor Control. When this checkbox is turned off, the 
Record/Monitor button is hidden. This can help prevent new users 
losing data by accidentally clicking the button and switching from 
recording to monitoring. Even if the button was set to monitor before the 
control was hidden, Chart will only record, not monitor.

Scroll/Review Control. When this checkbox is turned off, the 
Scroll/Review button is hidden. This can help prevent new users 
becoming confused, should they accidentally set the review option, and 
Chart’s data stops scrolling, and so on. 

Computed Inputs. When this checkbox is turned off, the Computed 
Inputs… menu command disappears from the Channel Function pop-up 
menu, so that the Computed Input dialog box is no longer accessible 
from there. 

Channel Calculations. When this checkbox is turned off, the options in 
the lower half of a Channel Function pop-up menu that perform channel 
calculations on data are removed (including those added by Chart 
extensions). This helps to prevent new users confusing recorded data 
(raw or computed) with calculated data.

Full Trigger Window. When this checkbox is turned off, the Start and 
Stop Cycling controls do not appear in the Trigger window. 

The Computed Inputs and Channel Calculations controls don’t stop 
access to the functions through the columns in the Channel Settings 
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dialog box, so to stop access you should hide the Channel Settings… 
menu command as well. 

Note that the settings for Computed Inputs, Channel Calculations, and 
the Trigger Window (such as pre-triggering or the number of blocks 
after which to stop cycling) remain in effect, so make sure they are set 
to what you want before you hide them.
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Figure 7–6  
The License Manager 
dialog box.
License Manager

The Chart License Manager allows you to view, add and delete license 
codes for Chart. Choose Chart > Preferences > License Manager… to 
open the License Manager dialog box (Figure 7–6).

Existing license codes and their descriptions are shown in the lower half 
of the dialog box. Note that the last four characters of the license code 
are shown as ‘xxxx’ — you will have been provided with the full license 
code including the last four characters when you purchased the 
software. To add a license code, enter it into the License Code text box 
and click Add. The new code will appear in the dialog box.

To delete a license code, select it and then click Delete. You will be 
asked to confirm the deletion. If you delete your Chart license code, the 
next time you try and run Chart, you will be prompted to enter a valid 
license code. Chart will not run until you have done this. If you delete 
all the license codes shown in the License Manager dialog box, you 
can edit the entries in the Name and Organization text boxes.
Chart Software

Chart Extensions

Chart extensions are additions to the Chart program that add extra 
functionality, such as file translation capability, data analysis. For 
example, the Export MATLAB extension allows you to save Chart files in 
a format readable by the data analysis application MATLAB. Extensions 
are separate files that may be downloaded free from the eDAQ web 
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Figure 7–7  
The Extensions Manager 
dialog box, showing 
some extensions.
site (www.eDAQ.com), along with documentation that describes how to 
use them.

When Chart is installed, the ‘Chart 5’ folder created in your 
Applications folder includes an Extensions folder. This folder should not 
be renamed or moved, or no Chart extensions will load. To install an 
extension, quit Chart and place the extension file in this folder, or run 
the installer if one was provided. Extensions in the Extensions folder will 
be loaded when Chart starts up.

Click on a  (it toggles to a ) to deactivate an extension
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The Extensions Manager dialog box lists the Chart extensions within the 
folder, explains what they do, and lets you choose which of them will 
be loaded when Chart starts up. Choose Chart > Preferences > 
Extensions… to open the dialog box. Chart extensions in the Extensions 
folder are shown in the scrolling list at the left. Click one to select it: its 
version number and a description appears to the right. 

It is unlikely that you will want to use all the Chart extensions. To 
change the ones used, click the ticks or crosses in the list. Clicking a 
tick will toggle it to a cross, and vice versa. Those Chart extensions 
marked with a tick will be loaded when Chart starts up; changes take 
effect when Chart restarts. You can decide which Chart extensions 
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▼ Refer
Recording Length,  p. 32

Figure 7–8  
The Memory Cache 
dialog box.

▼ Refer
Recording Length,  p. 32
should be loaded during startup, as well. Hold down the space bar as 
Chart starts up to open the dialog box, and click the tick or cross 
beside each Chart extension to change its status. 

Memory Cache

If your computer is taking a lot of time to perform actions on large files 
(such as redrawing windows), it may help to change the size of the 
memory cache. Choose Chart > Preferences > Memory Cache… to 
open the Memory Cache dialog box (Figure 7–8). Then select the 
Manual option and adjust the size of the memory cache by adjusting 
the position of the slider bar (depending on the system and resources 
being used, performance may be improved by either decreasing or 
increasing the size of the cache, so you may need to experiment with 
both).

Data Buffering
Chart Software

Data buffering lets you choose where the data you record will be 
stored, memory or disk. Files are stored on the system disk (the current 
startup disk) by default. Recording data to RAM (physical memory) may 
be faster than recording to disk when using a slower computer. 
However, the benefits will be limited by the amount of RAM you have; 
if you need more space for the file you are recording than there is 
RAM, Chart will start using virtual memory, which accesses the hard 
disk anyway. Most systems have more disk space than RAM, and data 
buffered to disk by Chart can survive a power failure or system crash, 
so recording to disk is a better choice unless the slowness of your 
computer forces you to record to RAM. Data buffering settings can be 
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Figure 7–9  
Data Buffering dialog 
box.
changed only when Chart has open either no file or a new file with no 
data. Close any open Chart file containing data and choose Chart > 
Preferences > Data Buffering… to choose where data will be buffered. 
The dialog box in Figure 7–9 appears. 

If recording to disk, you can select a different disk buffering location 
(on a different disk, perhaps) by clicking the Choose button. The 
amount of free space on the disk containing the chosen folder is 
displayed. Note that this is a temporary location, different from the 
location you choose in the Save dialog box when you save a file. Data 
can be recorded to an internal or external hard disk, removable media 
such as magneto-optical disks or removable hard disks. Hard disks are 
generally faster than the other options. Care should be taken that 
removable media are not removed in the middle of recording! When 
Chart comes to write to a removed disk, it will open the standard 
system dialog box asking you to insert the missing disk, and will cease 

Select a different location 
for disk buffering

Click the appropriate 
button to record to 
memory or disk

Use the default disk 
buffering location
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recording until the disk is inserted. 

If Chart is set up to record to disk, it creates a buffer file as soon as it 
starts up. This temporary file is called ‘…Chart Buffer File…’ in the 
Finder and has a different icon from normal files. Blocks of data are 
written to the file at set intervals when sampling. As a general rule, a 
new block is written to disk every 16 000 samples or every two 
minutes, whichever comes first. Once recording has finished, you still 
must save the file using the standard Save command. Quitting Chart or 
opening a new file will prompt you to save the file first: if you abandon 
it at this stage, the data will be lost. When a file is saved, all the 
buffered data are written to it, and the buffer file is emptied, ready for 
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Figure 7–10  
The Startup Settings 
dialog box.
the next bout of recording. When you quit Chart normally, the buffer 
file is erased. 

In the case of a problem that terminates sampling, Chart only loses a 
maximum of the last block of data recorded, that is, 16 000 samples or 
the last two minutes of recording. The rest is stored in the buffer file. The 
next time Chart runs, it searches for a buffer file. If it finds one, an alert 
box indicates that the file being recorded prior to the problem needs 
recovery (since it will not have been saved properly). In most cases, 
most of the buffered data should be recoverable. If you choose to 
delete the file, the data will be lost.

Startup

Settings are of two sorts: those that affect recording, such as sampling 
rate, channel ranges, triggering, and stimulation functions; and those 
that affect the way the data looks, such as the menu configuration, 
window size, channel areas, and display settings. To save or clear 
customized settings, choose Chart > Preferences > Startup… to open 
the Startup Settings dialog box. 

Click the Save button to save all current settings in a preferences file 
(Chart StartUp) in the user’s Preferences folder, so that they are used 
each time Chart starts up. Click the Clear button to clear any settings 
currently stored in the Chart StartUp file: when Chart next starts up, it 
uses its default settings, taking the whole screen for its display, with 
visible channels having a 10 V range, and so on. (Settings in use 
remain until you quit and restart Chart.) To bypass the current startup 
settings and use the default settings for a single session, hold down the 
Chart Software

Command key as Chart starts up: release the key when the alert box 
appears, and click the Yes button.
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Figure 7–11  
The Special Access 
dialog box.
Special Access
Because it is possible to change menu preferences so that vital menu 
commands are locked or menus themselves hidden, it is necessary to 
have a back door in. Access to dialog boxes often needed, but made 
unavailable in order to safeguard files, is possible through the Special 
Access dialog box, which appears on typing Command-\ (the 
backslash character). If your keyboard does not have a \ character, 
type Control-Command-1 instead.

Clicking the Menu Editor… button opens the Menus dialog box, letting 
you show hidden menus, unlock menu commands, and otherwise alter 
settings. This is obviously useful if by locking or hiding things you have 
removed access to that dialog box. 

Clicking the Tool Bar… button opens the Tool Bar Settings dialog box, 
letting you choose whether the Tool bar appears, and which buttons 
appear in it and how they are arranged. This is useful, say, to change 
keyboard shortcuts, which still apply if the Tool bar is hidden. 

Clicking the Save As… button opens the Save As dialog box, which 
allows you the complete range of options in saving a Chart file. It is 
useful where you have disabled the ability to save a file, and 
particularly to save the file as a Settings file with the hidden or locked 
menu items remaining as specified when the file was saved.

Clicking the Controls… button opens the Controls dialog box, which 
lets you remove Chart functions that could be confusing or are 
unnecessary for a student or new user. This is useful to reinstate 
functions when they are required. 
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Clicking the Startup… button opens the Startup Settings dialog box, 
letting you save the current settings in the file (including menu layouts 
and so on) as those Chart will use when it starts up. This is useful when 
you use Chart for routine work requiring the same settings day after 
day. It also means that quitting and restarting Chart will not face the 
user with a Chart file that could have quite different settings, and none 
of the safeguards you may have set up. 

Macros
Macros are used to group sets of commands together conveniently, 
letting you speed up repetitive and tedious tasks, such as changing the 
settings for various parts of an experiment. They can help to automate 
recording and analysis. They record the results of your actions step by 
step, then reproduce them when played back. If you find yourself 
regularly doing the same series of tasks in Chart, whether simple or 
complex, macros can ease things considerably. Macros can record 
almost any Chart operation: setting dialog box and window controls; 
changing the display format; sampling; copying waveform data to the 
Data Pad; saving data as a new file; printing the Zoom window display 
of selected data; and so on. There are some differences between 
recorded and real operations, but in general, dialog boxes will guide 
you through your options. 

Note that macros record the results of your actions, not individual 
keystrokes and mouse clicks, and record the simplest possible 
interpretation of those actions. Even if you spend some time fiddling 
with control settings during the recording of a macro, only the final 
settings you obtain will be used. Macros cannot be edited, and may be 
Chart Software

incompatible between versions of Chart. 

You should keep a written record of the steps involved in your macros, 
and their purpose: it is easy to forget which macro does what when you 
haven’t used them for a few weeks. Noting the steps down before 
actually recording will help when constructing complex macros, since it 
can prove easy to miss out a step or end a repeated sequence in the 
wrong place, with detrimental effects. 

When a file is saved, all currently available macros are saved with it, 
becoming part of the file. When you open a Chart data or settings file, 
any macros in that file are loaded into memory. In the Open dialog box 
there is a Discard Existing Macros checkbox. If this is on, macros 
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Figure 7–12  
The New Macro dialog 
box.
currently in memory are discarded when the file is opened, and any 
macros in the opened file replace the previous set. If the checkbox is 
off, macros accumulate in memory as you open files until you quit and 
restart Chart, or delete the macros. 

Recording a Macro

To record a macro, choose Macro > Start Recording or type Command-
R (the menu command then changes to Stop Recording…). When a 
macro is being recorded, for the most part Chart remembers rather than 
executes operations, but opening files, changing channel ranges, or 
turning channels off, for example, are done as you record. 

During the process, a progress indicator is shown in the text box of the 
Tool bar, to remind you that your actions are being recorded, not 
necessarily effected. Perform all actions to be recorded, then choose 
Macro > Stop Recording… or type Command-R again to finish. The 
New Macro dialog box appears (Figure 7–12). 

The Menu pop-up menu lets you choose the menu in which your macro 
will appear from a list of existing menus. By default, the macro will be 
added as a new menu command to the Macro menu. You can create a 
new menu by entering its title (up to 10 characters) in the Menu text 
entry box: it will be added to the right of the Macro menu in the menu 
bar. The name of the macro (up to 20 characters) should be entered in 
the Item text entry box. Each name must be unique in its menu. To 
create a menu divider, so that similar macros can be logically grouped, 
record a simple macro (playing a sound, say), and start the macro 
name with two hyphens (--). It will appear only as a divider in the menu, 
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and cannot be chosen (it is accessible through the Tool bar, though). 

Type a name for the macro here

Click here to choose a menu to 
which to add the macro

Assign a keyboard shortcut here

Type here to create a new menu
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▼ Refer
Shortcuts and Tips,  
p. 237
An optional keyboard shortcut can be assigned to the macro as well: 
type a single lower-case letter or number in the text entry box (letters 
are automatically capitalized; invalid characters will be rejected). An 
alert box will warn you if you choose a character already in use, and 
tell you where it is assigned. If you proceed anyway, your choice 
overrides the previous assignment, and the keyboard shortcut will only 
work for (and appear beside) the menu command just created. 

The Size indicator tells you the number of steps recorded (useful if you 
can’t remember which step you are up to in the middle of a complex 
macro), and the memory used by the macro (which depends on the 
procedure). Click the Discard button to discard the macro you have just 
recorded. Click the Cancel button to leave the dialog box and record 
more steps in the macro. Click the Add button to add the macro to the 
bottom of the selected menu; the button is only active and undimmed 
when the macro is named and a menu is chosen. 

Until you save the file, new macros exist only in memory and are not 
permanently stored. If you open another file (without discarding 
currently available macros) and save that file, the macros will become 
part of the new file. When you quit Chart, you will not be asked to save 
changes if the changes are only concerned with macros, so it is a good 
idea to save the file each time you create a macro. 

Playing a Macro

Once assigned a name and location, a macro acts much as if it were a 
menu command. To use one, select it from its menu or type its keyboard 
shortcut (or click its button in the Tool bar). While a macro plays, the 
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title of the menu in which it resides is highlighted, the message ‘Playing 
Macro…’ is displayed in the text box of the Tool bar, and no other 
functions can be performed within Chart. If you switch to another 
application and leave Chart in the background, the macro stops 
playing at its current step. To stop a macro playing at any time, type 
Command-period (.): the macro stops at its current step. 

Deleting a Macro

To delete existing macros, choose Macro > Delete Macro… to open the 
Delete Macro dialog box. A scrolling list displays the name of the menu 
that the macro is in, a colon, and the name of the macro, for all 
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Figure 7–13  
The Delete Macro dialog 
box.
available macros. To delete a macro, select it and click the Delete 
button. To choose multiple macros for deletion, Shift-click or Shift-drag 
to select contiguous macros, or Command-click to select or deselect 
macros individually. Once the Delete button is clicked, the dialog box 
closes and the macro or macros will be gone. As a shortcut, double-
click a macro to delete it and close the dialog box in one step. 

As was mentioned, macros are part of a particular file, and when a file 
is saved, all currently available macros are saved with it. When you 
delete a macro, you delete it from memory. If it has been assigned a 
button in the Tool bar, the button disappears. If the macro is part of the 
current file, it is permanently deleted from that file only when the file is 
saved (although it will not be available while the file remains open). 
Copies of the macro attached to other files are not deleted. 

Options When Recording Macros

Operations involving files and dialog boxes can be made to behave 
differently when playing macros, depending on whether you want to do 
the same thing all the time, allow user modification, and so on. 
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Changing Dialog Box Settings

Macros can be used to change dialog box settings to values specified 
when you record, or to open a dialog box for the user to change 
settings when the macro is played. 

If you want a macro that changes the settings in a dialog box, then 
select the dialog box as you would normally while recording the macro. 
Change the settings, and then click OK in the dialog box. (If you click 
Cancel, changes made in the dialog box are ignored.) When playing 
the macro, the settings are changed without displaying the dialog box. 
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Figure 7–14  
The Macro Sampling 
dialog box.

▼ Refer
Wait While Sampling,  
p. 221
When changing control values in dialog boxes, absolute values are 
recorded, not relative changes. For example, if you move a slider bar 
that increases voltage from 2 V to 3 V, the new voltage (3 V) is 
recorded, not the change in voltage (+1 V) or the percentage change in 
voltage (+50%).

If you want a macro that lets the user change dialog box settings when 
the macro is played, then while recording the macro, hold down the 
Option key when selecting the command that shows the dialog box, 
then click the OK button. Do not make any setting changes. When the 
macro is played back, the dialog box is displayed so that its settings 
can be changed by the user. At that stage, clicking the OK or Cancel 
buttons in the dialog box lets the macro continue, with the user-defined 
settings or the original settings respectively. 

Starting Sampling

Macros can be used to control when sampling starts and stops. Should 
you click the Start button when recording a macro, the Macro Sampling 
dialog box will appear. In general, you would probably want to retain 
the default setting in the upper part of the dialog box (that is, stop the 
macro while sampling), but in some cases you might want to perform 
steps as sampling proceeds (adjusting some settings, for example). 
Another macro command, Wait While Sampling, lets you suspend 
sampling after a particular step, if you choose this option. The lower 
part of the dialog box allows you to specify when sampling stops. This 
could be useful to override, for a certain portion of an experiment, a 
fixed duration set in the Trigger window. 
Chart Software
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Figure 7–15  
The Open File for Macro 
dialog box.
Opening and Appending Files

A macro can be used to open or append the same file each time it is 
played, or to allow the user to choose a file. To open or append a 
particular file with a macro, choose File > Open… or File > Append… 
while recording a macro: in each case the Open File for Macro dialog 
box is displayed. To append rather than open a file, turn on the 
Append checkbox. 

To let the user choose which file is to be opened or appended when the 
macro is played, press the Option key when selecting the command 
while recording the macro. An alert box reminds you that you are 
giving the user a choice. The Open dialog box will be displayed when 
the macro is played. 

When opening the same file each time, if the file has been moved (or 
deleted) since the macro was recorded, then Chart searches in the most 
recently used folder and in the same folder as Chart. If the file is in 
neither place, an alert box lets you know that Chart cannot find the file, 
and the Open dialog box is displayed to allow you to find it yourself. If 
you choose a different file at this stage, that one will be opened 
instead; if you click the Cancel button, the macro will stop. 
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Figure 7–16  
The Save File for Macro 
dialog box.
Saving Files

When playing a macro, you can save data in a file or in a series of 
files. Choosing the plain Save command will save a current named file. 
You might want to do this at specified intervals to minimize data loss in 
case of possible power loss. To let the user choose where and under 
what name the file is to be saved when the macro is played, press the 
Option key when selecting the command while recording the macro. 
An alert box reminds you that you are giving the user a choice, and the 
Save As dialog box will be displayed when the macro is played. 

Data are not recorded during the time it takes to save a file to disk, so 
large files might take a while to save. To minimize data loss during 
automated recording, you can instead save a series of short files, and 
also specify where and in what form you want the data to be saved, by 
choosing File > Save As… or File > Save Selection… when recording 
the macro. The Save File for Macro dialog box appears. The formats 
are data file, settings file, and so on, as usual. 

The three ‘Append filename with’ checkboxes let you specify unique file 
names. If none are turned on, then each time you play the macro, the 
Chart Software
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file will be overwritten, just as it is when saved normally. If the Unique 
number checkbox is selected, a different number is added to the end of 
the given file name each time the file is saved during the playing of the 
macro. Numbers are added in numerical sequence starting with ‘1’. For 
example, if the file name is CoolData, then the next files generated will 
be CoolData(001) and CoolData(002). If the macro is played again, 
numbering will follow on from the last such numbered file to give 
CoolData(003) and so on. Selecting the Time checkbox appends the 
current time to the file name. Selecting the Date checkbox appends the 
current date to the file name. The two may be combined. These 
checkboxes are dimmed and unavailable if the Unique number 
checkbox is selected. 

Macros That Call Other Macros

Once a macro has been created, it can be used by other macros (when 
it is loaded in memory) as a step in the recording of the new macro. 
This enables modular construction of complex procedures. Macros can 
only be nested up to ten deep, however. An alert box will appear 
during the playing of your macros if the combination becomes too 
recursive, and the macro sequence will stop at that stage. If a macro is 
called by other macros, Chart warns you if you attempt to delete it. If a 
macro is deleted without being replaced, then if it is called, an alert 
box tells you that it cannot be found, and the calling macro stops. 

Macro Commands

Control structures for macros are provided in the Macro Commands 
submenu; the menu commands are only available while recording a 
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macro. They let you provide user feedback using dialog boxes and 
sounds, set up repeat sequences, wait for a certain time, and so on. 

Update Screen

Normally, when a macro is played, the screen is updated after each 
macro step (a tick beside the Update Screen menu command indicates 
that it is active). Choosing the command from the menu as the first step 
in a macro causes the macro to play without redrawing the screen each 
time the data display is altered in some way (the tick disappears). 
Update Screen can be turned off or on at any stage of a macro. The 
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Figure 7–17  
The Macro Wait dialog 
box, showing the three 
options selected.
settings toggle. If Update Screen is off, the screen will be redrawn only 
when the macro is finished, or it is turned on again. 

This may considerably speed up some macros, for example, those 
involving multiple changes to view and display settings, or repetitive 
selection and transfer of data to the Data Pad: in this case, the data on 
screen will still be seen to be selected, but data off screen will not be 
scrolled through before selection, as would occur if Update Screen 
were on (it was ticked in the menu). Since you cannot edit macros, you 
cannot change the Update Screen settings once the macro is finalized. 
You can, however, record another macro that consists of two steps: 
turning update screen off or on, then calling the original macro. 

Wait…

Choosing the Wait… macro command opens the Wait dialog box. A 
pop-up menu lets you choose from Wait For, Wait Until, and Wait Until 
the Next, to wait for a set length of time (say, 55 seconds), wait until a 
certain time (say, 11:20 a.m.), or wait until the next time division (say, 
at the next hour) before the macro continues. 
Chart Software
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Figure 7–18  
The Macro Wait dialog 
box during the playing of 
the Wait step of a 
macro.
The checkbox lets you choose whether a dialog box with a progress 
bar appears during the wait (generally a good idea). The dialog box 
gives a visual indication of wait progress, and provides the options of 
proceeding immediately to the next step of the macro by clicking the 
Skip the Wait button, or aborting the macro by clicking the Stop Macro 
button (equivalent to typing Command-period). 

This feature is useful if you want to perform some steps of an 
experiment at certain intervals, or to record multiple sampling 
sequences with a specific interval between them.

Play Sound…

Choosing the Play Sound… macro command opens the Macro Play 
Sound dialog box, which allows you to choose from the range of 
sounds in your computer’s system to set audible alerts in macros. Click 
the name of a sound in the scrolling list to select it. If you wish to hear 
the selected sound, click the Play button. To have it actually played in 
the macro, click the OK button (which closes this dialog box). To 
choose more than one sound option, Shift-click or Shift-drag to select 
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contiguous sounds in the list, or Command-click to select or deselect 
multiple sounds individually. Sounds appear in the list in the order they 
were installed in the system, and are played back in that order. To save 
time in creating multiple sounds, you can create a library of sound 
combination macros, and simply incorporate one or more of them in 
the macro that needs them. 

You might wish to have three beeps signal when the e-corder starts 
recording data, or a bell and a whistle when a trigger point has been 
reached. You can even record short verbal cues, if your computer has a 
microphone input, using the Sound System Preferences, and use these 
in your macros. 
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Figure 7–19  
The Macro Play Sound 
dialog box.

Figure 7–20  
The Macro Message 
dialog box.
If a macro attempts to play a sound not in the system (created on a 
computer with a different setup, or since removed from the system), then 
an ordinary system beep will be substituted for the sound originally 
specified. 

Message…

If you select the Message… macro command, the Macro Message 
dialog box appears. This allows you to cause alert boxes requiring user 
response to appear at certain stages within the macro. 

You can type in the message of your choice (up to 255 characters). The 
dialog box produced will have an OK button, and if the checkbox at 
the top is on, a ‘Cancel’ button as well (for exiting the macro). There 
are four choices of icon: the default shape is highlighted. Click one of 
the icon buttons to choose it. You can use the icons to indicate the 
urgency of an important message, and the Chart icon for general 
messages that indicate Chart’s state. Click the OK button when you 
Chart Software
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Figure 7–21  
The Speak Message 
dialog box.
have chosen an icon and typed in the message. You could use 
messages to remind you what the macro does.

It may help to notify a user that something is up if you precede an alert 
box with an audible signal (using the Play Sound… macro command), 
since he or she may not be looking at the screen when an alert box 
appears. 

Speak Message…

If you choose the Speak Message… macro command, the Speak 
Message dialog box appears. You can use it to give audible messages 
in macros, if the computer playing the macro has speech available. You 
can type in the message of your choice (up to 255 characters). If the 
Use System Volume checkbox is on (it is by default), the volume at 
which the message is spoken is the system volume set in the Sound 
System Preferences. If this checkbox is off, the volume can be set with 
the slider bar. 

Three radio buttons give a choice of actions when the macro step is 
reached, depending on whether you want to display an alert box, just 
as if the Macro message dialog box were used, and whether the 
computer on which the macro plays has speech enabled. If an alert box 
appears, it will stop the macro until its OK button is clicked. If not, the 
macro carries on playing after this step.
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Figure 7–22  
The AppleScript from 
Macro dialog box.
If the Never radio button is on, then the message will be spoken if 
speech is enabled, otherwise a standard system beep is used instead. 
In either case no alert appears. If the Only if Speech is not Available 
radio button is on, then the message is spoken if speech is enabled, 
otherwise the alert appears. If the Always radio button is on, then an 
alert box appears whether or not speech is enabled. 

AppleScript…

This macro command allows you to insert an AppleScript as a macro 
step. AppleScript is a scripting language for automating tasks, and 
controlling applications and their interactions through Apple events. It 
should be installed on your computer. On selecting the AppleScript… 
macro command, the AppleScript from Macro dialog box appears. You 
can enter a script of 32 000 characters in the scrolling field. The dialog 
box is a movable modal one, which means you can switch out of 
Chart, to get tested scripts from the Script Editor, say, and paste them 
in. You will lose text styles from a formatted script if you do this: scripts 
are just left as unformatted text in the dialog box, even when compiled 
there. 

Click the Check Syntax button to check and compile the script — you 
are told if the script will not run. The AppleScript is checked and 
compiled once you click the OK button, if you have not checked it 
already. It will look for named applications at that stage. Click the Test 
button to actually run the script (so that you can see how it works, while 
you are recording the macro).
Chart Software
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Table 7–1  
Apple events understood 
by Chart (it can also 
send other Apple events 
to programs that 
recognize them).
Once you click the OK button, the AppleScript is stored as one step of 
the macro. It thus can’t be edited, but it is recommended that only 
simple scripts will be used from within Chart: complex scripts that might 
require adjustment are better left residing in the Finder, and then called 
using a simple AppleScript macro step within Chart. 

For example, you could transfer data to an Apple event aware 
spreadsheet as you worked through a Chart file, by running a macro to 
cut a line from the Data Pad, and using an AppleScript step to switch to 
the spreadsheet, paste the data into the next row, and switch back to 
Chart. 

Chart is Apple event aware, but not Apple event recordable, and has 
no dictionary. It supports the required suite, and one more command.

The macro to be played by the ‘do script’ Apple event is identified by 
the name of the menu that the macro is in, a colon, and the name of the 
macro (just as it is shown in the Delete Macro dialog box). You don’t 
need to tell Chart to activate: it is automatically brought to the front 
when this event occurs. If an AppleScript macro step both switches out 
of Chart to some other program and then switches back in, the macro 
carries on and completes any remaining steps. If the AppleScript 
switches out of Chart, but does not switch in again, then the macro 
finishes at that step, and any remaining steps are ignored. 

Learning AppleScript is left up to you — it is not trivial, but is worth it if 
you want to do a lot of automation. Check the Mac OS X help or the 
AppleScript web site (www.apple.com/applescript/) for documentation 
and example scripts. 
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Command Function Example

open Open the specified Chart docu-
ment 

open file "Test Results"

print Print the specified Chart docu-
ment 

print file "Test Results"

quit Quit Chart application quit application "Chart 
v5.0"

run Launch Chart application run application "Chart 
v5.0"

do script Play the specified Chart macro do script "Macro:Beep"
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▼ Refer
Finding Data,  p. 133
Repeat While in Block

This macro command allows you to perform some operation while the 
selection or active point remains within a block of data. You should 
specify an End Repeat command after the instructions you want 
performed in the repeated sequence. For instance, you may want to 
find all the peaks from the start to the end of a block of data, and 
record their heights in the Data Pad. You would make use of the Find… 
command for this:

1. Choose Macro > Start Recording.

2. Choose Commands > Find…, and set up the Find and Select 
dialog box: Go, Start of This Block, Set Active Point. 

3. Choose Macro > Macro Commands > Repeat While in Block.

4. Choose Find… again, and set up the Find and Select dialog box 
for the search: Find Data, Next, Local Maxima, Set Active Point. 

5. Choose Commands > Add to Data Pad.

6. Choose Macro > Macro Commands > End Repeat.

7. Choose Macro > Stop Recording.

8. Name the Macro and assign a keystroke if you wish.

Repeat While in Selection

This macro command works similarly to the Repeat While in Block 
command except that it allows you to perform some action from the 
start to the end of a selection rather than from start to end of a block.
Chart Software

Repeat Select Every…

This macro command allows you to select sequential periods of data in 
a Chart file and to perform some operation on them. When you choose 
the Repeat Select Every… macro command, a dialog box appears, 
allowing you to set a selection period (with a minimum selection of two 
data points) and choose whether the command applies to the whole 
file, the currently selected block or to a current selection. You could, for 
example, transfer data to the Data Pad for every ten-second period 
within a given block. 
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Figure 7–23  
The Repeat Select Every 
dialog box.

Figure 7–24  
The Repeat Select 
Every… macro command 
in action.
If the Allow partial selections checkbox is selected, and the recording 
period is not an exact multiple of the selected time period, the last 
selection will be a shorter time making up the balance — for example, 
if the file were 45 seconds long and the selection period 10 seconds, 
the last selection would be the remaining five seconds. If the checkbox 
is off, the last selection in a block will not be included in the case where 
the length of the block is not an exact multiple of the selected time 
period.

Figure 7–24 shows a macro selecting a period of data (0.1 seconds) 
sequentially through a Chart file: each selection of data is dealt with 
before moving on to the next one. When this macro command plays, it 
will scroll through the Chart file and highlight each new selection, 
which may take a while unless the Update Screen command is turned 
off. 
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Period of selection 
(0.1 seconds here)
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Figure 7–25  
The Begin Repeat dialog 
box.
You cannot nest this command within itself, but you could nest it within 
the Repeat Select Each Block command, say, if you wanted to copy the 
mean of a channel for each ten-second period in a block to the Data 
Pad, and write the data of each block to a new file. You should specify 
an End Repeat command after the instructions you want performed in 
the repeated sequence.

Repeat Select Each Block

This macro command allows you to perform some operation on each 
block of data in turn in the Chart file. For instance, you may want to get 
the mean of a channel for each block and copy the information to the 
Data Pad. When this macro command plays, it will scroll through the 
Chart file and highlight each new block, which may take a while: turn 
off the Update Screen command to avoid the visual feedback. As with 
all Repeat macro commands, you should specify an End Repeat after 
the instructions you want performed in the repeated sequence. 

Begin Repeat

The Begin Repeat macro command is used to repeat steps in a macro. 
You can repeat any group of commands up to 100 000 times. This 
could be used, for example, to set up fast sampling at staggered 
intervals overnight. You should specify an End Repeat command after 
the instructions you want performed in the repeated sequence. 
Chart Software

End Repeat

Each and every Repeat macro command step you specify should be 
paired with an End Repeat. If you do not specify enough End Repeat 
steps, Chart adds them when you choose Stop Recording…, but if you 
have a complex macro, the repeated sequences might not end up in the 
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▼ Refer
Units Conversion,  p. 46

Figure 7–26  
The Set Units Conversion 
dialog box.
right places. Writing down the macro before recording it will help to 
avoid such problems.

Set Units Conversion…

The Set Units Conversion… macro command lets you automate units 
conversion. It may be more convenient to use this command in a macro 
rather than the proper Units Conversion dialog box. On choosing the 
command, the Set Units Conversion dialog box (Figure 7–26) appears. 
Select the Point 1 or Point 2 radio button to select the first or second 
pair of values. You can choose the recorded data of a particular 
channel, or the mean, maximum, or minimum values from a selection of 
recorded data, using the Channel and Selection pop-up menus. The 
converted value should be typed into the Value text entry box. Choose 
or define units from the Units pop-up menu. 
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To get a macro that converts the units of a channel into a percentage of 
the maximum reading, say, you should perform the following steps:

1. Select data containing the greatest and smallest data points in the 
channel you want to affect. 

2. Choose Macro > Start Recording.
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3. Choose Macro > Macro Commands > Set Units Conversion… to 
open the Set Units Conversion dialog box.

• Click the Point 1 radio button in the dialog box (if it is not 
already selected).
• Click the Selection radio button.
• Choose Minimum from the pop-up menu beside it.
• Enter ‘0’ in the ‘Value’ box.

4. Click ‘OK’.

5. Choose Macro > Macro Commands > Set Units Conversion… to 
open the Set Units Conversion dialog box again.

• Click the Point 2 radio button in the dialog box.
• Click the Selection radio button.
• Choose Max from the pop-up menu beside it.
• Enter ‘100’ in the ‘To Value’ box.

6. Define units of ‘%’ using the Units pop-up menu.

7. Click ‘OK’.

8. Choose Macro > Stop Recording.

9. Name the Macro (‘Percent’, or whatever) and assign a keystroke 
if you wish.

On finishing recording, you can apply this macro to any channel as 
required. Remember that it only applies to the current selection, so you 
will have to select a range of data including the largest and smallest 
points recorded to have the scale set correctly. To select an entire 
channel, Command-drag to select a rectangle the full height of a 
channel at its start of the record, scroll to its end, and Shift-click to 
Chart Software

extend the selection — this ensures that all data points are included. 

This feature can also be used for automatic calibration of transducers 
during setup. To do this, set up a macro with prompting messages. You 
must select the channel you are going to use, which means you must 
have started recording — simply start and stop, then click the channel 
to which the transducer will be connected. For example, in the case of 
a pressure transducer, the macro should be of the form: 

1. Macro Message. (Remove weight from transducer and click OK.)

2. Macro Set Units Conversion. (Set to 0.)
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▼ Refer
Starting Sampling,  
p. 206
3. Macro Message. (Put 100 g weight on transducer and click OK.)

4. Macro Set Units Conversion. (Set to 100, and set units to g.)

5. Macro Message. (The transducer is now calibrated.)

Once the macro has been recorded and named, it can be invoked 
when starting to record. The message box will appear, at which time 
the user should ensure the transducer has zero grams weight applied to 
it. When the second message box appears, the user should apply 100 
grams weight to the transducer, after which it will be calibrated.

Wait While Sampling

The Wait While Sampling macro command is used to suspend some 
steps in a macro until sampling stops. It can be used at any stage in a 
macro after sampling starts, just by choosing it from the submenu: later 
macro steps are suspended until sampling stops, then continue. 

The Macro Sampling dialog box lets you suspend all other macro steps 
while sampling, or just continue with them while sampling. Sometimes 
this all-or-none choice isn’t enough. For example, you might want to 
start recording, apply some stimuli (which must be done while 
sampling), record the results for a time, and give the user the choice to 
start another cycle of stimulation or stop the macro, using a macro 
message. You would need the alert box to appear only after sampling 
had stopped, not straight after the stimulus, so macro steps would have 
to be suspended at that stage. Choosing a Wait While Sampling step 
before the Message step allows this refinement.

Stop Sampling
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The Stop Sampling macro command is used to stop Chart sampling. 
Choose it from the submenu, at any stage in a macro, to provide a user 
stop (the Start button doesn’t actually start Chart sampling while you 
record a macro, so the Stop button does not appear). In some 
circumstances, if you switch back and forth between recording and 
monitoring, or change multiple settings such as input ranges, this can 
result in the recording of very short blocks between the steps of the 
macro. Stopping sampling using this macro command before such steps 
prevents that problem. 
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Figure 7–27  
The Timed Events dialog 
box.
Timed Events
The Timed Events feature allows you to create a list of actions you want 
to be performed at particular times from the start of recording, including 
setting the analog output or (on specially configured e-corder units) 
digital output: once the list is set up, Chart will perform the actions at 
the times you have specified. Choose Setup > Timed Events… to set up 
a list of timed events. The Timed Events dialog box will appear (Figure 
7–27). 

Click the New button to create a new event row in the scrolling list. To 
set the time from the start of recording at which you want the event to 
occur, click in the cell of the row in the Time column, and enter the time, 
in either seconds (any numerical value) or hours, minutes, and seconds 
(the value in the format hh:mm:ss). The time will be rounded to the 
nearest second, and expressed as hours, minutes, and seconds. For 
example, typing 10 will result in the time being set to 0:10. If you type 
in 120, the value is converted into 2:00, that is, two minutes from the 
start of recording. To set an event to occur at two hours and forty five 
minutes from the start of recording, you would enter 2:45:00. Actions 
can be scheduled for the start or end of recording by clicking the Start 
or End buttons. Alternatively, you can type in the letter S, for start, or E, 
for end, in the time entry field. This is useful for tidying-up tasks, such as 
resetting the analog output. 

Choose an event from the 
pop-up menus in the 
Chart Software

Action column

Enter the time after the start 
of recording that the event 
will occur here

Click here to remove the highlighted rowClick here to add a new 
event row
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Figure 7–28  
The Add Comment 
dialog box.

▼ Refer
Constant Output Voltage,  
p. 66
The timed events list will automatically re-sort rows in chronological 
order once you have finished a new row. This allows you to add new 
events to the list at any time, while being able to view the list in order of 
events. You can have two or more events scheduled at the same time: 
Chart will execute one after the other as quickly as it can. 

Timed Event Actions

Clicking the mouse button when the pointer is in a row in the Action 
column opens the Action pop-up menu of events. Three types of event 
can be chosen: setting an e-corder output voltage; adding a comment; 
and (on specially configured e-corder units) applying a digital output 
configuration.

Choose Action pop-up > Add Comment… to add a comment to the 
recording at a specified time. The Add New Comment dialog box will 
appear. You can type in the comment you want to add, and choose to 
apply it to all channels or to a specific channel through the Channel 
pop-up menu. 

Choose Action pop-up > Set Analog Output… to set the analog output 
voltage level from the Output sockets at the front of the e-corder. The 
Timed Event Stimulator Output dialog box appears, letting you adjust 
the constant output voltage. The amplitude range within which the 
output voltage is set is taken from the Stimulator Constant Output dialog 
box. 
▼ Refer
Comments and 
Exclusions,  p. 117
& Automating Chart 223

Note that ‘Analog Output 2’ events are not available with current 
e-corder models.

If you have previously defined a list of digital output configurations 
(only possible on specially configured e-corder units), they will be 
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Figure 7–29  
The Timed Event 
Stimulator Output dialog 
box.
included as menu commands at the bottom of the Action pop-up menu, 
and can be applied at scheduled times by selecting them as event 
actions.

The ‘Repeat Sequence’ command can be used to make the timed events 
sequence start from the beginning again. When Chart encounters the 
Repeat Sequence action, it goes back to the beginning of the event list 
and performs each event in order, starting the sequence from the time 
for which the Repeat Sequence was set. This allows you to pause 
between repeating events. 

The example in Figure 7–30 shows how the Repeat Sequence can be 
used. It shows the sequence of list events on a time line. The event list in 
the dialog box consists of two actions at the beginning of recording, 
two actions at 1 minute 40 seconds, and two actions at 5 minutes, at 
which stage the event sequence finishes. By placing a Repeat Sequence 
action at 10 minutes, we get the whole sequence repeated again 5 
minutes after the end of the last one. Note that the sequence is repeated 
immediately after the repeat sequence action.

Editing and Saving Timed Events

To add a new event, click the New button again, and create the new 
Chart Software

event you need at the time you want. Once it is entered, Chart sorts the 
event list in chronological order again. To change an existing event, 
select the time or action to change and enter the changes. To remove 
an event, click a row to select it (it becomes highlighted) and click the 
Delete button. Shift-click or Shift-drag to select contiguous rows, or 
Command-click to select or deselect multiple rows singly, for mass 
deletion. If there are entries in the dialog box, timed events will occur 
when you start recording. You have to delete all entries to turn timed 
events off. 

You can save timed events setups in settings files, or as macro steps. If 
you open the Timed Events dialog box while recording a macro, its 
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Figure 7–30  
An example of a repeat 
sequence and the 
associated time line.

▼ Refer
Automatic Comments,  
p. 226
state is recorded as one macro step when you click the OK button, and 
its timed events are made available and used when the macro is 
played, during a sampling step. If various sets of timed events were 
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recorded as steps before sampling steps, different lists of actions could 
be applied during each macro sampling step. 

The Accuracy of Timed Events

The timed events feature is not intended for uses requiring very high 
accuracy. Since it is controlled from the computer, its accuracy will 
depend on how busy the computer is: very fast sampling, a slow 
processor, or running intensive applications in the background may all 
delay it. Holding down a menu while timed events are about to occur 
forces a delay until the menu is released. In general, though, it should 

0:00

5:00

10:00

15:00

20:00

Analog output 0.00 V; pump on

Analog output 2.5 V;
add comment ‘Pump Started’

Analog output 0.00 V; pump off

Analog output 0.00 V; pump on

Analog output 2.5 V;
add comment ‘Pump Started’

Analog output 0.00 V; pump off

Analog output 0.00 V; pump on

Sequences keep repeating 
until recording stopped
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▼ Refer
Comments and 
Exclusions,  p. 117
be accurate to the second entered. If greater accuracy is required, the 
automatic comments feature might be more suitable. 

Automatic Comments
The automatic comments feature lets you generate predefined comments 
while sampling. By setting up a list of comments (in the Automatic 
Comments dialog box) that correspond to certain events, you can have 
Chart automatically insert the corresponding comment when the event 
occurs. The events include certain states or changes of state of the 
e-corder digital inputs, external trigger, or stimulator, so that you can 
keep notes of all such changes during automated recording. The timing 
of automatic comments is very accurate (unlike the timed events 
feature), so it is particularly suitable for this. The events also include 
using Function keys, so that a single keystroke can be used to enter a 
long comment. If you have external equipment to monitor or routine 
analyses to run, then automatic comments can save a lot of time. 

Choose Setup > Auto Comments… to create a list of automatic 
comments. The Automatic Comments dialog box appears. The dialog 
box gives some feedback about the e-corder hardware. The state 
indicators at the top of the dialog box show if the external trigger (Ex) 
is on (highlighted) or off (plain), so that you can observe the effects 
while setting up automatic comments.

To create a new automatic comment, click the New button to add a 
new row to the scrolling list. Type the comment text in the Comment 
Text column of the row. The comment can be applied to any of the 
available channels or to all channels, by selecting the appropriate item 
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from the pop-up menu in the Chan column. 

The pop-up menu in the Event column lets you choose what causes the 
comment in a row to be added. As a shortcut, you can click one of the 
numbered state indicators to apply that bit to a selected row. The pop-
up menu also has an Any Bit option. When this option is selected, 
Chart adds a comment when any digital bit changes.Those rows where 
the comments are activated by digital input bits or the external trigger 
will have a state change icon in the second column. Click the state 
change icon to toggle it up or down, showing the input signal change 
to cause the comment to be added to the recording: up for an off-to-on 
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Figure 7–31  
The Automatic Comments 
dialog box.

▼ Refer
Tool Bar,  p. 190

▼ Refer
Triggering,  p. 55
transition (from a low to a high state), and down for an on-to-off 
transition (from a high to a low state). 

Function Keys

You can choose one of the 15 Function keys (F1 to F15) in the Event 
column, for use with an extended keyboard. Then rather than typing in 
comments in the text entry area at the bottom of the Chart window 
while recording, you can simply press the key to add the assigned 
comment, saving both typing and time. This is useful if you are doing a 
routine experiment or have typical things you note about recorded 
data. Note that Function keys assigned to a button on the Tool bar 
override those same keys assigned for automatic comments.

State indicators, shows 
red when on

Enter the comment here

Choose the channel in which the comment 
will be recorded from this pop-up menu

Click to toggle 
the state icon

Choose the event that adds the 
comment from this pop-up menu
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External Trigger, Stimulator

If you choose the external trigger (Ext Trigger) in the Event column, the 
event comes from an external source connected via the Trigger 
connector on the front of the e-corder. Chart adds the matching 
comment when a TTL voltage pulse (or contact closure) activates the 
external trigger, at the start or end of the event, depending on the 
whether the state change icon is up or down (you could measure event 
width by using both). 
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▼ Refer
The Stimulator,  p. 60
If you choose the stimulator (Stim Mark) in the Event column, Chart will 
add the matching comment when it starts a stimulus. The comment is 
added at the start of each step or ramp. If continuous (repetitive) 
stimulation is chosen, the comment is added at the start of each pulse, 
or the start of each cycle for triangle or sine modes; otherwise it is 
added at the beginning of the set number of pulses or cycles. 
Stimulation starts when sampling starts, for repetitive stimulation, so a 
comment will be added at time zero. This feature helps to avoid having 
both to enter a comment and apply stimulation manually at the same 
time. It works at any sampling rate, up to a stimulus frequency of about 
10 Hz. Unlike the stimulus marker, it won’t add a data spike to a 
channel’s waveform.

Repeating Automatic Comments

You can have more than one comment attached to the same event, in 
which case Chart simply cycles through them. You might want to 
indicate ‘first heating phase’, ‘second heating phase’ in monitoring a 
digital input, say. Chart takes account of the state change icon in the 
second column of the dialog box, so that, for instance, the start and 
end of an external trigger pulse are treated as separate events. 

Repeated automatic comments can also be numbered to help keep 
track of them. If you set up an automatic comment that contains the # 
character, then when this comment is added, an incrementing number 
replaces the #. An automatic comment ‘Pump on #’ would give ‘Pump 
on 1’, ‘Pump on 2’, and so on in the recording. Up to ten independent 
lists of numbered repeat comments can be generated, by adding a 
number (0 to 9) immediately after the # (#0 is the same as just using # 
by itself). To set up a comment that gives the current digital input byte, 
Chart Software

use #D in the comment text column.

Editing and Saving Automatic Comments

To create a new automatic comment, click the New button. To change 
an existing comment, select the text and type over it; to change the 
event, choose another from the Event column. To delete an automatic 
comment, click a row to select it (it becomes highlighted) and click the 
Delete button. Shift-click or Shift-drag to select contiguous rows, or 
Command-click to select or deselect multiple rows individually, for mass 
deletion. If there are entries in the dialog box, automatic comments will 



Chapter 7 — Customizing 

Figure 7–32  
The e-corder Startup 
dialog box.

▼ Refer
Figure 1–2, p. 4
be applied as set up when you start recording. You have to delete all 
entries to turn automatic comments off. 

You can save automatic comments setups in settings files, or as macro 
steps. If you open the Automatic Comments dialog box while recording 
a macro, its state is recorded as one macro step when you click the OK 
button, and its comments list is made available and used when the 
macro is played, during a sampling step. If various sets of automatic 
comments were recorded as steps before sampling steps, different lists 
of comments could be applied during each macro sampling step. To 
change the list, you must first stop recording. 

Choosing a Connected e-corder
Usually a single e-corder is connected to a computer. It is possible, to 
use multiple copies of Chart, and connect multiple e-corders to one 
computer. Each copy of Chart can be assigned to work with an 
individual e-corder.

e-corder Startup

You control the way in which the software starts up by changing the 
default settings in the e-corder Startup dialog box. Choose Chart > 
Preferences > e-corder Startup… to open the dialog box. 

If the top radio button in the dialog box is on, the software always 
starts in analysis mode without even looking for an e-corder; this avoids 
the ‘e-corder Unavailable’ dialog box, and is useful if you are using 
Chart on a computer without an e-corder attached (for example to 
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review and analyse existing data files).
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The Choose e-corder 
dialog box.

Figure 7–34  
The Change e-corder 
Name dialog box.
Choosing and Naming an e-corder

If you have multiple e-corders connected to your computer then you can 
hold down the Option key as Chart starts up to open a dialog box that 
lets you choose which one to use. This could be useful if you have the 
e-corders set up for particular tasks and don’t want to disconnect or 
reconnect them. 

To choose a connected e-corder, click it in the scrolling list. Click the 
OK button to start up Chart with the chosen e-corder. If you click 
Cancel, a dialog box appears letting you choose to work in Analysis 
Figure 7–33  
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mode. 

You can also name an e-corder selected in the scrolling list by clicking 
the Change Name… button. A dialog box appears: enter a name in 
the text entry box to replace the default (model) name and click the OK 
button to apply it. 

Naming an e-corder is useful if you have several e-corders of the same 
type. The e-corder stores the name and can be identified by it whenever 
it is connected.
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If you do record on multiple copies of Chart simultaneously, you may 
need to synchronize the recording. To do this, use the same triggering 
setup in each Chart file, and use an external triggering device 
connected in common to the trigger input at the front of each e-corder 
to start recording.
& Automating Chart 231
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Menus & Shortcuts
Menus
The menus shown here are the default settings, and your copy of Chart 
may be set up differently, since Chart menus can be extensively 
customized. Chart has seven menus: Chart, File, Edit, Setup, 
Commands, Macro and Window; macros, Chart extensions can add 
more. Some of the menu commands shown will change or be disabled 
233

depending on the active window and what, if anything, is selected. An 
ellipsis (…) after a menu command indicates that it opens a dialog box; 
a tick to its left indicates that it is currently active; and a keyboard 
equivalent, if there is one, is shown to its right.

Display system and hardware configuration information

Customize Chart options (see submenu)

Use Mac OS X services

Hide the Chart Application
Hide other applications

Quit Chart

Show all applications



Choose how Chart looks for e-corder

Choose trigger event: voltage level or contact closure

Set up the Tool bar
Choose shape of the Waveform Cursor
Modify Chart menus
Figure A–2  
The Preferences 
submenu.
Figure A–3  
The File menu.

Modify various Chart features and settings

View, add and remove Chart licenses
Choose which Chart extensions to use

Change the size of the memory cache
Choose to store data on disk or in memory

Save current settings as default settings

View a list of your experiment and supporting files

Create a new Chart file
Open an existing file
Append an existing file to the current file

Close the current file
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Save the current file
Save file with a new name, or location, or format
Save the current selection as a separate file
Set up Chart to save automatically

Set up file information to search for

Search for Chart files by file information or comments

Set up page size and so on to suit the printer
Print all data (or active window)

Undo previous action (if possible)

Cut selected data to the Clipboard

Copy selected data to the Clipboard
Paste selection
Clear selection
Select all data

Clear all data in a channel

Show Clipboard

Figure A–4  
The Edit menu.



Figure A–5  
The Setup menu. Modify display settings, grids, lines, etc.

Change channel display and input settings

Set up what triggers and stops sampling
Auto-zero any connected Bridge or GP Amp

Set up the stimulator
Display the stimulator control miniwindow

Set the stimulator constant output voltage

For future e-corder models
For future e-corder models
List actions to be performed at certain times
Figure A–6  
The Commands menu.

Add predefined comments with a shortcut key

Comment on the selected point or area
Set Marker position (see submenu)

Add information on selected point or area to Data Pad

Set scale zero to active point, or average of selection
Revert to settings before baseline set up

Exclude the selected point or area 
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Figure A–7  
The Set Marker submenu.

Auto scale the amplitude axis in all channels

Find and select data matching user criteria
Find and select next data matching user criteria

Set Marker to lowest point in selection
Set Marker to highest point in selection
Set Marker to left-most point in selection
Set Marker to right-most point in selection



Figure A–8  
The Window menu.

Display Notebook window, for general notes 

Return to or open the Chart window

Display a selection in the Zoom window

Display the X–Y window

Display the Comments & Exclusions window

Display all data for a channel in a miniwindow

Display the Data Pad, for setup or analysis

Display a time/date/value miniwindow
Display data logged from DVM miniwindows
Display the Spectrum window
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Figure A–10  
The Macro Commands 
submenu.

Figure A–9  
The Macro menu.

Start or stop recording a macro

Choose macro control actions (see submenu)

Delete a macro from the current list of macros

Redraw the screen during playing of macro

Pause the macro for a set time 

Set an audible alert using the System sounds

Display a message dialog box
Speak a written message
Add an AppleScript as a macro step

Repeat some action while selection is within a block
Repeat some action within a selection
Select regular periods of data to manipulate
Select each block of data to manipulate
Start a repeat sequence
Finish a repeat sequence or repeat select sequence

Change the scale units within a macro

Leave remaining macro steps until sampling finishes

Stop Chart sampling
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Table A-1:  
Chart keyboard and 
other shortcuts: the 
table is divided into 
named groups of 
related shortcuts for 
convenience.
Shortcuts and Tips
Actions in general apply to the Chart window. Keyboard shortcuts for 
menu commands can be added, changed, or assigned to user-defined 
actions (menu commands are listed alphabetically by shortcut so that 
you can see at a glance which keys have been used). Some of the 
shortcuts shown will change or be disabled depending on the active 
window and what, if anything, is selected.

Menu Commands

Action Shortcut

Select all Command + A
Clear selection Command + B
Copy to Clipboard Command + C
Add information to Data Pad Command + D
Mark data to be excluded from analyses 
and so on

Command + E

Find and select data matching user criteria Command + F
Find and select next data matching user cri-
teria

Command + G

Hide Chart Command + H
Add comment Command + K
Comments & Exclusions window Command + L
Overview miniwindow Command + M
New Chart data file Command + N
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Open file Command + O
Print Command + P
Quit Chart Command + Q 
Start/stop macro recording Command + R 
Save file Command + S
Paste Command + V
Close active window Command + W
Cut selection Command + X
Channel Settings dialog box Command + Y
Undo/redo Command + Z
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Navigation

Selecting Data

Action Shortcut

Scroll left or right Left or Right arrow
Go to previous or next block Option + Left or Right arrow
Go to start or end of file Command + Left or Right arrow
Manually scroll data display 
area

Option + drag the area (Chart or 
Zoom window)

Auto-scroll data display area Option + drag the area, let go while 
dragging

Go to a block Click the block button
Go to a comment Double-click comment in Comments 

& Exclusions window
Go to any section of data dis-
play area

Drag highlighted region in Over-
view miniwindow

Center off-screen selection Command + click in Zoom window

Action Shortcut

Set active point in a channel Click in channel
Set active point over all chan-
nels

Click in Time axis

Select area in a channel Drag in channel
Extend selection in a channel Shift + click in channel
Select full height of a channel Command + drag in channel
Select area of additional chan-
nel

Shift + drag in additional channel
 Chart Software

Select full height of additional 
channel

Command + Shift + click in addi-
tional channel

Select same relative height of 
additional channel

Option + Shift + click in additional 
channel

Select area over all channels Drag in Time axis
Extend selection over all chan-
nels

Shift + click in Time axis

Deselect selected channel Shift + click in channel
Select a block Press the block button and choose 

Select Block, or double-click in 
Time axis



Appendix A — Menus & S
Starting up Chart 

Display 

General 

Action Shortcut

Choose the extensions to load Hold down Space Bar while Chart 
starts up

Use the default settings for a 
session

Hold down Command key while 
Chart starts up

Action Shortcut

Revert shifted or stretched vertical 
scale

Double-click in Amplitude axis

Cycle through scale display 
modes

Double-click repeatedly in Ampli-
tude axis

Hide split bar (show Chart win-
dow with one pane)

Double-click split bar

Give each channel the same 
area

Double-click any channel separa-
tor

Overlay adjacent channels Option + click their channel sep-
arator

Separate overlaid channels In Channel Settings dialog box, 
turn on their Separator checkbox

Move Tool bar Shift + drag Tool bar
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Action Shortcut

Select/deselect adjacent items in list Shift + click in list
Select/deselect separate items in list Command + click in list
Move between text entry fields in dialog 
boxes

Tab

Accept (OK) dialog boxes Return
Cancel dialog boxes Esc key or Command + . 

(period)
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Miscellaneous 

Action Shortcut

Start/stop sampling (on most systems) Command + Space Bar
Stop process (sampling, macro playing, 
drawing, etc.)

Command + . (period)

Bring up last chosen channel calculation 
dialog box

Command +  =

Special access to dialog boxes (Menu, 
Save As, etc.)

Command + \ or Con-
trol + Command + 1

Delete selection Delete
Add information on a data point to Data 
Pad

Double-click in channel

Show recording settings information for a 
channel

Click Channel Status dia-
mond

Show block information summary for a 
channel

Click in data display 
area of channel

Make channel-specific comment while 
sampling

Tab, type channel num-
ber, comment, then 
Return

Make non-specific comment while sam-
pling

Tab, type any letter, 
comment, then Return

Send Marker home Double-click Marker, or 
click Marker box

Transfer data from display to initial volt-
age values in Units Conversion dialog 
box

Double-click in its data 
display
 Chart Software

Activate Stimulator Panel buttons to start 
or stop stimuli

Option + Space Bar

Maximize image in Page Layout dialog 
box

Double-click image

Set/Remove baseline over whole channel Command + choose 
Commands > 
Set/Remove Baseline

Turn channel and all below it off or on In Channel Settings dia-
log box, Command + 
click the On checkbox
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There are many other general Macintosh shortcuts, of course, such as 
the set available in the Open and Save dialog boxes. See the 
Macintosh system help for details.

Turn channel and all below it off, or those 
with visible data on

Command + choose 
Channel Function pop-up 
> Turn Channels Off/On

Apply channel calculation permanently to 
a channel

Command + choose 
Channel Function pop-up 
> Apply Calculation…

Action Shortcut
hortcuts 241
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Troubleshooting

Technical Support
Chart has been extensively tested to make sure that it runs smoothly and 
without difficulties. Occasionally, however, problems may arise or 
something unexpected may occur. The second part of this appendix 
gives a list of possible problems and likely solutions: you should look 
there first to see if your needs are addressed specifically. (This can save 
you some money in telephone calls or faxes!) 

If you are experiencing difficulties with Chart that are not covered in 
this manual, or you need technical assistance with your e-corder system 
in some form, then eDAQ and its authorized distributors are glad to 
help. The About Chart dialog box gives access to contact addresses 
and information on the system and hardware configuration. Choose 
Chart > About Chart… to open it. 
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Release date

Click these buttons for 
information on contacts, 
Chart extensions and 
hardware configuration
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Figure B–2  
The eDAQ Contacts 
dialog box.
Dealer and Distributor Information

If you need help or information from an eDAQ distributor, click the 
Telephone button to open the eDAQ Contacts dialog box. Feel free to 
get in touch with your local eDAQ distributor to discuss hardware and 
software requirements generally, and find out more about the latest 
releases, upgrades, and software maintenance information. You can 
also visit the eDAQ web site for general information of this nature. 

The dialog box should have up-to-date contact information. Click in the 
scrolling list on the left of the dialog box to select your country, or the 
nearest one to it, and contact information will appear to the right. Click 
the Copy button to copy the information to the Clipboard, to save 
typing it out. 

The Web and email addresses in this dialog box, and the Web 

Click on links
 Chart Software

address are hyperlinks. Clicking a link will open your web browser and 
take you to the web site, or open your email program and fill in the 
mailing address for you.

System Configuration Information

In general, we will need quite specific information about your hardware 
and software to help to isolate and to solve problems effectively. Since 
this type of information can be tedious to collate, Chart does it all for 
you. Click the computer button to open the About this Macintosh dialog 
box. 
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Figure B–3  
The About this Macintosh 
dialog box.
The dialog box has four tabs. The Chart tab gives information on which 
version of Chart is running, together with information about your 
computer and operating system. The Licenses tab lists your current 

The Hardware tab lists 
details of the e-corder, 
and any eDAQ Amps or 
pods connected

The Chart tab lists details 
of the software version 
and computer
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license for Chart and you have installed (this information is also 
available in the License Manager dialog box). The Extensions tab lists 
installed Chart extensions, if any. The e-corder tab contains details of 
your e-corder and how it is connected, as well as any connected eDAQ 
Amps and pods. If the e-corder has any pod connections without pods 
connected, they are listed as ‘Input Amplifier’. Click the Print… button 
to print a tab, or the Copy to Clipboard button to copy the text for 
pasting into an email, letter or fax to your eDAQ distributor. 
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General

We welcome customer comment. If you have comments or suggestions 
you would like to make about the Chart Application or this manual, 
please feel free to write to us directly at info@eDAQ.com. We value 
your responses, and they are taken into account when future releases 
are being worked on. 

Solutions to Common Problems
Chart has an extensive array of dialog boxes which appear in most 
cases where problems arise. Very often they will suggest appropriate 
courses of action. Otherwise this section of the manual may prove 
useful. 

Starting Up

Startup errors are mostly hardware problems, and are dealt with in 
detail in your e-corder Manual (supplied as a pdf format file) but are 
briefly covered here. 

The computer can’t find the e-corder

• The e-corder is off or the power is switched off at the wall, the 
power cable is not connected firmly, or a fuse has blown. Check 
switches, power connections, and fuses. 

• A poor connection between e-corder and computer, or bad cable. 
Ensure that the cable is firmly attached at both ends and try again. If 
 Chart Software

there is still a problem, try a new cable. 

• The software preferences are set to start up in analysis mode or 
only using a certain connection. (e-corder settings are common for 
Chart and Scope, so this could have been set in either program.) If 
the ‘e-corder Unavailable’ dialog box has appeared, click the 
Options… button in it to open the e-corder Startup dialog box so 
that you can change the settings. Otherwise choose Chart > 
Preferences > e-corder Startup… to open the dialog box. 

Chart ‘hangs’ or gives an alert on start-up

• It may be that the copy of Chart on your computer has become 
damaged in some way. Try reinstalling Chart from the original CD. 
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Chart starts up with strange settings and macros

• If you started Chart by opening a settings file or a data file with 
custom settings start up again from the Chart program itself.

• If the startup settings have been customized start up Chart with its 
default settings, by hold down the Command key as you open the 
software. Release the key when an alert box appears. 

• To revert to the default startup settings, choose Chart > 
Preferences > Startup… and click Clear in the dialog box that 
appears. The next time Chart starts up, it will open with the default 
settings. 

Interface Problems

Some data display areas show gray

• Chart channels show gray if they are turned off while recording, 
or if they are monitoring rather than recording, or if they are very 
thin. Most dialog boxes and windows require a selection of data in 
the Chart window to display a waveform (not just an active point). 
The X–Y window needs to have the x and y channels selected to plot 
against each other. The Zoom window and Overview miniwindow 
show gray if they were stopped while drawing. 

• Turn the channel on, switch from monitoring to recording, or drag 
the channel separator to widen it; select data in the Chart window if 
there is no selection; click x and y numbered buttons in the X–Y 
window to get an X–Y plot; click the display area in the Zoom 
window for it to redraw; click the display or a numbered button in 
the Overview miniwindow for that to redraw. 
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The Time axis shows very large or negative values

• The file with which you are working is an old one with new data 
recorded in it, or one created by appending files or selections, and 
the time is displayed from the start of the record. Chart remembers, 
but does not display, the date and time of all recordings. Hence a 
section recorded before the one at the start of the file and 
subsequently appended to it, say, will appear with a negative time 
relative to the start of the record. Very large values to the right of the 
Time axis reflect a large lag between the time the record was 
created and the latest recording. 
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▼ Refer
Choosing Unit Names,  
p. 50
• If the values are a problem, simply change the time mode display 
to show time from the start of each block (the default setting). 

Defined units display strangely

• Chart will deal with a unit prefix correctly only if it is chosen from 
the Prefix pop-up menu in the dialog box for defining units: if 
defined as part of a unit, it is ignored. Take a tesla (T), the standard 
unit of magnetic flux density. If you type in mT as one word with no 
prefix, then Chart will display a waveform of a thousandth of a mT 
with units of mmT. If the prefix m were chosen, Chart would scale 
the unit prefix properly, to give measurements in µT. 

• The indentation of defined units in the Unit pop-up menu in the 
Units Conversion dialog box shows if a prefix has been used 
properly.

Commands seem to have no effect, or a strange one

• If commands do not work in all circumstances, or if you have no 
selection or active point in the Chart window (for example, you 
cannot use commands to do with selections or active points, such as 
adding data to the Data Pad or printing a selection) then make sure 
you have a selection or active point in the Chart window, or 
otherwise have things appropriately set up. 

• If Macro recording has been turned on, then you record what you 
are doing rather than actually doing it. Choose Macro > Stop 
Recording… and discard the macro. 

Keyboard shortcuts don’t work, or do strange things

• Menu commands may have been deleted, or keyboard shortcuts 
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reassigned to other menu commands or macros. Look at the menus 
and compare them with the tables in Appendix A. See below for 
resetting procedures. 

Menus, controls, or settings don’t match those in this guide

• If you started Chart by opening a settings file or a data file with 
custom settings start up again from the Chart program itself.

• If the startup settings have been customized start up Chart with its 
default settings, by hold down the Command key as you open the 
software. Release the key when an alert box appears. 
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▼ Refer
Setting Sampling Rates,  
p. 36
Performance,  p. 31
• To revert to the default startup settings, choose Chart > 
Preferences > Startup… and click Clear in the dialog box that 
appears. The next time Chart starts up, it will open with the default 
settings.

• Chart extensions may also add menus and alter some options. To 
start up Chart and choose which Chart extensions load, hold down 
the space bar while Chart opens. Release the key when the 
Extensions Manager dialog box appears. To stop particular Chart 
extensions being loaded at all, move them from the Extensions folder 
into the Extensions (Unused) folder (or make another such folder to 
suit your needs). 

I’ve altered menus and locked myself out, can’t save, and so on

• Type Command-\ or Command-Shift-1 to open a dialog box that 
allows special access to menu, Tool bar, control, startup settings and 
saving options.

Dialog boxes don’t appear where I want them

Chart dialog boxes usually appear on the main monitor (the one with 
the menu bar). There are times, however, when you want one to 
appear on a secondary monitor, for instance, if that monitor is color 
and you are changing display colors. 

• Chart usually opens dialog boxes on the monitor where the 
pointer is positioned. Move the pointer to a secondary monitor and 
use a keyboard shortcut to open the dialog box there (if there is no 
shortcut, add one or define a macro with one to do it). 

I keep getting alerts saying the sampling rate is too fast
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• Chart has a maximum continuous sampling rate of 200 000 
samples per second on one channel, 80 000 rates on two, and 
40 000 on three or four. The external trigger can’t be used at a 
sampling rate of 200 000 /s. Turn off the external trigger when 
sampling at 200 000 /s, reduce the number of channels used at 
fast rates, and so on. 

• Faster computers allow better sampling rates on more channels, 
slower computers may limit recording speed. A USB 1.1 computer 
may not handle the very fastest sampling rates.
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• Turn off unused Chart extensions, channels, computed inputs, and 
filters. This will decrease the workload for the computer. 

• Channels do not need to be visible to record data, so check that 
any bunched up in the Chart window are actually off.

• Change the size of the memory cache (choose Chart > 
Preferences > Memory Cache… to open the Memory Cache dialog 
box.

• If the Chart window is large and the display is at a high color 
depth, more processing power is needed to draw it. Shrink the 
Chart window and reduce the color depth of the display. 

• Miniwindows floating over the data display area will slow down 
sampling rates, especially if they overlap multiple channels. 

• Keep miniwindows away from the data display area, turn them 
off, or make sure they keep to only one channel. 

• Background activities (other programs and devices) can reduce 
the ability of the computer and connection to cope with recorded 
data. Turn off programs other than Chart that could slow down or 
(as in the case of electronic mail) interrupt data sampling, and don’t 
use too many devices at once, especially on a USB chain. 

• When recording to disk, ensure that your disk is not too full and is 
not fragmented: this slows down the speed of writing to disk. 

• Recording to RAM (if you have enough) may be better for slower 
computers. 

Nothing seems to be recording

• The Record/Monitor button (bottom right of the Chart window, by 
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the Start button) may be set to monitor; there will be a cross through 
it if this is so, the Recording Status indicator (above the Time axis) 
will read ‘Not Recording’, and incoming channels will be grayed. 
Click the Record/Monitor button to make the cross disappear, and 
then data shown on screen will be recorded normally. If the button is 
not visible, then use the Controls dialog box (Edit > Preferences > 
Controls…) to show it. 

• Chart may be recording, with nothing visible going on. This 
happens if Chart is reviewing rather than scrolling. If so, the 
Scroll/Review button will be highlighted (depressed), the Recording 
Status indicator will read ‘Recording’, and the scroll bar replaces 
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the Comments bar. Click the Scroll/Review button to change its state 
and record normally. 

• You may be sampling at a very slow rate with a highly 
compressed horizontal scale, so that it takes a long time for data to 
appear. Check sampling rates and View buttons, and change as 
needed.

• Chart may be waiting for a trigger event or its internal timer: in 
this case the Recording Status indicator, above the Time axis, will 
read ‘Waiting for trigger’ or ‘Int. Timer’ or something similar. Values 
in the Range/Amplitude display may still change with the input 
signals. The e-corder also indicates it is waiting for a trigger. Supply 
the necessary trigger event, or choose Setup > Trigger and set the 
Event in the Trigger dialog box to User. 

The computer ‘hangs’ while recording, or there is data loss

• There may be a poor cable connection between the e-corder and 
the computer, or a bad cable. Ensure that the cable is firmly 
attached at both ends and try again. If there is still a problem, try a 
new cable.

• Network connections or a strange system extension could also be 
at fault.Check your network connections and system extensions. It 
recommended to avoid using the intenet, email, or other network 
connections whilst collecting data.

Running out of memory

• You may be recording to RAM rather than to disk. Record to disk 
instead — choose Chart > Preferences > Data Buffering…
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• Chart extensions use up allocated memory and may slow down 
Chart as well: only use those that you need. Turn off unnecessary 
Chart extensions (choose Chart > Preferences > Extensions… to get 
the dialog box), then quit and restart Chart. 

• Chart uses a reasonable amount of memory for an off-screen 
buffer: if the Chart window is large, more memory is used, 
especially at increased color depths. Shrink the Chart window and 
reduce the color depth of your display.
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Comments are truncated when printed

• Turning off the Show Times checkbox in the Comments window 
will allow a little extra space for printing comments either at the end 
of a Chart file or on their own. 

• Comments are only designed for short notes, but if they are still 
too long to print after trying the above remedies, then transfer them 
as text to a word-processing program.

Printing is very slow

• Reduce the color depth of your display, and compress your file 
using the View buttons to minimize the number of pages that must 
be printed. Ensure that you are using the latest printer driver.

• The Page Setup options affect printing speed. Experiment with 
them to see which give best results. For a PostScript laser printer, 
Substitute Font should be on. In general, the Faster Printing option is 
most useful for older, slower computer systems; new systems should 
print Chart files more quickly with it off.

• When setting the Layout options in the Print dialog box leave the 
Layout option at printing one page per sheet, since the scaling can 
be quite slow. 

The quality of the hard copy using faster printing should be sufficient for 
most purposes except publication. Printing speed depends on hardware 
as well: the faster the computer and printer, the faster that material can 
be printed. 

Macros behave unexpectedly
 Chart Software

• Make sure that you have the right macro, not a different one of 
the same name (in the case of name conflicts, the latest macro 
loaded into memory is used). 

• Check that you have the steps and effects recorded somewhere, 
and that you haven’t misremembered them — it is very easy to do. 

• If the macro is a new one, it is possible that a step was not 
recorded correctly, and in particular, that a repeated sequence was 
ended in the wrong place. Try recording it again. 
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I have macros in files where I don’t want them

• A macro, once created, floats around in memory until it is 
discarded or you save a file, whereupon a copy is saved with the 
file. If you have opened many files containing macros, you may end 
up with a lot in memory. 

• Ensure that the Discard Existing Macros checkbox in the Open 
dialog box is on. This prevents accidental accumulation of unwanted 
macros as you open files. 

• Delete unwanted macros using the Macro > Delete Macro… (this 
action merely removes macros from memory) and then save the file 
you want free of them (this removes them from the file). 

I created a macro, but lost it on quitting Chart

• Macros are saved when a file is saved. The macro may have 
been attached to another file, or lost if you didn’t save a file before 
quitting Chart. 

Chart can’t seem to recognize a Chart file

• You may be using an early version of Chart with a later version’s 
file. File formats can change between versions, so software cannot 
always read later files. Newer software updates files when it opens 
them. Always use the latest version of Chart. 

• The file may have become corrupted, possibly through disk 
damage.Use disk-checking software to find and fix the problem. 

• If you back up files onto a computer using the Windows OS, be 
careful. Try to make sure the files are only handled from the Mac 
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OS. Windows systems typically do not understand Macintosh files, 
and may discard information such as the file type or resource fork if 
the files are manipulated by the OS or an archiving program.

• Chart files should still be recoverable even if the file type and 
resource fork are lost. It may be necessary to add “.cfm” to the file 
name in the Finder to force Chart to recognize it as a Chart file. 

Chart quits unexpectedly, crashes, or freezes

• If Chart quits unexpectedly or crashes, or the pointer freezes, then 
there may be a Mac OS system problem. See the guide to the Mac 
OS that came with your computer for details on this problem and 
how to deal with it.
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• The file you are using may have become corrupted, possibly 
through disk damage. Use disk-checking software to find and fix the 
problem. 

• Try reinstalling Chart from the original CD. 

• Check your disk with anti-viral software. If you find a virus, you 
should check all potentially affected computers, disks, and backups, 
and eliminate the infection.

• Check to see if the problem occurs again. If so, note down what 
you were doing as fully as possible (use the About this Macintosh 
dialog box, and add any relevant details, such as sampling rates 
and the like) and notify eDAQ. 
 Chart Software
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Note
Chart checks itself on 
startup for damage or 
virus infection, and will 
present an appropriate 
alert box if it detects a 
problem. (Files are not 
checked, though.) 
 Chart Software
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Technical Notes

Calculation Details
Depending on your data it may be useful to know the mathematical 
details behind some of Chart’s analysis functions, in order to get the 
best use out of them. This appendix gives details of the algorithms used 
by the Spectrum window. It also explains why the results of computed 
input functions and corresponding channel calculations may differ.

The Spectrum Window FFT

Physical phenomena can be described in terms of time or its inverse, 
frequency. The functions describing a phenomenon in the time domain 
or frequency domain are effectively equivalent, and one can switch 
between them using certain linear transforms. Spectrum uses a discrete 
Fast Fourier Transform (FFT) algorithm to convert data from time to 
257

frequency domains. 

Spectrum divides the data into segments, with the number of data 
points in each segment equal to a power of two (a requirement of the 
algorithm): this is the FFT Size shown in the Spectrum Settings window. 
Once a selection made in the Chart window is divided up into 
segments of this size, the transform is applied to each segment to 
calculate its spectrum. The spectrum plotted is the average of these 
partial spectra. Averaging improves the amplitude accuracy over a 
large selection.
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Figure C–1  
A selection of 968 data 
points with FFTs of 256 
(no overlap) divides into 
3 FFTs with 200 left over, 
so Spectrum adds 56 
zeroes at right to pad out 
data for the fourth FFT.
If the number of data points selected does not divide up exactly into a 
whole number of FFTs, and the selection is unadjusted (‘Use Current’ is 
chosen in the settings), or if not enough points exist within a data block, 
the remainder is padded with zeroes, which are added to the right side 
of the remaining data points of the selection before the transform is 
applied. The Spectrum window shows selection information above the 
graph area: the number of FFTs, the number of data points per FFT, and 
either the number of padded points (if any), or whether the selection 
was adjusted to give an integral number of unpadded FFTs. (This 
information changes with Spectrum’s settings.) 

Spectrum’s Implementation of the FFT

+56 padded 
zeroes

Selection = 968 data points

256 256 256 200

FFT FFT FFT FFT

Average

Display
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The treatment here is only a summary; see Press et al.1 for a more 
complete discussion. Chart takes samples at discrete intervals set by the 
sampling rate. If we look at a sequence of N consecutive samples, 
where N is an even number (for simplicity), with a sampling interval ∆, 
we can define a function hk ≡ h(tk) where the time when sample k is 
taken, tk ≡ k∆, and k is the series 0, 1, 2, … N–1. It is assumed that the 
function that describes the sampled points is representative of the entire 
waveform, that is, that there is some form of periodicity. The FFT 
transforms these N discrete samples in time, with h voltage (or derived 
units), to N discrete samples in frequency, with H frequency amplitude. 
The frequencies can be assigned the discrete values fn = n/N∆, where 
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n is the series –N/2, …, N/2–1. The discrete Fourier transform of the 
N points hk is defined by:

This transform maps N complex numbers hk into N complex numbers 
Hn (for data measured from physical phenomena, such as Chart deals 
with, numbers hk are real with the imaginary part set to zero). Hn are in 
the frequency domain, since the horizontal axis is measured in units of 
1/∆, which represents frequency. Zero frequency corresponds to n = 0; 
positive frequencies correspond to values 1 ≤ n ≤ N/2–1. The function 
can be seen to be periodic in n with period N, with H–n = HN–n for 
values of n other than zero. One can let the n in Hn range from 0 to 
N–1 so the correspondence between k in the time domain and n in the 
frequency domain is more obvious, but we don’t for this treatment.

If Re(Hn) and Im(Hn) are the real and imaginary parts of the nth 
frequency component of the FFT, then the power (modulus squared) of 
the nth frequency component of the spectrum may be expressed as:

The amplitude (modulus) of the nth frequency component of the 
spectrum is then:

where the factor 2 converts from RMS value to amplitude. 

Note that the accuracy with which FFT can resolve frequencies depends 
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on the sampling rate 1/∆, and the number N of points sampled. If a 
frequency reading is not an integral multiple of 1/∆N Hz, then it will 
be resolved into peaks above and below that value, distorting the 
result. Keeping N at a large value minimizes these problems.

Windowing Functions

The FFT assumes that samples represent an integral number of cycles of 
a periodic waveform. The assumption of perfect periodicity can lead to 
problems. If, say, the first and last values of a waveform seen in the 
sampling window do not join smoothly together, then a spurious 
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Figure C–2  
Windowing functions 
used by Spectrum and 
their definitions: k is a 
value between –N/2 
and N/2–1, where N is 
the number of sampled 
points.
frequency reading will be detected at the edge of the sampling window 
by the FFT: this is known as an edge effect. Windowing functions 
reduce the importance of data at the edges of the window used by the 
FFT, thus preventing spurious peaks arising from edge effects. If a 
windowing function is used, the original data are multiplied by the 
windowing function w(k) to weight them:

Four of the more useful windowing functions have been provided in 
Spectrum, as shown in Figure C–2 (there are many others, as discussed 
in Reference 1). To compensate for the attenuation due to a windowing 
function when one is in effect, all power values P(n), calculated as 
shown earlier, are multiplied by a factor 
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Zero-padding

If Spectrum’s internal data selection is not a multiple of the chosen FFT 
size, the data size is extended to the right by padding it with zero 
values. Windowing functions are applied to the true data, before its 
length is extended by zero-padding.

Computations with Computed Input 
Functions and Channel Calculations

There is some overlap in functionality between computed inputs and 
channel calculations. The cyclic rate and cyclic amplitude computed 
input functions are duplicated as options in the Cycle Variables channel 
calculation (except for Counter, which is represented by the Cycle 
Variables Data Pad functions Event Count and Cycle Count); the 
Differential computed input function is duplicated as the Differential 
channel calculation; and the five integral computed input functions have 
corresponding options in the Integral channel calculation. (Note, 
however, that the two smoothing computed input functions provide a 
different computation to the Smoothing channel calculation.)

In addition to differences in the way computed inputs and channel 
calculations are used (computed inputs are used online while channel 
calculations are principally used offline, for instance), the results yielded 
by the two may differ. There are three factors, which may or may not 
contribute depending on the type of computed input/channel 
calculation used. Which factor affects which type of computed 
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input/channel calculation is summarized in Table C–1.

1. The sampling rate used for computation may differ. Computed 
inputs will always have a precision based on a sampling rate of 
2000 Hz or higher — the speed at which Chart samples internally 
for these computations, even if a lower sampling rate is chosen. 
Since channel calculations operate offline, they are based on the 
sampling rate set for the channel. If the sampling rate is 
≥ 2000 Hz, the precision of results calculated using computed 
inputs and channel calculations will be the same, but if the 
sampling rate is < 2000 Hz, then the precision of results computed 
using channel calculations will be less than those using the 
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Table C–1  
Factors contributing to 
different results from 
computed inputs and 
channel calculations, for 
different types of 
computation.
computed inputs. This difference affects all corresponding computed 
inputs and channel calculations.

2. Computed inputs must use data as they are acquired, whereas 
channel calculations are able to use data in a ‘window’ extending 
either side of any particular data point. This affects cyclic 
computations, because computed inputs must show results for the 
previous cycle, whereas the Cycle Variables calculation can show 
values for the current cycle. It also affects the Differential computed 
input function and channel calculation, because neighboring points 
are used in the numerical calculation of a derivative. This is not a 
factor for the integral computed functions and the Integral channel 
calculation, which do not rely on a window of points.

3. Computed inputs and channel calculations differ in their method of 
cycle detection. The former use a threshold and hysteresis function, 
while the latter use local maxima or minima. This affects cyclic rate 
and cyclic amplitude computed input functions and the 
corresponding Cycle Variables channel calculation options.

Factors contributing to differences between com-
puted inputs and channel calculations

Computation 
type

Sampling rate Use of ‘win-
dow’ data

Cycle detec-
tion method

Rate x x x
Cyclic x x x
Differential x x
Integral x
 Chart Software
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Experiments Gallery 
Configuration Files 

You can customize the appearance of files that are shown in the 
Experiments Gallery, by adding text labels, hiding files, choosing a 
default selected file, and so on. This is done on a folder-by-folder basis 
by adding a configuration file called 'labels.ini' to the appropriate 
folder.

The configuration file is a text file containing ‘sections’, ‘key lines’ and 
(optionally) ‘comment lines’ (see below for an example).

Note: Character case is unimportant for section and key names, but is 
preserved in key values.

Sections
A section starts with a line containing a section name in square 
brackets, and is followed by key lines. Most section names consist of 
263

filenames (for example, [Electroencephalography] would be the section 
name for a Chart data file named ‘Electroencephalography’) and are 
used to control the appearance of the entry for the file with that name in 
the Experiments Gallery dialog box. The order of the filename sections 
in the configuration file is the order the entries are shown in the file list. 
Files in a folder that do not have sections in the labels.ini file are shown 
in the file list after the files that do have entries.

The section name [folder] is optional and is followed with a key line 
whose value is text that will be shown in the information area in the 
Experiments Gallery dialog box. This text is usually used to give a 
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general description of a folder. If this section is omitted the info area is 
not shown. 

Key Lines
A key line contains a key name followed by an equals sign and a key 
value. Spaces around the key value are ignored. The following keys 
may be used within a filename section:

Text. This key provides the text to be shown as additional description 
text for the file.

Flags. Various options used to control some of the behavior and 
appearance of the entry for a file. Available flags are:

• Bold. Show the label (filename and descriptive text) in bold face.

• Default. Make the file selected in the file list whenever the relevant 
folder is selected in the Experiments Gallery dialog box.

• MacOnly. Only show this entry on a Macintosh system.

• WinOnly. Only show this entry on a Windows system. (When 
creating labels.ini files that will be used on Windows, you need to 
create them in a text editor that can insert line feed characters.)

• Hide. The entry is not shown in the file list.

Comment Lines
A comment line starts with a semicolon (";"). Comment lines may be 
 Chart Software

placed anywhere in the configuration file and are ignored when Chart 
reads the file. Blank lines are ignored and are useful for visually 
separating sections.



Appendix A — Experiment
Example
Below is the text of a typical configuration file. The corresponding 
appearance of the Experiments Gallery dialog box, when the folder 
containing that configuration file is selected, is shown in Figure D–1:

[Folder]
text=A basic experiment on the pulsatile flow of blood, the ECG, and 
peripheral circulation.

[TLM03c ECG Periph Circ.pdf
text=The instructions for setting up and running this experiment. 
flags=default, bold

[TLM03c Data File 1]
text=Typical volume pulse, blood flow, and ECG traces to compare 
your data to, or to use in case of poor results.

[TLM03c Data File 2]
text=Typical volume pulse and blood flow to compare your data to, or 
to use in case of poor results.

[TLM03c ECG Periph Circ.doc]
text=An editable version of the experiment (in Word format).

[TLM03c Dem Notes.txt] 
text=Information for demonstrators about this experiment: answers to 
questions and troubleshooting help. 
s Gallery Configuration Files 265
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Figure D–1  
Appearance of the files 
in a folder called ECG 
Periph Circulation, when 
the labels.ini file above 
has been added to the 
folder.
 Chart Software
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Index

A
About Chart dialog box 33, 243
About Chart… command 33, 243
About this Macintosh dialog box 245
Abs Smoothed (computed input function) 163
active channel 76
active point 98
Add Comment dialog box 118
Add Comment dialog box (Timed Events) 223
Add Comment… command 118
Add Exclusion dialog box 118
Add Exclusion… command 118
Add to Data Pad command 138
adding comments 29
adding data to the Data Pad 138

application program
limits 34
versions 253

Apply Calculation… command 170
Arithmetic (channel calculation) 40, 173–176
Arithmetic dialog box 172
Arithmetic… command 40, 173
Auto Comments… command 226
Auto Save… command 108
Auto Scale Data command 74, 88
auto scale display 73
automatic comments 226–229

editing 228
events 226–228
numbering 228
repeating 228
saving 228
stimulus frequency 228
Software 267

ced features 15
g 6–7
tude axis 21, 73–75
is 15, 129–187
is mode 16, 229
d dialog box 111
d… command 110, 207
ding files 110
 events 214–215
Script 214–215
Script from Macro dialog box 214
Script… command 214

Automatic Comments dialog box 227
automatic scrolling 20
automating Chart 16, 202–229

B
background recording 30–31
backup files 126
bandwidth 7, 8, 43
baseline 132
baseline tracking 157–158
basic data acquisition 5–11



Begin Repeat command 218
Begin Repeat dialog box 218
bipolar display 73
bipolar output 67
Block buttons 20, 26–27
Block Information pop-up list 28
blocks 26

appended files 110
information 141
internal and user-defined 34
limits 34
lines between 26, 34, 78
navigating 19, 27
recording dates 71
selecting 99, 216, 218

C
calibration 49, 220
Change e-corder Name dialog box 230
changes at fast rates 37, 78
channel calculations 167–187

Arithmetic 173–176
Cycle Variables 176–183
differences with computed input 261
Differential 183–184
Integral 184–187
Smoothing 171

channel controls 21, 38–41
Channel Function pop-up menu 22, 38–41

Apply Calculation… command 170
Arithmetic… command 173

Channel Status pop-up list 22, 27, 167
channel titles 81–82
Chart Buffer File 199
Chart desktop icons 17, 199
Chart extensions 167, 196–198
Chart for Windows files

opening 18
saving as 107

Chart License setup dialog box 4
Chart menu

About Chart… command 33, 243
Quit command 5, 19

Chart window 19–24
printing 113
splitting 71–72

Chart Window command 19
Choose e-corder dialog box 230
Clear Channel… command 100
Clear command 137
Clear Selection command 100
Clipboard 103
Close command 19
closing a Chart file 19
color 54, 82–83, 87
color depth 32, 33, 250, 251
color display 249
Color pop-up menu 22, 38, 72, 79, 87
color printing 112
Commands menu 235

Add Comment… command 118
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Computed Input… command 153
Cycle Variables… command 177
Differential… command 183
Input Amplifier… command 41
Integral… command 184
No Calculation command 167
Smoothing… command 171
Turn Channel Off command 39
Turn Channel On command 39
Units Conversion… command 46

channel separators 22, 54, 75, 83
Channel Settings dialog box 51, 81
Channel Settings… command 51, 81
Channel Status indicator 22, 41, 167

Add Exclusion… command 118
Add to Data Pad command 138
Auto Scale Data command 74
Find Next command 136
Find… command 133
Remove Baseline command 132
Set Baseline command 132

comments 29, 117–124
adding after recording 118
adding while recording 29, 226
automatic 226–229
boxes 29, 80, 119
channel-specific 29, 117, 119
deleting 122



editing 122
finding 122, 134
identifying data points 123, 132
including in text file 103
lines and areas 80
numbering 110, 119, 122
printing 123, 252
reading 29
show/hide 80
specific 29, 117, 119
text labels 80, 119
truncation 123

Comments & Exclusions command 121
Comments & Exclusions window 121
comments bar 25
computed input 40, 53, 153–167

controls 158–159
differences with channel calculations 261
functions 159–167
raw data controls 155–157
sampling rates 154

Computed Input dialog box 153
computed input function

Abs Smoothed 163
Counter 162
Cyclic Height 163
Cyclic Max 163
Cyclic Mean 162
Cyclic Min 163
Differential 165
Envelope Max 164
Envelope Min 164
Frequency 161
Integral 165–167

Copy command 100, 101, 102, 137
Copy to Clipboard dialog box 102
Counter (computed input function) 162
CPU load 23, 25, 31
crashes 253
Cursor… command 192
customer comment 246
customizing Chart 16, 189–231
Cut command 137
Cycle Variables (channel calculation) 40, 176–183

Data Pad functions 183
functions 180–181

Cycle Variables… command 40, 177
Cyclic Height (computed input function) 163
Cyclic Max (computed input function) 163
Cyclic Mean (computed input function) 162
Cyclic Min (computed input function) 163

D
data acquisition 5–11
data buffering 198–200
Data Buffering… command 199
data compression 33
data display area 22, 39, 75

channel areas 75
splitting 71–72, 85

Data display bar 26
data file 105
data limit area 157
Index 269

1/3Max+2/3Min 163
Period 160–161
Ratemeter 159
RMS Smoothed 163

Computed Input… command 153
computer requirements 3
contacting eDAQ ii, 244
controls and display 14
Controls dialog box 194, 200
Controls… command 194
conventions 2
Copy as Picture dialog box 101

data loss 6, 32, 100, 127, 155, 170, 199, 208, 
251, 253

Data Pad 101, 108, 136–145
adding data 89, 138
different block units 138
functions 139–144
limits 136
printing 114, 145
saving as text file 108
setting up 138–144
Spectrum functions 143

Data Pad Column Setup dialog box 139
Data Pad command 137



Data Pad Value miniwindow 143
data resolution 38, 75
DC output voltage 67
dealer and distributor information 244
default settings 17, 200
Define Unit Name dialog box 50
defining units 50
Delete Macro dialog box 205
Delete Macro… command 204
Delete Unit Name dialog box 50
deleting units 50
dialog box placement 249
different sampling rates by channel 52
differential

signal input 44
time derivative 165

Differential (channel calculation) 40, 183–184
Differential (computed input function) 165
Differential… command 40, 183
digital filters 43
digital read-outs 89–93
digital voltmeter 89
digitization 9
discontinuity 26, 78, 87, 100, 141, 146
display and expectations 11
display at fast rates 37, 78
display offset 44
display settings 11, 77–80

e-corder Startup… command 229
e-corder system 3
e-corder Unavailable dialog box 4
eDAQ contacts ii, 244
eDAQ Contacts dialog box 244
Edit menu 234

Clear Channel… command 100
Clear command 137
Clear Selection command 100
Copy command 100, 101, 102, 137
Cut command 137
Paste command 137
Select All command 99
Show Clipboard command 103

emergency access 201–202
End Repeat command 218
Envelope Max (computed input function) 164
Envelope Min (computed input function) 164
exclusion uses 123–124
exclusions — see comments
Experiments Gallery 17, 19, 96–98

configuration files 263–265
Experiments Gallery command 96
extensions 167, 196–198
Extensions Manager dialog box 197
Extensions… command 197
external devices

responding to 227–229
external trigger marker 59
External Trigger Options dialog box 190
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Display Settings dialog box 77
Display Settings… command 77
divisions 36
DVM 89–93
DVM Log window 108

saving as text file 108
DVM miniwindow 90
DVM submenu 89

E
e-corder Settings 50
e-corder Startup dialog box 229

External Trigger… command 190

F
Fast Fourier Transform 147, 257–261
fast tracking 157
faster printing 252
FFT 147, 257–261
File Information dialog box 125
File Information… command 124
File menu 234

Append… command 110, 207
Close command 19



Experiments Gallery command 96
File Information… command 124
Find File… command 125
New command 17
Open… command 17, 207
Page Setup… command 111
Print… command 111
Save As… command 101, 104–108, 208
Save command 104
Save Selection… command 100, 109, 208

file problems 253
file types

buffer 200
data 105
settings 105
text 106

filtering 7–8, 43–44
AC coupled 43
basics 7–8
digital 43
high-pass (baseline tracking) 157
low-pass 43
mains 43

Find and Select dialog box 133
Find File dialog box 125
Find File… command 125
Find Next command 136
Find… command 133
finding Chart files 124–126
finding comments 122, 134
finding data 134
finding events 133–136

H
high-resolution printing 112
horizontal compression 21, 37
hysteresis 156

I
initial display 38
input amplifier 40, 41–45, 53
Input Amplifier dialog box 42
Input Amplifier… command 41
Integral

Absolute Value 166
Negative Only 166
normal 165
Positive Only 166
Reset Each Cycle 166
resetting 159, 166
Time Constant 167
Timed Reset 167

Integral (channel calculation) 40, 184–187
Integral (computed input function) 165–167
Integral… command 40, 184
interference 11
internal timer 56–57, 59
introduction to data acquisition 5–11

K
keyboard shortcuts 19, 194, 237

changing 194
Index 271

First Point command 131
Found Files dialog box 126
Frequency (computed input function) 161
frequency range 7
Function keys 24, 192, 227

G
general display controls 77–80
glitches 123
graticule 36, 37, 79

conventions 2
macros 204

L
Last Point command 131
License Manager… command 196
licenses

adding 196
deleting 196
entering new Chart 4

licensing your copy of Chart 3
limits of files 34



lines between blocks 26, 34, 78
locating events 84, 89
low-pass filters 43

M
macro commands 209–221
Macro Commands submenu 236

AppleScript… command 214
Begin Repeat command 218
End Repeat command 218
Message… command 212
Play Sound… command 211
Repeat Select Each Block command 218
Repeat Select Every… command 216
Repeat While in Block command 216
Set Units Conversion… command 219
Speak Message… command 213
Stop Sampling command 221
Update Screen command 209
Wait While Sampling command 221
Wait… command 210

Macro menu 236
Delete Macro… command 204
Start Recording command 203

Macro Message dialog box 212
Macro Play Sound dialog box 212
Macro Sampling dialog box 206
Macro Wait dialog box 210
macros 202–221

appending files 207
called by other macros 209
changing dialog box settings 205–206

timed events 225, 229
user changes to settings 206
versions 202

mains filter 43
Marker 23, 87, 123, 131–132
marker channel (for stimulus) 63
Maximum Point command 131
measurement

direct 130
relative 131

Memory Cache… command 198
memory indicator 23
memory indicators 26
menu commands

conventions 2
hiding 193
locking 193

menus 233–236
altering 192–194
and the Tool bar 193
creating 203
hiding 193

Menus dialog box 193
Menus… command 192
Message… command 212
Minimum Point command 131
monitoring 27

N
naming an e-corder 230
272 Chart Software

commands 209–221
deleting 204–205
discarding when opening files 202
keeping records 202
keyboard shortcuts 204
loading 202
nesting 209, 218
opening files 207
playing 204
recording 203–204
sampling 206
saving 203–204
saving files 208–209
stopping 204

navigating 19
New command 17
No Calculation command 167
noise 10
Notebook 115–116

printing 116
Notebook command 115
Notebook window 116
number of channels appearing 38, 54
number of channels on 38
Nyquist frequency 6



O
off-screen buffer 33, 251
1/3Max+2/3Min (computed input function) 163
Open dialog box 17
Open File for Macro dialog box 207
Open… command 17, 207
opening a Chart file 16
Output Voltage… command 66
overlaying channels 76–77, 83
overlaying in Zoom window 86
Overview command 84
Overview miniwindow 84–85, 133
overview of Chart 14–16

P
Page Layout dialog box 114
page setup 111–113
Page Setup dialog box 112
Page Setup… command 111
Paste command 137
performance 31–32
Period (computed input function) 160–161
Play Sound… command 211
pointer 24

arrow-headed cross 191
cross 130
double-headed arrow 99, 130
dragging 74

e-corder Startup… command 229
Extensions… command 197
External Trigger… command 190
License Manager… command 196
Memory Cache… command 198
Menus… command 192
Startup… command 200
Tool Bar… command 190

pre-triggering 57
Print dialog box 113
Print… command 111
printing 111–115

Chart window 113
color 112
commands 113
comments 123
Data Pad 145
faster 252
high-resolution 112
Notebook 116
problems 252
restricting 195
Spectrum window 113
X–Y window 146
Zoom window 89

problems and solutions 246–254
Pulse stimulus waveform 62

Q
Quit command 5, 19
quitting Chart 5, 19
Index 273

hand 20, 88
heavy cross 137
I-beam 24, 137
resizing 122, 138
separator 75
split 71
stretching 74

post-triggering 57
preferences 190–196
preferences file 50
Preferences submenu 234

Controls… command 194
Cursor… command 192
Data Buffering… command 199

R
Ramp stimulus waveform 62
range 9–10, 38, 44, 53, 155, 158

basics 9–10
choosing 38

Range pop-up menu 22, 38, 158
Range/Amplitude display 22, 25, 39, 130, 132
Rate pop-up menu 22, 36, 52
Rate/Time display 22, 26, 36, 52, 130, 132
Ratemeter (computed input function) 159
raw data 53, 155, 158
Record/Monitor button 23, 27



hiding 195
recording 14, 25–34

changing settings during 26, 31
different sampling rates by channel 52
fidelity 11, 75
limits 32
media 127, 199
problems 249–251
resolution 10, 38, 75
running other applications 31
split data display 30–31
to disk 34
to RAM 33
while reviewing data 30

Recording Status indicator 25, 28
recovering files 127, 253
reduction 103
Remove Baseline command 132
Repeat Select Each Block command 218
Repeat Select Every dialog box 217
Repeat Select Every… command 216
repeat sequence 224
Repeat While in Block command 216
RMS Smoothed (computed input function) 163

S
sampling rates 6–7, 36

and View buttons 36
appropriate 6–7
basics 6–7
computed input 154

Save Selection… command 100, 109, 208
saving a selection 109
scale

moving 74
setting 74
stretching 74

Scale pop-up menu 21, 73, 76
Scaling buttons 21, 74
Scroll bar 19
scroll while sampling 78
Scroll/Review button 24, 30, 195
scrolling speed 36
Select All command 99
selecting data 99–100
selection information 140
sensitivity bandwidth 156
Set Baseline command 132
Set Marker submenu 235

First Point command 131
Last Point command 131
Maximum Point command 131
Minimum Point command 131

Set Scale dialog box 73
Set Scale… option 73
Set Units Conversion dialog box 219
Set Units Conversion… command 219
settings 18, 103, 105, 200
settings file 105
Setup menu 235

Auto Comments… command 226
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continuous 37, 52
different by channel 52
digital filters 32, 43
mains filter 43
problems 249
slow 37
too low 6

Save As dialog box 104
Save As Text File dialog box 106
Save As… command 101, 104–108, 208
Save command 104
Save File for Macro dialog box 208
Save Selection directory dialog box 110

Channel Settings… command 51, 81
Display Settings… command 77
Output Voltage… command 66
Stimulator command 60
Stimulator Panel command 65
Timed Events… command 222
Trigger command 55
Zero All Inputs command 46

shortcuts 237–241
Show Clipboard command 103
signal conditioning 5
signal input controls 44
Sine stimulus waveform 62



single-sided display 73
slope 141
Slow Sampling submenu 37
slow tracking 157
smoothing 171–173
Smoothing (channel calculation) 40, 171
Smoothing dialog box 171
Smoothing… command 40, 171
Speak Message dialog box 213
Speak Message… command 213
special access 201–202
Special Access dialog box 201
specifying connections 229–230
Spectrum command 147
Spectrum window 108, 147–152

calculation details 257–261
printing 113
saving as text file 108
settings 149–152

Split bar 23, 30, 71–72
stacking in Zoom window 86
Start button, Chart window 23
Start Recording command 203
startup problems 246–247
Startup Settings dialog box 200
Startup… command 200
state changes 226
statistics 139
Step stimulus waveform 62

Stimulator window 61
stimulus marker 63
stimulus waveform

Pulse 62
Ramp 62
Sine 62
Step 62
Triangle 62

Stop Sampling command 221
superscripts and subscripts 50, 82, 137
system configuration information 244–245

T
tear-off data displays 89, 145
technical support 243–246
text file 106
threshold and sensitivity 156
Time & Date button 24, 70
time and date display 71
Time axis 21

problems 247
time display mode 21, 26
Time Format & Display dialog box 70
time scale controls 70–71, 78
Timed Event Stimulator Output dialog box 224
timed events 222–226

accuracy 225
actions 223–224
Analog Output 2 223
editing 224
Index 275

stimulation 60–67, 228
automatic comments 228
changing during sampling 66
continuous 62
discrete 63
mode 61

Stimulator 60–67
Stimulator command 60
Stimulator Constant Output dialog box 66
Stimulator output 67
Stimulator Panel command 65
Stimulator Panel miniwindow 65

macros 225, 229
saving 224
turning off 224

Timed Events dialog box 222
Timed Events… command 222
Tool bar 24, 190–192, 205

and automatic comments 192, 227
and menus 193

Tool Bar Settings dialog box 191
Tool Bar… command 190
transferring data 101–103
Triangle stimulus waveform 62



Trigger command 55
Trigger Marker 60
Trigger window 55
triggering 55–60, 227

automatic comments 227
changing in Chart window 59
external 56, 59, 227
external modes 190
fixed duration 58
level 57
slope 57
source 56
synchronizing recording 231
threshold 56, 227

triggering event 56
Turn Channel Off command 39
Turn Channel On command 39
turning channels off and on 38–39, 75

U
underlying data 170
units conversion 40, 45, 46–50, 53, 73, 99

calibration 49
Data Pad calculations 138
prefixes 248
typing in values 48
using sampled data 48–49

Units Conversion dialog box 46
Units Conversion… command 46
Update Screen command 209
using this guide 2

warning icon 170
Waveform Cursor 87, 130, 131, 192
Waveform Cursor dialog box 192
waveforms

stacking 86
superimposing 85

where to start 2
window

Chart 19–24
Comments & Exclusions 121
Data Pad 136–145
Notebook 116
Spectrum 147–152
Stimulator 61
Trigger 55
X–Y 101, 145–146
Zoom 85–89, 101

Window menu 236
Chart Window command 19
Comments & Exclusions command 121
Data Pad command 137
DVM command 89
DVM Log Window command 92
Notebook command 115
Overview command 84
Spectrum command 147
X–Y Window command 145
Zoom Window command 85

X
X–Y plot 79
X–Y window 101, 145–146

printing 146
276 Chart Software

V
versions 253
View buttons 21, 84, 113

and sampling rates 36
Voltage at Input dialog box 44
voltmeter 45

W
Wait While Sampling command 221
Wait… command 210

X–Y Window command 145

Z
Zero All Inputs command 46
Zoom window 85–89, 101
Zoom Window command 85
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Copyright and Trademarks

e-corder and PowerChrom are registered 
trademarks, and EChem a trademark of eDAQ Pty 
Ltd. Chart and Scope are trademarks of 
ADInstruments Pty Ltd and are used under license. 
All eDAQ software, hardware, and documentation 
is protected by copyright. eDAQ retains the 
exclusive ownership of the trademarks and 
registered trademarks represented by its company 
name, logo, and product names. 

Responsibilities

You and any others using any eDAQ product agree 
to use it in a sensible manner for purposes for which 
it is suited, and agree to take responsibility for their 
actions and the results of their actions. 
Software

lems arise with an eDAQ product, eDAQ will 
all reasonable efforts to fix them. This service 
cur a charge, depending on the nature of the 
ms, and is subject to the other conditions in 
reement. 

ware Warranty

 Pty Ltd warrants e-corder systems, to be free 
ects in material and workmanship for one year 
he date of purchase. eDAQ Pty Ltd will repair 
lace defective equipment as appropriate.
g & Warranty

To obtain a warranty repair/replacement you must 
first notify us before return of the instrument and we 
will issue you with a RAN (return authorization 
number). You must ship the defective product at your 
expense. We will pay return shipping. The product 
should be packed safely (preferably in its original 
packaging) and have the RAN on the shipping 
label. Returns sent without a RAN may be refused 
delivery.

This warranty does not cover hardware that has:

• been modified by the user in any way;

• been subjected to unusual physical, electrical, 
or environmental stress. This includes damage 
due to faulty power sockets, inadequate 
earthing, or power spikes or surges;

• been damaged because of incorrect wiring to 
ancillary equipment, or because of substandard, 
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connectors or cables; or

• had the original identification marks removed 
or altered. 

Software License

You have the non-exclusive right to use the supplied 
Scope software. (Your employees or students, for 
example, are entitled to use it, provided they adhere 
to this agreement.) Each separate purchase of the 
Scope software licenses it to be used on two 
computers at any given time (on one computer for 
data acquisition with an e-corder hardware unit, 



and on a second computer for the analysis of 
existing data files). Although multiple copies of a 
program may exist on several computers, more than 
two copies must not be used simultaneously. 
Departmental/company licences are available if you 
wish to run more than two copies simultaneously.

Technical Support

Please register your unit to receive technical support. 
Technical assistance is available via email. Please 
describe the problem with as much detail as 
possible. Include a small example data file, if 
appropriate. Please also state:

• the model and serial number of your e-corder 
unit.

• the type of computer and operating system 
being used (for example Windows XP, or 
Macintosh OS 10.2)

• the software version you are using (for 
example Scope v4.0.1)

We endeavor to answer all your questions, but in 
some cases, for example where the problem relates 
to the other equipment that you are using, a nominal 
fee may be charged.

Jurisdiction

eDAQ Pty Ltd is bound by the laws of New South 
Wales in Australia, and any proceedings shall be 
heard by the Supreme Court of New South Wales in 
Australia.
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Disclaimer

eDAQ reserves the right to alter specifications of 
hardware and software without notice.

No liability can be accepted for consequential 
damages resulting from use of eDAQ products.
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